
PRS-700

©2008 Sony Corporation

User’s Guide/Guide de l’utilisateur

4-124-649-11(1)

Portable Reader System

 Jump to the table of contents

 Consultation de la table des matières

Reader



PRS-700.GB.4-124-649-11(1)

About the Manuals
Included with the Reader is the Quick Start Guide and this 
User’s Guide. Additionally, after installing eBook Library 
software from the supplied CD-ROM, you can refer to the 
Help within eBook Library.

Browsing the User’s Guide

Browsing this Guide on your computer
Click the Start menu in the bottom left of the Desktop, then 
select “All Programs” – “Reader” – “PRS-700 User’s Guide” 
to start Adobe Reader and open the User’s Guide.
For details on how to use Adobe Reader, refer to Adobe 
Reader Help.

Hint
	To view the User’s Guide, Adobe Reader or Acrobat needs to be 

installed. Adobe Reader can be downloaded for free from the 
Adobe website (www.adobe.com).
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Using the eBook Library Help

Refer to the eBook Library Help for details about using 
eBook Library, such as importing books to your computer 
and transferring them to the Reader.
Follow the steps below to start eBook Library and browse 
Help.

 Click the Start menu from your computer, then 
select “All Programs” – “Reader” – “eBook Library.”

 Click “Help” – “eBook Library Help” on the Menu bar.
Help appears.
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Introduction

What You Can Do with the Reader
First, read the Quick Start Guide to prepare the Reader for 
use. Initially after purchase, you need to charge the Reader 
battery, and install the dedicated software “eBook Library” 
on your computer.
Once initial preparation is complete, you can transfer 
content from your computer to the Reader to take anywhere 
you wish.

*1

*2

Downloaded 
eBooks

*1 Online eBook store
*2 Book/Audio/Picture files that you already have

Transferring

Charge the Reader, then install eBook Library 
and Adobe Digital Editions.

Downloaded eBooks from 
“The eBook Store from 
Sony.”

Transfer content from your 
computer to the Reader 
using eBook Library.

Enjoy content on the 
Reader.

Reading/
Playing/Viewing

Importing

Getting Started
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Guide to Parts and Controls

Front
 OPTION button

Displays the Option menu. (  page 5�, 59, 90, 9�, 98, 
104)  
You can use various functions such as creating Notes, 
jumping to a page, from the Option menu.

  (Size) button
Displays the Size menu. (  page 64, 10�)
You can adjust the text size and zoom in/out a page or 
picture from the Size menu.

Continued 8 US
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 SEARCH button
Displays the Search menu. (  page 71)  
The Search menu appears with the on-screen keyboard. 
You can search for books or keywords by inputting a 
word using the on-screen keyboard.

 HOME button
Displays the Home menu. (  page 16)

 Touch panel
The touch panel gives you simple access to the various 
functions on the Reader (  page 18).

 Stylus
The stylus enables you to perform precise operations 
such as highlighting, on the touch panel (  page 1�, 18, 
114).

 SD Memory Card slot
Used to insert a SD Memory Card (optional). (  page 28)

 “Memory Stick Duo” slot
Used to insert a “Memory Stick Duo” Memory Card 
(optional). (  page 28)

 POWER switch
Switches on/off the Reader. (  page 2�) 
To shutdown the Reader, slide and hold it for more than 
� seconds (  page 24).

 Indicator
Lights up in red while charging, and goes off when 
charging is complete. (  page 21)
Flashes orange while the Reader is accessing your 
computer via USB.
Also flashes in orange while switching the Reader on or off.

Continued 9 US
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 Holes for soft cover attachment
The soft cover is attached when purchased. (  page 12)

Folds open in use

Note

	Do not leave the Reader in high temperature conditions, as it 
may damage the soft cover.

 <  /  > (Page Turn) buttons
Turns pages. You can also turn pages using the touch 
panel.

  (Back) button
Returns to the previous menu.

 Hole for hand strap
Used to attach the hand strap (optional).

  (Light) Switch
Switches on/off the built-in light. (  page �2)

 DC IN jack
Used to connect the AC Adaptor for Reader (AC-
S5220E) (optional).

 Hint
	The Reader can be charged by connecting to a computer 

using the supplied USB cable.

Continued 10 US
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 USB connector
Used to connect the USB cable (supplied). (  page �9)

  (Headphones) jack
Used to connect headphones (optional). (  page 95)

 VOL –/+ button
Adjusts the volume. (  page 97)
To mute the sound, press and hold either edges of the 
VOL –/+ button. To restore the sound, press the VOL –/+ 
button again.

Rear

 RESET button
Resets the Reader if no operation is possible. (  page 
114)

Continued 11 US
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About the serial number
The serial number provided for the Reader is required for 
the customer registration. The number is on the label on the 
rear of the Reader. Do not remove the label.

Removing/attaching the soft cover

Removing the soft cover
 Pull the tab of the soft cover towards A.
 Remove the Reader in the direction of B.

Attaching the soft cover
 Insert the tab C of the soft cover in the hole D of the 

Reader.
 Pull the tab of the soft cover towards A.
 Insert the Reader in the direction of E to attach it to the 

soft cover.
 Check that the tabs of the soft cover are completely 

inserted in the holes of the Reader.

Note

	Note that the tab of the soft cover may become deformed, if you 
pull the tab too strongly.

Continued 12 US
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Removing the supplied stylus
The supplied stylus is stored on the right side of the Reader. 
Pull it out from the top when you use it.

Note

	When you put the supplied stylus back into the holder, make sure 
to insert it fully to the bottom of the holder.

1� US
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Basic Operations

Menu Operation
You can operate the Reader using the touch panel and the 
buttons on the Reader. 
From the Home menu, you can read/play/view content, and 
configure the settings.
The items/contents displayed on the screen can be selected 
by tapping the touch panel. For details about using the touch 
panel, refer to “Guide to Operate the Touch Panel.” (  page 
18)

Menu flow  
Example: reading a book

 In the Home menu, tap  (Books).
The Book list appears. By default, 
books are sorted by the title in the 
list.
For details about the Home menu, 
refer to “About the Home menu.” (  
page 16) 

Continued 14 US
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 Tap the desired book on the 
Book list.
The Book page appears.
	For details about the Book list, 

refer to “Selecting a book from 
the Book list.” (  page 47)

 Read the book.
	For details about the Book page, 

refer to “Reading books on the 
Book page.” (  page 49)

To return to the Home menu
Press the HOME button.

To return to the previous screen
Press the  (Back) button.
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About the Home menu

The Home menu is the starting point to read/play/view 
content and to configure the settings. You can select menu 
items by tapping them. 
The Home menu can be always displayed by pressing the 
HOME button.

Menu item Description

 (Continue Reading) Continues reading from the last 
displayed page.

 (Books) Displays the Book list. (  page 
47)

 (All Notes) Displays the list of all the 
bookmarks, highlights and 
comments created in Books within 
the Reader. (  page 89) 
For details about bookmarks and 
highlights, refer to “Creating Notes 
on a Book Page.” (  page 78)

 (Collections) Displays the list of collections 
created by eBook Library. (  page 
58)
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Menu item Description

 (Audio) Displays the Audio list. (  page 
95)

 (Pictures) Displays the Pictures list. (  page 
100)

 (Settings) Displays the Settings menu. (  
page 106)

Other available functions in the Home menu
The following functions are available in the Home menu.
	The Option menu appears by pressing the OPTION 

button. You can display the audio Playback screen (  
page 97), or change the screen orientation (  page 69) 
from the Option menu.

	The Search menu appears by pressing the SEARCH 
button. You can search for a book by title or author from 
the Search menu. (  page 71)

17 US



PRS-700.GB.4-124-649-11(1)

Guide to Operate the Touch Panel
Using the touch panel, you can perform various operations 
by using your finger or the supplied stylus.

Note

	When you use the supplied stylus, make sure to use the pointed 
end of it for tapping and dragging on the touch panel. Do not use a 
writing pen, pencil, or other sharp object.

Tapping
By tapping on the touch panel, you can select an item on 
the menu or list, etc.

Continued 18 US
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Double-tapping
By tapping twice (double-tap) on the touch panel, you can 
create bookmarks (  page 79), select a word on a Book 
page to search in the Search menu (  page 71), etc.

Dragging
By dragging on the touch panel, you can turn a page (  
page 50), drag a magnified page in Zoom mode (  page 68) 
or select a word to highlight (  page 82).
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Dragging and Holding
By holding on the touch panel after dragging, you can turn 
pages repeatedly. (  page 50)
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Charging the Reader

About charging

Charging the Reader is required when using for the first time 
or when the remaining battery power is running low. Turn on 
the Reader, and then charge in one of the following two ways.
	Connect to a computer via USB (Refer to the Quick Start Guide 

and  page �9). 
(Charging time: approx. 4 hours*)

	Connect to an AC outlet using the AC Adaptor for Reader (AC-
S5220E) (optional). 
(Charging time: approx. 2.5 hours*)
* Approximate time required to fully charge the battery.

Notes

	When you connect the Reader to your computer,  (indicating 
connection via USB) is displayed on the Reader’s screen. If the 
battery has been fully depleted, it takes approximately 5 minutes 
until  is displayed, during which time you will not be able to turn 
on the Reader by the POWER switch. In this case, wait until  is 
displayed. 
The charge indicator lights up in red while  is not displayed, 
while the Reader is charging.

	If the remaining battery power of a connected notebook computer 
is low, charging via USB connection may not be possible.

	If you connect the Reader to a notebook computer which is not 
connected to an AC outlet, the battery of the notebook computer 
will be consumed. Do not leave the Reader connected to a 
notebook computer which is not connected to an AC outlet for an 
extended period.

	Connecting the Reader via a USB hub or extension cable may not 
work and is not supported. Connect the USB cable directly to the 
computer.

Continued 21 US
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You can verify the remaining battery power by checking the 
indicator in the bottom left of the screen. Charge the battery 
when remaining power is low (the fewer black segments 
indicated, the lower the remaining power).

Note

	If the remaining battery power is low, the following warning 
appears. Charge the battery.

 

 If you continue to use without charging, the following warning 
appears, and the Reader will shutdown automatically.

 Charge the Reader and turn it on again.
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Turning on the Reader
Slide the POWER switch in the direction of  to turn on the 
Reader.

Slide the POWER 
switch.

The Reader turns on. The indicator lights up in orange when 
the Reader is turned on.
	When the Reader is turned on for the first time after 

purchase, the touch panel calibration screen appears. 
Calibration is necessary to select targets accurately on 
the touch panel. For details about calibration, refer to 
“Calibrating the touch panel” (  page 26).

	It may take a few moments to turn on the Reader and the 
start-up screen to appear when used for the first time, 
after a reset (  page 114) or shutdown (  page 25), or 
when the battery has depleted.

Continued 2� US
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To turn off the Reader
Slide the POWER switch in the direction of  again.
The Reader turns off. After turned off, the Reader enters 
sleep mode.
If you slide the POWER switch and hold it for more than � 
seconds, the Reader is shutdown.

Hint
	When the “Power Management” setting is set to “On” (  page 109), 

the Reader enters sleep mode after 60 minutes of inactivity even if 
you do not turn off manually.

About the Power Management of the Reader

The Reader has a Power Management feature to avoid 
unnecessary battery consumption. At purchase, the Power 
Management is activated. The Power Management operates 
as follows:
	After 60 minutes of inactivity, the Reader enters sleep 

mode automatically while the battery power is consumed 
slightly.

	After 5 days of inactivity, the Reader automatically 
shutdown and stops consuming the battery power.

 If the battery power is at a low level, the Reader will shutdown after 
60 minutes of inactivity.
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Hint
	You can activate/deactivate the Power Management from “Power 

Management” in the Settings menu. (  page 109)

Note

	In the following states, the Reader does not enter sleep mode after 
60 minutes of inactivity even if “Power Management” is set to “On.”
– When connected to the computer using the supplied USB cable
– When connected to the AC Adaptor for Reader (AC-S5220E) 

(optional) to charge
– When playing audio files

To shutdown the Reader manually
You can shutdown the Reader manually in one of the 
following ways.
	Slide the Power switch and hold it for more than  

� seconds.
	Use “Device Shutdown” in the Advanced Settings menu. 

(  page 11�)
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Calibrating the Touch Panel

When the Reader is turned on for the first time after 
purchase, the touch panel calibration screen appears. 
Calibration is necessary to select targets accurately on the 
touch panel.

Hint
	If you cannot select an item even if you tap the center of it, 

calibrate the touch panel from “Touch Panel” in the Advanced 
Settings menu. (  page 112)

Note

	Make sure to use the supplied stylus for the calibration.

 Turn on the Reader.
The touch panel calibration screen appears. An × 
(target) is displayed at the upper left corner of the 
screen.

Continued 26 US
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 Tap the target using the supplied stylus.
The target moves to the lower right corner. Each time 
you tap the target, the position of the target moves. 
Continue to tap the target until the calibration process is 
completed.

If your tap missed the center of target
If an error was detected during the calibration steps, a 
message will appear and prompt you to restart the 
calibration process again.

27 US
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Inserting a Memory Card
The following memory cards can be inserted in the Media 
slots of the Reader.

Note

	The Reader has separate slots for “Memory Stick Duo” Memory 
Card and the SD Memory Card. Be sure to insert the memory card 
in the correct slot. Inserting the memory card in the wrong slot may 
damage the slot and the memory card.

“Memory Stick Duo”*1  

Memory Card
“Memory Stick Duo” 
“Memory Stick PRO Duo”

SD Memory Card*2 SD Memory Card
SDHC Memory Card
miniSD Card *�

*1 The Reader does not comply with MagicGate standard, and the data 
requiring the copyright protection function cannot be copied or played 
on the Reader.

*2 The Reader does not comply with copyright protection of SD Memory 
Cards.

*� miniSD Card adaptor (sold separately) required.

Notes

	An operation check is performed when using a Sony’s “Memory 
Stick Duo” Memory Card of up to 16 GB, however, operation of all 
“Memory Stick Duo” is not guaranteed.

	An operation check is performed when using an SD Memory Card 
of up to 16 GB, however, operation of all SD Memory Cards is not 
guaranteed.

	When inserting the memory card into the Reader, it may take time 
for the Reader to recognize the content files in the memory card if 
the number of the content files stored on the memory card is large.

Continued 28 US



PRS-700.GB.4-124-649-11(1)

Inserting a memory card into the Reader

 Remove the Memory slot protective inserts from the 
“Memory Stick Duo” slot and SD Memory Card slot.
The Memory slot protective inserts are inserted in the 
“Memory Stick Duo” slot and the SD Memory Card slot 
at purchase. When not using the memory card, insert 
the Memory slot protective insert into the slot.

Note

	If the Memory slot protective insert is not inserted in the slot, 
foreign objects may enter the slot, and cause malfunction or 
damage.
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 Insert a memory card in the  direction with its label 
side up until it clicks into the place.

Note

	The Reader has separate slots for “Memory Stick Duo” 
Memory Card and the SD Memory Card. Be sure to insert the 
memory card in the correct slot. Inserting the memory card in 
the wrong slot may damage the slot and the memory card.

  
Mark

“Memory 
Stick Duo”

SD Memory 
Card

  
Mark

Notes

	Be sure to insert the memory card in the correct direction. Forced 
insertion may damage the slot.

	Do not insert an incompatible memory card, as it may cause 
malfunction.

	Do not use a deformed memory card or adaptor.

Continued �0 US
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Removing a memory card from the Reader

 Gently push in the memory card.
You will hear a click, and the memory card pops out.

“Memory 
Stick Duo”

SD Memory 
Card

 Remove the memory card squarely from the 
“Memory Stick Duo” slot or the SD Memory Card 
slot.

Notes

	Do not remove a memory card or turn off the Reader while reading 
or writing data, as data may be damaged.

	For details on handling memory cards, refer to  page 1�5.
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Built-in Lighting Controls
You can light up the screen by sliding the  (Light) Switch. 
Use the built-in light when you read books on the Reader in 
dark locations.

 (Light) Switch

 Slide the  (Light) Switch toward  to light up 
the screen.
The screen becomes brighter.
The brightness of the built-in light can be adjusted in 2 
levels. Each time you slide the  (Light) Switch, the 
brightness level is switched in the following order:
Off : The built-in light is off. Whenever you turn 

on the Reader, the built-in light is always 
turned off at first.

Standard: The screen lights up.
Bright: The screen lights up in bright mode.

Continued �2 US
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Notes

	Make sure to turn off the built-in light when its use is unnecessary 
to avoid excessive battery consumption.

	When you connect the Reader to the computer via USB, the built-
in light is turned off automatically. The built-in light is unavailable 
during USB connection.
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Importing Content

Importing eBooks from  
“The eBook Store from Sony”
You can download eBooks from an online eBook store to 
your computer.
Use the dedicated software eBook Library to access the 
eBook Store.

Notes

	To download eBooks, you need to prepare an Internet-accessible 
environment on your computer.

	You need to authorize your computer to the eBook Store to 
download eBooks. 
You also need to authorize the Reader to the eBook Store to 
transfer and read downloaded eBooks on the Reader. 
For details, refer to the eBook Library Help.

 Double-click the eBook Library icon ( ) on 
Windows desktop.

	 Hint
	You can also start eBook Library by clicking the Start menu 

and then selecting “All Programs” – “Reader” – “eBook 
Library”.

 Click “eBook Store” in the Source view.
The View area is switched to the Store view and “The 
eBook Store from Sony” appears.

Continued �4 US
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 Follow the page instructions to purchase 
(download).
Downloaded eBooks are automatically imported to
“Library” in the Source view.

Library Downloaded 
content

Source view

	 Hint
	Purchased eBooks are grouped under “Purchased” in the 

collection.

Hints
	eBooks can be read in eBook Library using your computer. For 

details on eBook Library operations, refer to the eBook Library 
Help.

	The Source view appearance may vary depending on your 
computer.
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Importing Content from Your 
Computer
You can import content files stored on your computer into 
Library of eBook Library.

You can import the following content files.
	Book 

PDF file*1, EPUB file*1 Text file, RTF file, Word file (unsecured)*2, 
BBeB Book

	Audio 
MP� and AAC format audio files (unsecured)

– MP� file (.mp� file extension) 
The following specifications should be met in order to import an 
MP� file. 
Bit rate: �2 to �20 kbps 
Sampling frequency: 22.05, 44.1 kHz

– AAC file ( .mp4, .m4a, .mov, or .qt file extension) 
The following specifications should be met in order to import an 
AAC file. 
Bit rate: 40 to �20 kbps 
Sampling frequency: 24.0, 44.1, 48.0 kHz

Note

	Movie files are not supported.
	Picture 

Bitmap file, JPEG file, GIF file, PNG file

*1 Adobe DRM protected PDF and EPUB files supported only if 
Adobe Digital Editions 1.5 or later is installed and authorized on 
your computer. For details on authorizing the Reader for Adobe 
DRM protected content, refer to Adobe Digital Editions Help at:  
http://www.adobe.com/go/digitaleditions_help_en

*2 Word files will be automatically converted into RTF files during 
transfer only if Microsoft Word is installed on your computer.

For details on content files you can import, refer to the 
eBook Library Help.

�6 US
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Importing content files

You can select content files stored on your computer and 
import them into Library.

 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

 Click “Import Files” on the “File” menu.
The “Import Files” dialog box appears.

 Click  of the “Look in” list to select the folder 
containing the content file(s) to be imported, as 
necessary.
The content files in the selected folder are listed.

Hint
	You can also double-click the folder (in the folder list) to display 

the content files in the folder.

 Select the content file to be imported.
To select multiple files, click the files while holding down 
the Ctrl key.

 Click “Open.”
The content file(s) is imported into Library.

Hint
	You can import all the content files in a selected folder at the same 

time into Library from “Import Folder” on the “File” menu.
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Transferring Content

Transferring Content to Reader 
Connected with Your Computer
You can transfer (copy) the content in the Library to the 
Reader.

Note

	If the Reader is locked, it will not be recognized on your computer 
and content cannot be transferred. (  page 112) If you connect the 
Reader to your computer, disconnect it and unlock the Reader by 
inputting the password.

Hints
	The book content can be grouped in the Library as a collection, 

which can be transferred to the Reader. For details on how to 
create or transfer a collection, refer to the eBook Library Help.

	You can synchronize content in Library of eBook Library with the 
Reader by specifying a folder (such as “Library” or the sub-items 
under “Library”). (  page 45) The Reader can be automatically 
updated to match the content in Library, when you connect it to 
your computer.

 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.
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 Connect the Reader to your computer using the 
supplied USB cable.

USB cable  
(supplied)

To USB connector

“Reader” appears in the Source view of eBook Library.
A screen appears on the Reader, indicating that it is 
connected to the computer.
Notes

	If “Reader” does not appear in the Source view after connecting 
the Reader to your computer, disconnect the USB cable from 
the Reader, then reconnect it after a while.

	When you connect the Reader to your computer,  
(indicating connection via USB) is displayed on the Reader’s 
screen. If the battery has been fully depleted, it takes 
approximately 5 minutes until  is displayed, during which 
time you will not be able to turn on the Reader by the POWER 
switch. In this case, wait until  is displayed. 
The charge indicator lights up in red while  is not displayed, 
while the Reader is charging.

	When you connect the Reader to the computer via USB, the 
built-in light is turned off automatically. The built-in light is 
unavailable during USB connection.
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 Click “Library” in the Source view, then click  (List 
view).
The View area is switched to the List view and all the 
content in the Library is listed.

 Hints
	When you click “Books,” “Audio” or “Pictures” in the Source 

view, only their respective content is displayed.
	When you click  (Thumbnail view), content can be displayed 

as thumbnails.
	You can create a collection in the Library and the collection 

can be transferred to the Reader. For details on how to create 
or transfer a collection, refer to the eBook Library Help.

 Select the content you want to transfer from the list.
To select multiple content, click the content while 
holding down the Ctrl key.

 Drag the content from the list to “Reader” in the 
Source view.
The content is transferred to the Reader.

Reader
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Hint
	You can store computer data into the built-in flash memory of the 

Reader by transferring the data from your computer using Windows 
Explorer.

Notes

	If there is not enough free space on the memory of the Reader, 
content may not be transferable. The memory of the Reader can be 
increased in the following 2 ways.
	Transfer any unnecessary content back to eBook Library, then 

delete it to increase free space on the Reader. (  page 4�)
	Delete any unnecessary book on the Reader.  (  page 94)

	Do not delete files in the folder under “database,” and files in 
“database,” using Windows Explorer. Perform data management 
using eBook Library. For details on the eBook Library operations, 
refer to the eBook Library Help.

Transferring content via a memory card
Content imported to eBook Library can be transferred to a 
memory card on the Reader.

Hints
	“Memory Stick Duo” Memory Card and SD Memory Card can be used.
	You can synchronize content in Library of eBook Library with a 

memory card on the Reader by specifying a folder (such as 
“Library” or the sub-items under “Library”). (  page 45) For details 
on how to synchronize content with a memory card, refer to the 
eBook Library Help.

 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

 Connect the Reader to your computer using the 
supplied USB cable. (  page 39)
“Reader” appears in the Source view of eBook Library.
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 Insert a memory card into the Media slot of the 
Reader. (  page 30)
“Memory Stick/SD Card on Reader” appears in the 
Source view.

 Click “Library” in the Source view, then click  (List 
view).
The View area is switched to the List view and all the 
content in Library is listed.

	 Hints
	When you click “Books,” “Audio” or “Pictures” in the Source 

view, only their respective content is displayed.
	When you click  (Thumbnail view), contents can be displayed 

as thumbnails.
	You can create a collection in Library and the collection can be 

transferred to a memory card on the Reader. For details on 
how to create or transfer a collection, refer to the eBook 
Library Help.

 Select the content you want to transfer from the list.
To select multiple content, click the content while 
holding down the Ctrl key.

 Drag the content from the list to “Memory Stick/SD 
Card on Reader” in the Source view.
The content is transferred to the memory card on the 
Reader.
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Hint
	You can store computer data into the memory card on the Reader 

by transferring the data from your computer using Windows 
Explorer.

Notes

	If there is not enough free space on the memory card, content may 
not be transferable. The memory of the memory card can be 
increased in the following two ways.
	Transfer any unnecessary content back to eBook Library, then 

delete it to increase free space on the memory card.
	Delete any unnecessary book on the Reader. (  page 94)

	Do not delete files in the folder under “Sony Reader,” and files in 
“Sony Reader,” using Windows Explorer. Perform data 
management on eBook Library. For details on eBook Library 
operations, refer to the eBook Library Help.

To transfer content back to eBook Library

 Click the Start menu, then select “All Programs” - 
“Reader” - “eBook Library” to start eBook Library.

 Connect the Reader to your computer using the 
supplied USB cable. (  page 39)
“Reader” appears in the Source view.

Continued 4� US



PRS-700.GB.4-124-649-11(1)

 Click “Reader” in the Source view, then click  (List 
view).
The View area is switched to the List view and all the 
content in Library is listed.

 Hints
	When you click “Books,” “Audio” or “Pictures” in the Source 

view, only their respective content is displayed.
	When you click  (Thumbnail view), contents can be displayed 

as thumbnails.
	You can create a collection in the Reader and a memory card 

on the Reader, and the collection can be transferred to eBook 
Library. For details on how to create or transfer a collection, 
refer to the eBook Library Help.

 Select the content you want to transfer back from 
the list.
To select multiple content, click the content while 
holding down the Ctrl key.

 Drag the content from the list to “Library” in the 
Source view.
The content is transferred back to eBook Library.
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Synchronizing content in Library with Reader

You can synchronize content in the Library of eBook Library 
with the Reader by specifying a folder (such as “Library” or 
the sub-items under “Library”). The Reader can be 
automatically updated to match the content in the Library, 
when you connect it to your computer.

Note

	To synchronize content in the Library of eBook Library with the 
Reader, you need to specify a folder (such as “Library” or the sub-
items under “Library”). For details on how to specify a folder, refer 
to the eBook Library Help.

Hint
	When you want to synchronize content in the Library with the 

Reader right away, you can also synchronize them manually. For 
details on how to synchronize content manually, refer to the eBook 
Library Help.

 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

 Connect the Reader to your computer using the 
supplied USB cable. (  page 39)
eBook Library starts synchronizing content in the 
Library with the Reader automatically.

Continued 45 US



PRS-700.GB.4-124-649-11(1)

Hints
	eBook Library also starts synchronizing content in Library with the 

Reader automatically in the following situations:
	When you start eBook Library after connecting the Reader to 

your computer.
	After a period of time when any changes have been made to the 

specified folder.
	You can also synchronize content in the Library of eBook Library 

with a memory card on the Reader. For details on how to 
synchronize content with a memory card, refer to the eBook 
Library Help.

	You can also synchronize content in the computer drive with the 
Reader by specifying a folder as a favorite folder. For details, refer 
to the eBook Library Help.
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Reading Books

Reading Books
Selecting a book from the Book list

Follow the steps below to find books transferred from your 
computer.

 In the Home menu, tap  (Books).
The Book list appears.
When there are more than 10 books, the index bar 
appears on the right side of the list. The books are 
stored alphabetically. If your desired book is not 
displayed in the list, drag the index bar until the book 
appears or tap the letter of the book.



Indicates the number of days remaining before 
the expiration date of the book. If the book has 
already expired, “Expired” is displayed in place of 
the days.

 Indicator

Index bar

Indicates that 
content is 
stored on a 
memory card.

: “Memory 
Stick Duo” 
Memory 
Card

: SD Memory 
Card

Continued 47 US



PRS-700.GB.4-124-649-11(1)

	 Hints
	If you want to continue reading from the last displayed page, tap 

 (Continue Reading) in the Home menu. The last displayed 
page appears.

	The content on the memory card also appears in the Book list.
	You can also display the next page of the list by pressing the  

<  /  > (Page Turn) buttons.
	If an invalid operation is performed,  appears at the bottom 

of the screen.
	If a book has an expiration date, the number of days remaining 

before expiration is displayed in the Book list.
	“Expired” is displayed, when the book has been expired.

 Tap the desired book on the list.
The cover page of the book appears.
If you have read the book before, the last displayed 
page of the book appears. 
For details about operations on the Book page, refer to 
“Reading books on the Book page.” (  page 49)

Hint
	The Option menu of the Book list appears by pressing the OPTION 

button. For details about the Option menu of the Book list, refer to 
“Displaying the Option menu of a Book.” (  page 5�)
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Reading books on the Book page

You can read books by selecting the desired book from the 
Book list.

 Tap the desired book on the Book list.
The Book page appears.

Size indicator Current page number/
Total page number



 Hint
	You can display the Page jump panel by tapping the page 

number at the bottom of the screen. (  page 60)
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 On the Book page, drag on the page or press the 
<  /  > (Page Turn) button.
To go back to the previous page, drag on the page the 
opposite direction or press the <  (Page Turn) button.

    

 To turn pages repeatedly
If you hold on the touch panel after dragging, the pages 
turn repeatedly.

 Hints
	You can jump pages using the Page jump panel. (  page 60)
	You can reverse the direction of dragging in the Settings menu. 

(  page 110)
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Hint
	The Option menu of the Book page appears by pressing the 

OPTION button. For details about the Option menu of the Book 
page, refer to “Displaying the Option menu of a Book.” (  page 5�)

To close a book
Press the  (Back) button.

To use the link tool of eBooks files on the 
Reader
When an eBook file is displayed, you can use the embedded 
link tool.
The link appears highlighted on the screen. Tap to open the 
linked content or jump to the linked page.

Link

Hint
	If you want to return to the previous page after you jumped to the 

linked page, tap the page number at the bottom of the screen to 
display the Page jump panel, and then tap   (Previous View).
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Book types supported by the Reader

The following are the book types supported by the Reader 
and their characteristics.

BBeB file
(.lrf and .lrx file 
extension)

A file in BBeB format used in digital books 
and publications.
The link tool embedded in eBooks (page 
jumps, etc.) can be used. (  page 51)

PDF file*1

(.pdf file 
extension)

A File in PDF format (Version 1.4 or before)
Bookmark and link tool on PDF files can 
be used.

EPUB file*1

(.epub file 
extension)

A file in EPUB format used in reflowable 
digital books and publications.

Text file
(.txt file extension)

RTF file 
(.rtf file extension)

An RTF file (unsecured) that is 
automatically converted from a Microsoft 
Word file.*2

*1 Adobe DRM protected PDF and EPUB files supported only if Adobe 
Digital Editions 1.5 or later is installed and authorized on your 
computer. 

*2 Only if Microsoft Word is installed on your computer.
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Displaying the Option menu of a Book

The Option menu appears by pressing the OPTION button. 
You can use various functions from the Option menu.

Option menu of the Book list

Option item Description/Reference page

Sort Sorts the Book list “by Title,” “by Author” or “by 
Date.”

View Switches the list display format. (  page 55)

Now 
Playing*1

Goes to the audio Playback screen. (  page 97)

Orientation Switches the screen orientation (vertical/
horizontal). (  page 69)

*1 “Now Playing” appears only while a track is playing.

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Sorting a list
You can sort a list.
In the Option menu, tap “by Title,” “by Author” or “by Date” to 
sort the list.

Sorted “by Date”

Transferred 
date

Sorted “by Author”

Author name

Hints
	The sorting list function is also available in the Collection list, the 

All Notes list, the Notes list, the Audio list and the Picture list. The 
sorting items vary depending on the list. The default sorting items 
are following: 
The Book list: “by Title” 
The Collection list: “by Order” 
The All Notes list: “by Date” 
The Notes list: “by Page” 
The Audio list: “by Title” 
The Picture list: “by Title”

	In the index bar, letters that have applicable books or authors will 
be displayed in boldface.

	In the index bar, books or authors that begin with a number will be 
sorted under “#.” Those that begin with a symbol will be sorted 
under “ .”
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Note

	The appearance of the index bar differs depending on the sorting 
item. For example, when the list is sorted “by Date,” letters do not 
appear in the bar.

Switching list display format
You can choose to display the list format in either “List” or 
“Thumbnail” view.
In the Option menu, tap “Thumbnail” of “View” to switch the 
list display format.

“List” (default) “Thumbnail”

When you change the list display format, the Audio list and 
the Pictures list are also switched to the selected format.

Notes

	In the Book list and the Audio list, the thumbnail can be displayed 
only if the book or the track has cover art information.

	Some cover art cannot be displayed, depending on its file format.
	If books or tracks do not have cover art information, the default 

image will be displayed in “Thumbnail” list.
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Option menu of the Book page

Option item Description/Reference page

Go to Page Displays the Page jump panel. (  page 60)
Create/Edit 
Notes

Displays the tool bar to create/delete a bookmark/
highlight/comment. (  page 78)

Hide Notes/
Show Notes

Hides/Displays the bookmark/highlight. (  page 
84)

Table of 
Contents*1

Displays the table of contents.

Book Info Displays the book information. (  page 57)
Delete Book Deletes a book. (  page 94)
Now 
Playing*2

Goes to the audio Playback screen. (  page 97)

Orientation Switches the screen orientation (vertical/
horizontal). (  page 69)

*1 The displayed items vary depending on the content.
*2 “Now Playing” appears only while a track is playing.

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Book information
You can check the book information, such as title, author, 
book cover thumbnail, etc.
In the Option menu of the Book page, tap “Book Info” to 
display the book information.

Options Description

Book cover 
thumbnail*1

Displays the book cover thumbnail.

Title Displays the title.
Author Displays the author.
Publisher*1 Displays the publisher.
Category*1 Displays the category.
eBook ID*1 Displays the Book ID.
Kind Displays the file type.
Date Displays the latest update and creation date.
Size Displays the file size.
Location Displays the memory location where the book is stored.

Internal memory: The book is stored on the Reader.
Memory Stick/ SD Memory Card: The book is 
stored on a memory card.

Path Displays the file path location.
Digital 
Rights*1,*2

Displays the following only if a book with DRM is 
selected.
Full viewable: The entire book can be read.
Restricted: Some or all of the book cannot be read.

Expiration 
date*2

Displays the expiration date of a book if the book 
with DRM has an expiration date.

*1 This option appears only when BBeB book is selected.
*2 This option appears only when PDF and EPUB files are selected.
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Selecting a book from the 
Collection list
You can select and read a book from the list of collections 
created in eBook Library.

Hints
	For details on how to create or transfer a collection, refer to the 

eBook Library Help.
	You can search the Collection list for a collection using the Search 

menu. 
For details about the Search menu, refer to “Searching for books.”  
(  page 74)

	The Option menu of the Collection list appears by pressing the 
OPTION button. You can switch the screen orientation from the 
Option menu. (  page 69)

	You can also display the Option menu of a collection by pressing 
the OPTION button while the Book list of a collection is displayed. 
For details about the available menus, refer to “Displaying the 
Option menu of a collection.” (  page 59)

 In the Home menu, tap  (Collections).
The Collection list appears.

 Tap the desired collection on the list.
The Book list appears.

 Tap the desired book.
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Displaying the Option menu of a collection

The Option menu appears by pressing the OPTION button.
You can use various functions from the Option menu.

Option menu of a collection

Option item Description

Sort Sorts the list “by Order,” “by Title,” 
“by Author” or “by Date.”

View Switches the list display format. 
(  page 55)

Now Playing*1 Goes to the audio Playback 
screen. (  page 97)

Orientation Switches the screen orientation 
(vertical/horizontal). (  page 69)

*1 “Now Playing” appears only while a track is playing.

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Jumping to Pages
The Page jump panel appears by tapping “Go to Page” in 
the Option menu of the Book page. With the Page jump 
panel, you can skip pages and go to a page directly.

Hint
	You can display the Page jump panel by tapping the page number 

at the bottom of the screen.

	 In	the	Book	page,	press	the	OPTION	button.
The Option menu appears.

	 Tap	“Go	to	Page.”
The Page jump panel appears.

Enter Page #
(  page 62)

Page jump bar (  page 61)

 (Previous View)/ 
  (Next View)
(  page 63)

To close the Page jump panel
Tap  or the page number at the bottom of the screen. Or, 
press the  (Back) button or the OPTION button.
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Using the Page jump bar

You can skip pages using the Page jump bar on the Page 
jump panel.

 Drag the slider, or tap a point on the Page jump bar.
The page is displayed based on the slider position in the 
Page jump bar.

Slider
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Jumping to the specified number page 
directly

You can jump directly to a page by inputting the page 
number with the on-screen numeric keyboard.

 Tap “Enter Page #” on the Page jump panel.
The numeric keyboard appears.

Input area

Number Keys

 (Backspace) key

 Tap the number key to input the page number.
The input number is displayed in the input area. To 
delete the number, tap  (Backspace) key.

Hint
	Up to 10 numbers can be input.

 Tap “Go.”
The input page appears.
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Reading previously displayed pages

The Reader stores previously displayed pages in the 
memory for easy recall.

 Tap   (Previous View) on the Page jump panel.
The previously displayed page appears. To return to the 
page before the jump, tap   (Next View).
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Resizing and Zooming
The Size menu appears by pressing the  (Size) button. In 
the Size menu, you can adjust the text size, and zoom in/out 
a page.

 In the Book page, press the  (Size) button.
The Size menu appears.

 Zoom In 
(  page 67)

Size icons (  page 65)

To close the Size menu
Tap , or press the  (Back) button or the  (Size) button.
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Adjusting the text size

You can select from 5 different text sizes (S, M, L, XL or 
XXL) in the Size menu. “S” (original size) is set by default.

 Tap “M,” “L,” “XL” or “XXL.”
The text size is magnified to the selected size, and the 
text is reflowed in the Book page. The selected size is 
indicated at the bottom of the screen, and the original 
page is divided into multiple divided sections.

Size indicator

 Tap , press the  (Back) button or the  (Size) 
button to close the Size menu.
After the Size menu is closed, the texts are displayed in 
the selected size. To return the texts to the default size, 
tap “S” in the Size menu.
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Hints
	When viewing a PDF file in S size, you can magnify the text size by 

switching the screen orientation to “Horizontal.” This should be 
used only if retaining the original layout of the PDF file is required.

	The text size of BBeB, PDF or EPUB files will be magnified at the 
following ratios: 
BBeB file: S(100%), M(120%), L(150%), XL(200%), XXL(260%) 
PDF file: S(100%), M(200%), L(300%), XL(450%), XXL(600%) 
EPUB file: S(100%), M(140%), L(180%), XL(230%), XXL( - )*
*	 XXL	size	is	not	available	for	EPUB	files.

Notes

	If the text size is magnified, the total page number displayed on the 
Reader increases with the number of divided page sections. 
However, if the text size of a PDF or EPUB file is magnified, the 
total page number is not increased, and the current page number 
is displayed using the same page number as the original scale.

	PDF files viewed in M, L, XL and XXL sizes are displayed in reflow 
mode. In certain situations, only text appears in these scales as 
some tables and graphics may be reformatted and altered. In these 
cases, viewing in S size will retain the original formatting.

	Certain image-based pages such as a cover page of a book, or a 
PDF file that are created as an image file, cannot be magnified to 
M, L, XL or XXL size. In these cases, it is recommended to use the 
Zoom Mode.
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Zooming in/out

The Book page enters zoom mode by tapping “  Zoom In” 
on the size menu panel.

 Tap “  Zoom In.”
The Zoom bar appears.

Slider

Zoom bar

 Move the slider, or tap + or – of the Zoom bar 
repeatedly until the page is zoomed to the desired 
scale.
The page is zoomed in/out.

Hints
	You can also zoom in/out a Book page by tapping a point in 

the Zoom bar.
	By double-tapping on a Book page in zoom mode, the page is 

zoomed in and the double-tapped point is centered.
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To scroll the magnified page
When the Book page is zoomed in, / / /  appear at the 
edges of the screen. You can display the edge of the page 
by tapping / / / .

You can also scroll the page by dragging it.

To exit the Zoom mode
Tap , press the  (Back) button or the  (Size) button. 
The Zoom bar disappears and the Book page screen 
returns to the original text size.
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Switching screen orientation 
(vertical/horizontal)
In the Option menu, you can switch the screen orientation 
from vertical to horizontal or vice versa. Once the screen 
orientation is switched, all the menus and the contents are 
displayed in the selected orientation.

Hint
	You can switch the screen orientation from any of the Option 

menus.

 Press the OPTION button.
The Option menu appears.

 Tap “Orientation.”
The orientation is switched from vertical to horizontal.
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About screen division when screen orientation 
is set to horizontal
When set to horizontal, the Book page is divided into 2 parts 
(upper and lower). To display the lower part, drag the page 
or press the  > (Page Turn) button.

>

<

Displaying 
upper half

Displaying 
lower half

Position 
indicator



“Vertical” “Horizontal”
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Searching for Books or Keywords
The Search menu appears with the on-screen keyboard by 
pressing the SEARCH button. With the on-screen keyboard, 
you can search for books and keywords by inputting a word.

 Press the SEARCH button.
The Search menu appears.

Search

Input area

On-screen keyboard
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 Tap the on-screen keyboard to input the word.
The word appears in the input area.

Input areaCursor

Keyboard History

Character keys

 (Backspace)
/@#$

Symbols/Abc

To edit an input word
Tap the input word directly to move the cursor.

To delete a character
Select the unnecessary character by dragging on it or 
tap the unnecessary character to move the cursor to the 
right of it, and then tap  (Backspace). 

To change the character displayed in the on-screen 
keyboard
Tap “Symbols.” The keyboard is switched to the symbol 
keyboard. To return to the alphabet keyboard, tap “Abc.”
To toggle the alphabet character between lower-case 
and the upper-case, tap “.”
There are 2 patterns (high priority/low priority) of the 
symbol keyboard. To switch to the other type of symbol 
keyboard, tap “@#$.”
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Hints
	Up to 48 characters can be input.
	The previously typed words are displayed in the Keyboard 

History area. As you input characters, only applicable words 
remain. If you tap the word, it appears in the input area.

Notes

	Words less than � letters or more than 16 letters are not 
recorded in the Keyboard History.

	Keyboard History records letters and hyphens. Numbers or 
other symbols are not recorded. 

 Tap “Search.”
For details about searching for books or keywords, refer 
to the following.
	Searching for books (  page 74)
	Searching a book for keywords (  page 76)

To close the Search menu
Tap , or press the SEARCH button or the  (Back) 
button.
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Searching for books

You can search for books by title or author in the Home 
menu, Book list and Collection list.
Hints
	You can also search a collection by collection name in the 

Collection list.
	You can also search for a Note by word in the All Notes list or the 

Notes list. (  page 88)

 In the Home menu or the Book list, press the 
SEARCH button.
The Search menu appears with the on-screen keyboard.

 Input the word using the on-screen keyboard. (  
page 72)
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 Tap “Search.”
The Search Results list appears. 
Any books that have the input word included in the title/
author are displayed in the Search Results list.

 Tap the desired book.
The Book page appears.

To close the Search Results list
Tap , or press the  (Back) button.
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Searching a book for keywords

You can search for keywords by using the on-screen 
keyboard. The keywords can be displayed in the input area 
by the following two ways:
	Double-tap a word on a Book page, and then press the 

SEARCH button. The double-tapped word is displayed in 
the input area.

	Press the SEARCH button on a Book page. Input the 
keyword using the on-screen keyboard.

 In the Book page, press the SEARCH button.
The Search menu appears with the on-screen keyboard.

 Input the word using the on-screen keyboard. (  
page 72)

To input a word on the Book page
Double-tap the word on the Book page to highlight 
temporarily (to select consecutive words, including 
punctuation, etc., drag across the phrase without lifting 
after double-tapping), and then press the SEARCH button. 
The tapped word (or phrase) is placed in the input area.

Tapped word

Input area
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Note

	Highlights that are created by double-tapping can be erased in 
the following ways: 
– Tapping on any area of the page other than the highlighted area 
– Double-tapping another word 
– Opening another book

 Tap “Search.”
The search result page including the input word 
appears. The words are highlighted on the page.

 Tap   (Next Search) to skip to the next page 
which includes the word.
The next page which includes the input word appears. 
To return the previous page which includes the input 
word, tap  	(Previous Search).

To exit the search result page
Tap , or press the  (Back) button.

77 US



PRS-700.GB.4-124-649-11(1)

Creating Notes on a Book Page
The tool bar appears by tapping “Create/Edit Notes” in the 
Option menu of the Book page. With the tool bar, you can 
create the following Notes.
	Creating a bookmark (  page 79)
	Highlighting words (  page 82)
	Adding a comment (  page 85)

 In the Book page, press the OPTION button.
The Option menu appears.

 Tap “Create/Edit Notes.”
The tool bar appears.

 Notes  
(  page 91)

 (Highlight) 
(  page 82)

 (Eraser)  
(  page 83)

 (Bookmark) 
(  page 79)
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To close the tool bar
Tap , or press the  (Back) button.

Creating a bookmark on a Book page

You can create a bookmark on a Book page you may wish 
to return to. 
A bookmark can be created by the following two ways.
	On the Book page, create a bookmark by double-tapping 

a page.
	On the Book page, create a bookmark using the tool bar.

To create a bookmark by double-tapping a 
page

 In the Book page, double-tap near the upper right 
corner of the screen.
The bookmark appears in the upper right corner of the 
current page. 

Bookmark

Continued 79 US



PRS-700.GB.4-124-649-11(1)

To create a bookmark using the tool bar 

 In the Book page, press the OPTION button.
The Option menu appears.

 Tap “Create/Edit Notes.”
The tool bar appears.

 Tap  (Bookmark).
The bookmark appears in the upper right corner of the 
current page, and the color of  in the tool bar is 
reversed.

 (Bookmark)

Bookmark

Hint
	You can add a comment to a bookmark. For details, refer to 

“Adding a Comment to a Note.” (  page 85)
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To delete a bookmark
To delete a bookmark, double-tap the bookmark. 
You can also delete a bookmark by tapping  on the tool bar.

Hints
	While you are viewing a comment of a bookmark in the Comment 

viewer, you can delete both the bookmark and comment by tapping 
“Delete.” (  page 87)

	You can delete all the Notes within a book from the Option menu of 
the Notes list. (  page 9�)

Note

	When you delete a bookmark with a comment, the comment will 
also be removed. Tap “Yes” in the confirmation message to delete 
both the bookmark and the comment.

To display a bookmarked page
You can display the bookmarked page from the All Notes list 
and the Notes list. (  page 89, 91)
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Highlighting words

You can highlight words on a Book page. 

 Tap  (Highlight).
The color of  in the tool bar is reversed and the 
highlighting function becomes available.

 Drag across the word on the Book page.
The word is highlighted.

 (Highlight)

Highlighted word

 Hint
	You can add a comment to a highlight. For details, refer to 

“Adding a Comment to a Note.” (  page 85)

Hints
	You can also highlight a word with a hyperlink and add a comment 

to it (  page 85).
	To highlight multiple lines of text all at once, drag across the lines 

starting from the first character to the last character. 
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Notes

	When you tap a highlighted word with a hyperlink, the Comment 
editor (  page 85) or the Comment viewer (  page 87) appears 
instead of jumping to a page. To enable the hyperlink, hide the 
highlights using “Hide Notes” in the Option menu, or delete the 
highlight.

	You cannot highlight the cover page and pictures, as well as book/
chapter titles that are displayed at the upper right of a Book page.

To delete a highlight
 Tap  (Eraser).

The color of  in the tool bar is reversed and the 
highlight erase function becomes available.

 Tap, or drag across the highlighted word on the 
Book page.
The highlight is erased.

Hints
	While you are viewing a comment of a highlight in the Comment 

viewer, you can delete both the highlight and comment by tapping 
“Delete.” (  page 87)

	You can delete all the Notes within a book from the Option menu of 
the Notes list. (  page 9�)

Note

	When you delete a highlight with a comment, the comment will also 
be removed. Tap “Yes” in the confirmation message to delete both 
the highlight and comment.
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Hiding Notes (bookmark/highlight)
Bookmarks or highlights in a book can be hidden/shown 
from the Option menu of a Book page. 

 Tap “Hide Notes.”
All the bookmarks and the highlights within the book are 
hidden temporally. To show them again, tap “Show 
Notes.”
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Adding a Comment to a Note
You can add a comment to a bookmark or a highlighted 
word using the on-screen keyboard in the Comment editor.

	 Tap	the	bookmark	or	the	highlighted	word.
The Comment editor appears.

On-screen keyboard

Input screen
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	 Enter	your	comment	using	the	on-screen	keyboard.
For details on how to use the on-screen keyboard, refer 
to  page 72.
The on-screen keyboard in the Comment editor has a 
“Return” key. You can indent the line using this key.

Hint
	Up to 2048 characters can be input in a comment.

	 Tap	“Done.”
The Comment editor is closed, and  is attached to the 
bookmark or the highlight.

Note

	Make sure to tap “Done” when you finish inputting the 
comment. If you tap , the comment will not be added.
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To view a comment
Tap  (Bookmark and comment) or (Highlight and 
comment) on a Book page. The Comment viewer appears.

Page number of the 
comment

/: 
The arrows become available when 
the comment has multiple pages.
To display the previous/next page of 
the comment, tap /.

Note

	When you tap a highlighted word with a hyperlink, the Comment 
editor (  page 85) or the Comment viewer appears instead of 
jumping to a page. To enable the hyperlink, hide the highlights 
using “Hide Notes” in the Option menu, or delete the highlight. (  
page 83, 84)

To edit the comment
Tap “Edit” in the Comment viewer to display the Comment 
editor. Edit the comment using the on-screen keyboard. (  
page 72)

To delete a comment
Tap “Delete” in the Comment viewer. The comment and the 
bookmark/highlight will be deleted.
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Opening a Page from a Notes List
You can directly open a page with a bookmark or highlighted 
words from the List screen.

Hints
	Notes can also be created in eBook Library.  

In eBook Library, you can set to merge the Notes of the Reader 
and eBook Library while synchronizing. When merging the Notes, if 
any inconsistent Notes are created for the same word, the older 
Notes will be replaced with the latest Notes.

	When you copy a book from eBook Library to the Reader, the 
Notes of the Reader will be replaced with the ones of the eBook 
Library (or vice versa).

	The annotations of a book transferred from Adobe Digital Editions 
1.5 or later are converted into the bookmarks on the Reader.
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Searching the Reader for Notes

By tapping  (All Notes) in the Home menu, the All Notes 
list appears. The All Notes list includes all the Notes of all 
the books stored on the Reader and memory cards. You can 
jump to a page by tapping an item in the list.

Hint
	You can search the All Notes list for a Note using the Search menu.

 In the Home menu, tap  (All Notes).
The list of all the bookmarks and highlights on the 
Reader appears.

Indicates type of the Note
 (Bookmark): The first sentence of the page is displayed.
 (Highlight): The highlighted word is displayed.
 (Highlight with comment): The comment is displayed.
 (Bookmark with comment): The comment is displayed.

Annotated date/Book title/Page number

 Tap a Note.
The page that includes the Note is displayed.
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Displaying the Option menu of the All Notes 
list

The Option menu appears by pressing the OPTION button. 
You can use various functions from the Option menu.

Option menu of the All Notes List

Option item Description

Sort Sorts the list “by Date,” “by Type” 
or “by Comment.”

Now Playing*1 Goes to the audio Playback 
screen. (  page 97)

Orientation Switches the screen orientation 
(vertical/horizontal). (  page 69)

*1 “Now Playing” appears only while a track is playing.

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Searching a book for Notes

By tapping “  Notes” in the tool bar, the Notes list appears. 
The Notes list includes all the Notes of the currently viewed 
book. You can jump to a page by tapping an item in the list.

Hint
	You can search the Notes list for a Note using the Search menu.

 In the Book page, press the OPTION button.
The Option menu appears.

 Tap “Create/Edit Notes.”
The tool bar appears.
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 Tap “  Notes.”
The list of all the bookmarks and highlights in the 
current book appears. 


Page number

 (Bookmark): 
The first sentence of the page is 
displayed.

 (Highlight): 
The highlighted word is displayed.
Indicates type of the Note

 (Highlight with comment): 
The comment is displayed. 

 (Bookmark with comment): 
The comment is displayed

 Tap a Note.
The page that includes the Note is displayed.

To delete all the Notes within a book
In the Option menu of the Notes list, tap “Delete Notes.”
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Displaying the Option menu of the Notes List

The Option menu appears by pressing the OPTION button.
You can use various functions from the Option menu.

Option menu of the Notes List

Option item Description

Sort Sorts the list “by Page,” “by Type” 
or “by Comment.”

Delete Notes Deletes all the bookmarks, 
highlights and comments within 
the book.

Now Playing*1 Goes to the audio Playback 
screen. (  page 97)

Orientation Switches the screen orientation 
(vertical/horizontal). (  page 69)

*1 “Now Playing” appears only while a track is playing.

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Deleting a book 
You can delete a book on the Reader or memory cards that 
are inserted into the Reader.

 In the Book page, press the OPTION button.
The Option menu appears.

 Tap “Delete Book.”
The confirmation message appears.

 Tap “Yes.”
The book is deleted and the screen goes to the Book 
list.
Note

	Confirm carefully before deleting the book.
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Playing Audio Files

Playing Audio Files
Playing audio files transferred from your 
computer

MP� and AAC files (unsecured) can be played back on the 
Reader. You can also read books while listening to an audio 
file. (  page 96) When listening to audio files, connect the 
optional headphones to the headphone jack.

 In the Home menu, tap  (Audio).
The Audio list appears.

Indicates that 
content is stored 
on a memory 
card.

: “Memory 
Stick Duo” 
Memory Card

: SD Memory 
Card

Thumbnails of 
pictures (if 
contained on files)

 Indicator



 Hints
	The content on the memory card also appears in the Audio list.
	When more than 10 tracks are stored, the index bar appears 

on the right side of the list. You can display the next page of 
the list by scrolling the bar, or pressing the  > (Page Turn) 
button.

	If an invalid operation is performed,  appears at the bottom of 
the screen.
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 Tap the desired track.
Playback starts.
Then, succeeding tracks are played in the listed order.

To stop playback, tap  on the screen.

To close the Audio list or the Playback screen
Press the  (Back) button.

Hints
	You can read a book while playing tracks. To do so, play the track 

before you begin to read a book.
	The Option menu of the Audio appears by pressing the OPTION 

button. (  page 98)
	While a track is playing, the volume indicator appears at the bottom 

right of the screen.
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Operations on the Playback screen
On the Playback screen, the following operations can be 
performed.

Play mode icon*1

: Shuffle play
: Repeat (1 Song)

: Repeat (All Songs)
Track name
Artist name

Album name

Slider
Volume indicator

Elapsed 
playback time/ 
Total time of the 
current track

Current track number/
total track number

Playback progress bar

(stop)/(play)

Picture area

*1 The play mode icons appear while tracks are playing in shuffle play or 
repeat play. (  page 99)

Button/Gesture Operation

 Dragging (  page 19)
   /   (Page Turn) 
buttons

Skips to the previous/next track.

Playback progress bar Rewinds/Fast-forwards the track 
by dragging the slider or tapping a 
point of the Playback progress 
bar.

/ Stops/Restarts the playback.

VOL –/+ button 	Adjusts the volume.
	Mutes on/off by pressing and 

holding it.
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Displaying the Option menu of the Audio

The Option menu appears by pressing the OPTION button.
You can use various functions from the Option menu.

Option menu of the Audio list

Option item Description/Reference page

Sort Sorts the Audio list “by Title”or “by 
Artist.”

View Switches the list display format. 
(  page 55)

Now Playing*1 Goes to the audio Playback 
screen. (  page 97)

Orientation Switches the screen orientation 
(vertical/horizontal). (  page 69)

*1 “Now Playing” appears only while a track is playing.

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Option menu of the Playback screen

Option item Description/Reference page

Repeat Off (default setting): Stops 
playback after playing all tracks.
1 Song: Plays the current track 
repeatedly.
All Songs: Plays all tracks 
repeatedly.

Shuffle Off/On Plays all tracks in random order.

Continue Reading Goes to the Book page screen. 
The last displayed page appears.

Orientation Switches the screen orientation 
(vertical/horizontal). (  page 69)

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Viewing Pictures

Viewing Pictures
Viewing pictures transferred from your computer

BMP/JPEG/GIF/PNG files can be viewed on the Reader.

 In the Home menu, tap  (Pictures).
The Picture list appears.

Indicates that 
content is stored 
on a memory 
card.

: “Memory 
Stick Duo” 
Memory 
Card

: SD Memory 
Card

Thumbnails

 Indicator



	 Hints
	The content on the memory card also appears in the Picture list.
	When more than 10 pictures are stored, the index bar appears 

on the right side of the list. You can display the next page of 
the list by scrolling the bar, or pressing the  > (Page Turn) 
button.

	If an invalid operation is performed,  appears at the bottom of 
the screen.
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 Tap the desired picture.
The Picture appears.

To close the Picture list or the Picture viewer
Press the  (Back) button. 

Hints
	The Size menu of the Picture viewer can be displayed by pressing 

the  (Size) button. In the Size menu, you can zoom in/out a 
picture. (  page 67)

	The Option menu of the Picture appears by pressing the OPTION 
button. (  page 104)

	To increase the resolution of landscape pictures, view them in 
horizontal mode. (  page 69)
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Operations on the Picture viewer
On the Picture viewer, the following operations can be 
performed.

Current picture number/
total picture number

Button/Gesture Operation

 Dragging (  page 19)
   /   (Page Turn) 
buttons

To display the previous/next 
picture.
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To zoom in/out a picture
You can zoom in/out a picture. On the Picture viewer, press 
the  (Size) button to display the Picture menu, and then 
tap “Zoom In” to display the Zoom bar. 
For details about using the Zoom bar and scrolling the 
magnified picture, refer to “Zooming in/out” (  page 67). 



Zoom bar

Slider
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Displaying the Option menu of the Picture

The Option menu appears by pressing the OPTION button.
You can use various functions from the Option menu.

Option menu of the Picture list

Option item Description/Reference page

Sort Sorts the Picture list “by Title”or 
“by Date.”

View Switches the list display format. 
(  page 55)

Now Playing*1 Goes to the audio Playback 
screen. (  page 97)

Orientation Switches the screen orientation 
(vertical/horizontal).  (  page 69)

*1 “Now Playing” appears only while a track is playing.

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Option menu of the Picture Viewer

Option item Description/Reference page

Slideshow On/Off Starts/Stops a slideshow of 
pictures.
The slideshow setting can be 
configured from the Settings 
menu. (  page 110)

Now Playing*1 Goes to the audio Playback 
screen. (  page 97)

Orientation Switches the screen orientation 
(vertical/horizontal). (  page 69)

*1 “Now Playing” appears only while a track is playing.

Note

	When the “Slideshow” setting in the Settings menu is set to “Off,” 
slideshow does not start even if you select “Slideshow On” in the 
Option menu.

To close the Option menu
Tap , press the  (Back) button or the OPTION button.
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Settings

Changing Settings
You can configure the various settings in the Settings menu.

 In the Home menu, tap  (Settings).
The Settings menu appears. 
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 Tap the setting item to select.
The Settings menu of the selected item appears. When 
you select “Advanced Settings,” the Advanced Settings 
menu appears. Tap setting item to select again.
	Settings menu items (  page 109)
	Advanced Settings menu items (  page 112)

Advanced Settings menu

 Tap to select a setting. To input number, tap the 
numeric key.
Example: Device Lock

Numeric Keys
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 Tap “OK” or “Yes” to confirm the setting.

To close the Settings menu
To close the Settings menu and the Advanced Settings 
menu, press the  (Back) button.
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Settings menu items

In the Settings menu, you can configure the following 
settings.

Setting item Description

Date and Time Set date and time displayed on the 
Reader. To input the value, tap the 
numeric key. 

Hint
	When you connect the Reader to your 

computer with eBook Library started, the 
date and time of the Reader is automatically 
synchronized with your computer clock.

Power 
Management

Activate or deactivate the Power 
Management.
On (default setting): 
	After 60 minutes of inactivity, the Reader 

enters sleep mode automatically while the 
battery power is consumed slightly.

	After 5 days of inactivity, the Reader 
automatically shutdown and stops 
consuming the battery power.

	If battery power is at a low level, the Reader will 
shutdown after 60 minutes of inactivity.

Off: The Reader does not activate the 
Power Management.
For details, refer to “About the Power 
Management of the Reader.” (  page 24)

Continued 109 US



PRS-700.GB.4-124-649-11(1)

Setting item Description

Power 
Management 
(Continued)

Note

	In the following states, the Reader does not 
enter sleep mode after 60 minutes of 
inactivity even if “Power Management” is set 
to “On.”
– When connected to the computer using the 

supplied USB cable
– When connected to the AC Adaptor for 

Reader (AC-S5220E) (optional) to charge
– When playing tracks

Page Turn 
Gesture

Change the drag direction to turn pages.
: A page proceeds to the next page by 
dragging from left to right on the touch 
panel.
: A page proceeds to the next page by 
dragging from right to left on the touch 
panel. 

Slideshow Configure the slideshow settings.
On: Activate slideshow.
Off (default setting): Deactivate slideshow.
Slide Duration: To input the duration time, 
tap the numeric key. The duration time can 
be set up to 60 seconds in 1 second 
increments.

Note

	When a large size picture is displayed, it 
may take longer to display the picture than 
the indicated setting time on “Slide Duration.”

Advanced 
Settings

Refer to “Advanced Settings menu items.”  
(  page 112)
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Setting item Description

About Display the firmware version of the 
Reader, the product name, and the license 
information, etc.

Restore Defaults Refer to “Restoring default settings.”  
(  page 124)
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Advanced Settings menu items

In the Advanced Settings menu, you can configure the 
following settings.

Setting item Description

Device Lock Lock the Reader by setting a password.
On:  The Reader is locked by the 

password.
Off (default setting):  The Reader is not 

locked.
Code:  To input a password, tap the 4-digit 

number using the numeric keys. 
Once the password is set, next time you 
turn on the Reader, the screen asking for 
the password appears. To unlock it, input 
the password using the numeric keys, and 
then tap “OK.”

Note

	Be sure not to forget the password. If you 
lost it, contact Sony Support Center. 
For customers in the USA: 
Phone number: 1-866-962-7669 
For customers in Canada: 
Phone number: 1-877-899-7669

Touch Panel Calibrate the touch panel by tapping on 
the screen accurately. For details about 
calibrating, refer to “Calibrating the Touch 
Panel.” (  page 26)
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Setting item Description

Clear Keyboard 
History

Delete the record of all the typed words 
using the on-screen keyboard. After 
deleting the record, no word will appear in 
the Keyboard History area on the on-
screen keyboard.

Format Internal 
Memory

Format the built-in flash memory of the 
Reader. By formatting the memory, all the 
contents on the Reader will be erased.

Note

	Before formatting, make sure to transfer data 
that you do not want to lose to your 
computer or other device.

Device Shutdown Shutdown the Reader to minimize the 
battery consumption. 

Hint
	You can also shutdown the Reader by sliding 

the POWER switch and holding it for more 
than � seconds.

Notes

	After shutdown, the Reader may take a few 
moments to turn on.

	When you connect the Reader to your 
computer after shutdown, the Reader needs 
to be turned on again.

11� US



PRS-700.GB.4-124-649-11(1)

Troubleshooting

Troubleshooting
If the Reader does not function as expected, try the 
following steps to resolve the issue.

 Reset the Reader by pressing the RESET button 
with the tip of the supplied stylus, a small pin or tip 
of a paper clip.

Removing the tip from the supplied stylus
Twist the tip until it detached from the supplied stylus. To 
push the RESET button, use the other end of the tip that 
is stored in the body. Be sure to attach again after using 
it.

Use to push the RESET button

The content and settings stored on the Reader are not 
affected by resetting, and no information is erased.
After pressing the RESET button, turn on the Reader by 
sliding the POWER switch.
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Notes

	The screen will not change after pressing the RESET button. 
Slide the POWER switch to activate the Reader again.

	When you connect the Reader to your computer after a reset, 
it is necessary to turn on the Reader again. Otherwise, it takes 
approximately 5 minutes until  is displayed, during which 
time you will not be able to turn on the Reader by the POWER 
switch. In this case, disconnect the USB cable from the 
Reader, then turn on the Reader and reconnect it.

 Check the symptoms in “Troubleshooting.” (  page 
116)

 Check for information about the issue in eBook 
Library Help.

 Look for information about the issue on one of the 
support Web sites.
For customers in the USA:
http://www.sony.com/readersupport
For customers in Canada:
http://www.sony.ca/ElectronicsSupport/

 If the approaches listed above fail to resolve the 
issue, please call Sony Support Center.
For customers in the USA:
Phone number: 1-866-962-7669
For customers in Canada:
Phone number: 1-877-899-7669
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Power
Symptom Cause or corrective action

Battery cannot be 
charged (The 
indicator does not 
light up).

 Charge the battery within the 
temperature range of 50 °F to 86 °F 
(10 °C to �0 °C). 
Otherwise, the charging may be 
insufficient or may not start. 

Battery life seems 
short.

 The operating temperature is below 
41 °F (5 °C). This is due to the 
battery characteristics and not a 
malfunction.

 You have not used the Reader for a 
prolonged period. Efficiency of the 
battery will be improved by 
repeatedly charging and discharging.

 The battery needs to be replaced. 
Consult your nearest Sony Service 
Center.

 The battery has not been given 
enough time to charge fully.

	 Charge the battery until the indicator 
goes off. (The battery icon does not 
indicate remaining battery power 
during charging.)

 The battery life becomes shorter if 
the built-in light is turned on all the 
time. (  page �2)
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Symptom Cause or corrective action

The Reader cannot 
be turned on.

 Moisture condensation may have 
occurred. Wait for a few hours and 
then turn on the Reader.

 If the battery has been fully depleted, 
connect to your computer via USB 
and charge the battery. (  page �9)

 If the battery has been fully depleted, 
it takes approximately 5 minutes until 

 is displayed, during which time 
you will not be able to turn on the 
Reader by the POWER switch. In 
this case, wait until  is displayed. 
The charge indicator lights up in red 
while  is not displayed, while the 
Reader is charging.

Power (continued)
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Screen
Symptom Cause or corrective action

It takes time for the 
display to appear.

 In a cold place such as outdoors, it 
may take time for the display to 
appear.

	 This is due to the display 
characteristics and not a malfunction.

The Reader 
authorization/
deauthorization is 
not possible with 
eBook Store from 
Sony.

  The Reader authorization/
deauthorization is not possible with 
eBook Store from Sony if “Device 
Lock” of the Reader is set to “On.” 
Set it to “Off,” then authorize/
deauthorize the Reader.

You cannot select 
items even if you tap 
the center of them.

  Calibrate the touch panel from 
“Touch Panel” in the “Advanced 
Settings” menu. (  page 112)

The screen is frozen.   Reset the Reader by pressing the 
RESET button. Then, slide the 
POWER switch to activate the 
Reader again. (  page 114)
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Reading/playing/viewing contents
Symptom Cause or corrective action

A book cannot be 
read.

 A book with copyright protection 
cannot be read on any device other 
than the authorized one.

 If the book has an expiration date, 
confirm whether the book has 
already expired.  page 47.

An audio file cannot 
be played back.

 Audio files that are not supported by 
the Reader cannot be played. For 
details on supported audio files, refer 
to  page 95.

Sound is not output.  Increase the volume if it is set to low.
 If sound is not output through 

headphones, make sure the 
headphone plug is firmly inserted in 
the headphone jack.

A picture cannot be 
displayed.

 Picture files that are not supported 
by the Reader cannot be viewed. For 
details on supported picture files, 
refer to  page 100.

 A picture of large size may not be 
displayable, and its file will not appear 
in the list. Delete the picture file using 
eBook Library.

The data on 
Continue Reading or 
Notes of some files 
is missing.

 If the file status has changed (such 
as in the following cases), the data 
on Continue Reading or Notes may 
be deleted.
	A Text/RTF/PDF file is edited.
	An eBook purchased with an authorized 

Reader is read on another de-authorized 
Reader by memory card transfer.
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Connection to the computer
Symptom Cause or corrective action

The Reader cannot 
be operated during 
USB connection.

 Disconnect the Reader from the USB 
connection.

The Reader cannot 
be recognized.

 Is the power of the Reader turned on? Is 
the USB cable connected properly?

	 Verify the above and try again.
 Are you using a USB hub or USB 

extension cable?
	 Connecting the Reader via a USB 

hub or extension cable may not work 
and is not supported. Connect the 
USB cable directly to the computer.

 Verify that  (indicating connection 
via USB) is displayed at the top of the 
Reader’s screen. If the Reader still 
cannot be recognized, disconnect the 
USB cable from the Reader, then 
reconnect it after a while.

 If “Device Lock” of the Reader is set 
to “On,” set it to “Off.” If the Reader is 
locked, it will not be recognized on 
your computer.

Content cannot be 
transferred to the 
Reader from your 
computer.

 The USB cable is not connected 
properly. Disconnect the USB cable, 
then reconnect it.

 There is not enough free space on 
the Readers memory. Transfer any 
unnecessary content back to eBook 
Library or to a “Memory Stick Duo” 
Memory Card, then delete it to 
increase free space on the Reader.
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Symptom Cause or corrective action

There is no response 
from eBook Library 
during 
communication with 
the Reader.

 Disconnect the USB cable from the 
Reader, then reconnect it.

The Reader 
becomes unstable 
while it is connected 
to the computer.

 Are you using a USB hub or USB 
extension cable?

	 Connecting the Reader via a USB 
hub or extension cable may not work 
and is not supported. Connect the 
USB cable directly to the computer.

The Reader’s battery 
cannot be charged 
(The indicator does 
not light up).

 Is the USB cable connected 
properly? Verify and try again.

 Are you using a USB hub or USB 
extension cable? Connecting the 
Reader via a USB hub or extension 
cable may not work and is not 
supported. Connect the USB cable 
directly to the computer.

Connection to the computer (continued)
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eBook
Symptom Cause or corrective action

An eBook cannot be 
read.

 You may not have signed up for the 
service or authorized which is 
necessary for reading eBooks. 
Authorize your computer and the 
Reader.

 You may have tried to read the 
content owned by another user. 
The content owned by another 
user cannot be read.

 The authorization data may be 
damaged caused by a shutdown 
while reading an eBook. 
Deauthorize your computer and 
the Reader, then authorize again.

 Installation and authorization of 
Adobe Digital Editions version 1.5 
or later on your computer is 
required for reading Adobe DRM 
protected content. For details 
about usage or support of Adobe 
Digital Editions, refer to the Adobe 
information page at the following 
web site:  
http://www.adobe.com/go/
digitaleditions_us
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Memory card
Symptom Cause or corrective action

Content on a 
memory card cannot 
be read/played/
viewed.

 Check that the memory card is 
inserted in the Media slot in the 
correct direction.

 Check to see that you are using a 
memory card that is supported by 
the Reader.

 Clean the terminal area of memory 
card gently with a soft cloth if it is 
dirty.

 Check whether the books/pictures/
tracks are transferred by eBook 
Library or Adobe Digital Editions.

Content cannot be 
transferred to a 
memory card.

 Unlock the erasure prevention switch 
if it is locked.

 There is not enough free space on 
the memory card. Delete 
unnecessary data.

A memory card 
cannot be 
recognized.

 A memory card which is not 
formatted in FAT 16 or FAT �2 may 
not be able to be recognized on 
eBook Library.

	 When formatting a memory card, 
format it using the formatter supplied 
with the memory card, or using 
Windows Explorer to format at 
memory card manufacture’s default 
settings.

Content on a 
memory card cannot 
be deleted.

 Unlock the erasure prevention switch 
if it is locked.

 Uncheck the read-only attribute of 
content.
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Restoring default settings

All default settings of the Reader can be restored.

Notes

The following occurs when you restore the default settings.
	The screen orientation setting will be vertical.
	The device lock will be set to “Off” and the password will be set to 

“0000.”
	The “Slideshow” setting will be set to “Off” and its duration time set 

to 5 seconds.
	The mute will be off and the volume will be set to the default level 

(level �).
	The gesture direction will be set to left-to-right (to display the next 

page, drag on the page from left to right).
	The “Power Management” setting will be set to “On.”

 In the Home menu, tap  (Settings).
The Settings menu appears.

 Tap “Restore Defaults.”
The Restore Defaults screen appears. 
If “Device Lock” (  page 112) is set to “On,” the screen 
asking for the password appears. Input the password, 
then tap “OK.”

 Tap “Yes” to restore default settings.
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Uninstalling eBook Library
To uninstall the supplied software from your computer, follow 
the procedures below.

Note

	Before uninstalling, de-authorize your computer if it is authorized. 
For details on de-authorization, refer to the eBook Library Help.

 Click “Start” – “Control Panel.”

 Double-click “Add/Remove Programs.” *1

 Click “eBook Library by Sony” in the “Currently 
Installed Programs” list, then click “Remove.” *2

Follow the on-screen instructions and restart your 
computer. The uninstallation is complete when the 
computer has restarted.

Uninstalling PRS-700 User’s Guide
1 Click “Start”-“Control Panel.”

2 Double-click “Add/Remove Programs.” *1

3 Click “PRS-700 User’s Guide” in the “Currently Installed 
Programs” list, then click “Remove.” *2

Follow the on-screen instructions and restart your computer. The 
uninstallation is complete when the computer has restarted.

*1 “Uninstall a program” or “Programs and Features” in the case of 
Windows Vista.

*2 “Uninstall” in the case of Windows Vista.
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Other Information

Updating the Reader Device 
Software
By updating the Reader device software, you can ensure 
your Reader has the latest features. The latest software 
updates can be performed from the update menu on eBook 
Library from “Help” – “Check for Updates.”
For details on updates, refer to the eBook Library Help or 
the following website.
For customers in the USA:
http://www.sony.com/readersupport
For customers in Canada:
http://www.sony.ca/ElectronicsSupport/
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About Books Pre-installed on 
Reader
The Reader is pre-installed with sample data so that you 
can try it out right away. The pre-installed sample data is for 
the purpose of trial reading, viewing and listening.

About sample data
The Reader is pre-installed with sample data.
If you delete the sample data, you cannot restore it, nor will 
any replacement data be supplied by Sony.
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Notes on Reader Disposal
The built-in rechargeable battery of the Reader is recyclable. 
Do not remove the battery yourself, consult Sony Support.  
(  page 115)
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Precautions

Owner’s Record
The model and serial numbers are located on the back of 
the unit. Record the serial number in the space provided 
below. Refer to these numbers whenever you call upon your 
Sony dealer regarding this product.
Model No. __________________________
Serial No. __________________________
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The following FCC statement applies only to the version of 
this model manufactured for sale in the USA. 
Other versions may not comply with FCC technical 
regulations.

INFORMATION:
NOTE: This equipment has been tested and found to comply 
with the limits for a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful 
interference to radio communications.
However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of 
the following measures:
– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and 

receiver.
– Connect the equipment into an outlet on a circuit different 

from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician 

for help.
You are cautioned that any changes or modifications not 
expressly approved in this manual could void your authority 
to operate this equipment.
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If you have any questions about this product:
Visit:
www.sony.com/readersupport
Contact:
Sony Portable Reader System Support Center at 1-(866)-
962-7669
Write:
Sony Customer Information Services Center
12451 Gateway Blvd., Fort Myers, FL ��91�

Declaration of Conformity

Trade Name: SONY
Model No.: PRS-700
Responsible Party: Sony Electronics Inc.
Address: 165�0 Via Esprillo, 

San Diego, CA 92127 
U.S.A.

Telephone Number: 858-942-22�0

This device complies with Part 15 of the 
FCC Rules. Operation is subject to the 
following two conditions: (1) this device 
may not cause harmful interference, and 
(2) this device must accept any 
interference received, including 
interference that may cause undesired 
operation.
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For Customers in the USA and Canada
RECYCLING LITHIUM-ION BATTERIES
Lithium-ion batteries are recyclable.
You can help preserve our environment by returning 
your used rechargeable batteries to the collection 
and recycling location nearest you.

For more information regarding recycling of rechargeable 
batteries, call toll free 1-800-822-88�7, or visit http://www.
rbrc.org/.

Caution: Do not handle damaged or leaking Lithium-ion 
batteries.

On safety

	Do not insert any foreign objects in the DC IN jack of the 
Reader.

	Be sure not to short-circuit the terminals of the Reader 
with metallic objects.

On installation

	Never subject the Reader to extremes of light, 
temperature, moisture or vibration.

	Never wrap the Reader in anything when it is being used 
with the AC power adaptor. Heat build-up in the Reader 
may cause malfunction or damage.
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On heat build-up

Heat may build up in the Reader while charging, or if it is 
used for an extended period of time.

On the headphones

Road safety
Do not use headphones while driving, cycling, or operating 
any motorized vehicle. It may create a traffic hazard and is 
illegal in many areas. It can also be potentially dangerous to 
play at a high volume while walking, especially at pedestrian 
crossings. You should exercise extreme caution or 
discontinue use in potentially hazardous situations.

Preventing hearing damage
Avoid using the headphones at a high volume. Hearing 
experts advise against continuous, loud and extended play. 
If you experience a ringing in your ears, reduce the volume 
or discontinue use.

Caring for others
Keep the volume at a moderate level. This will allow you to 
hear outside sounds and to be considerate to the people 
around you.

Warning
If lightning occurs while you are using the Reader, take off 
the headphones immediately.
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Note on use

	Replacement or repair of a broken or scratched touch 
panel is not covered by the warranty. 

	Do not drop or submit the Reader to excessive shock.
	Do not poke people using the supplied stylus.
	Do not treat or use the supplied stylus roughly by bending 

it, or scratching the touch panel with it.
	Use the supplied stylus only for the operations on the 

touch panel.
	Do not use the damaged or deformed stylus.
	Depending on the types of the text and characters, the 

text shown on the Reader may not be displayed properly 
on device. This is due to: 
– The capacity of the Reader.
– The Reader is not functioning normally. 
– Content information is written in the language or the character 

that is not supported by the Reader.
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Notes on memory cards

About “Memory Stick Duo” Memory Card
“Memory Stick Duo” Memory Card is a high-capacity 
compact IC recording media. Not only can you exchange 
data among “Memory Stick Duo” Memory Card compatible 
devices, but also you can use as an external removable data 
storage.

About SD Memory Card
SD Memory Card complies with compact memory card 
standard and is commonly used as a storage media for 
digital still cameras.

For details on memory cards supported by the Reader, refer 
to “Inserting a Memory Card” on  page 28.

Notes on handling memory cards
	When using miniSD Card on the Reader, an adaptor (sold 

separately) is required.
	The Reader does not comply with the following:

− MagicGate standard.
− copyright protection of SD Memory Cards.
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	You cannot record or delete data stored in a memory card 
when its erasure prevention switch is locked.

 

	Keep a memory card in its case when you carry or store 
it.

	Do not touch the connector of a memory card with bear 
hands or metallic objects.

	Do not bend, drop, or subject a memory card to excessive 
shock.

	Do not disassemble or modify a memory card.
	Do not allow a memory card to get wet.
	Avoid the following to prevent data damage. Sony does 

not provide any guarantee for damaged data.
− Remove a memory card or turn off the Reader while reading or 

writing data.
− Operate the Reader in the location where static charge or 

electrical noise is present.

	Do not use a label other than the dedicated one in the 
label area.

	Do not use or store the Reader in a location subject:
− extreme high temperature, such as in a sun-heated car.
− direct sunlight.
− high humidity or places with corrosive substances.
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On software

	Copyright laws prohibit reproducing the software or the 
manual accompanying it in whole or in part, or renting the 
software without the permission of the copyright holder.

	In no event will SONY be liable for any financial damage, 
or loss of profits, including claims made by third parties, 
arising out of the use of the software supplied with this 
Reader.

	In the event a problem occurring with this software as a 
result of defective manufacturing, SONY will replace it. 
However, SONY bears no other responsibility.

	The software provided with this Reader cannot be used 
with equipment other than that which is so designated.

	Please note that, due to continued efforts to improve 
quality, software specifications may be changed without 
notice.

	Operation of this Reader with software other than that 
provided is not covered by the warranty.

	The ability to display the languages on your eBook Library 
will depend on the OS installed on your computer. For 
better results, please ensure that the installed OS is 
compatible with the desired language you want to display.
− We do not guarantee all the languages will be able to be 

displayed properly on your eBook Library.
− User-created characters and some special characters may not 

be displayed.

	Explanations in this manual assume that you are familiar 
with the basic operations of Windows. For details on the 
use of your computer and operating system, please refer 
to the respective manuals.
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On Cleaning
	Clean the case of the Reader with a soft cloth, such as a 

cleaning cloth for eyeglasses.
	If the case of the Reader becomes very dirty, clean it with 

a soft cloth slightly moistened with water or a mild 
detergent solution.

	Do not use any type of abrasive pad, scouring powder, or 
solvent, such as alcohol or benzene, as it may mar the 
finish of the case.

	Be careful not to let water get into the Reader from the 
opening near the connector.

	Clean the headphone plug periodically.
	Tapping or dragging on the touch panel using a dirty 

stylus may damage the surface. Wipe the stylus with a dry 
cloth when it gets dirty.

If you have any questions or problems concerning the 
Reader, consult your nearest Sony dealer.

Notes

	Recorded content is limited to private use only. Use of the 
content beyond this limit requires permission of the copyright 
holders.

	Sony is not responsible for incomplete recording/downloading or 
damaged data due to problems of the Reader or computer.
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On Copyrights

The contents of each book pre-installed on this product 
are copyrighted works, edited with the cooperation of the 
publisher and editor hereto mentioned.
Copyright laws prohibit copying the data of this product or 
the contents of this manual (illustrations, related 
documents, etc.) in whole or in part without the permission 
of the copyright holder. Additionally, use of the data of this 
product or the contents of this manual is not allowed 
without Sony’s permission except for personal use.

	SONY and the SONY logo are registered trademarks of Sony 
Corporation.

	BBeB, BBeB Book, and their logos are trademarks of Sony 
Corporation.

	“Memory Stick,” “Memory Stick Duo,” “Memory Stick PRO Duo,” 
and their logos are trademarks of Sony Corporation.

	Bitstream is a registered trademark, and Dutch, Font Fusion, 
and Swiss are trademarks, of Bitstream Inc.

	Microsoft, Windows, Windows Vista and Windows Media are 
trademarks or registered trademarks of Microsoft Corporation 
in the United States and / or other countries.

	Adobe, the Adobe logo, Reader and PDF are either registered 
trademarks or trademarks of Adobe Systems Incorporated in 
the United States and/or other countries.

	MPEG Layer-� audio coding technology and patents licensed 
from Fraunhofer IIS and Thomson.
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	This product includes software developed by the OpenSSL 
Project for use in the OpenSSL Toolkit.   
(<http://www.openssl.org/>)  Copyright © 1998-2006 The 
OpenSSL Project. All rights reserved. This product includes 
cryptographic software written by Eric Young (eay@cryptsoft.
com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com). For details on OpenSSL License, refer to 
“openssl.txt” on the CD-ROM.

All other system names and product names appearing in this 
document are generally the registered trademarks or trademarks 
of their respective manufacturers. Further, the trademark TM and 
registered trademark ® symbols are not indicated throughout this 
document.

Program ©2008 Sony Corporation
Documentation ©2008 Sony Corporation

About GNU GENERAL PUBLIC LICENSE

Dear customers
Thank you for purchasing this product.
Included with this product is the following software which 
applies to GPL/LGPL. You may obtain, modify and 
redistribute the source codes of the software.

busybox
dosfstools
FreeType
gcc
glibc
intiscripts
Kernel
kernel header
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libgcc
libstdc++
make
MAKEDEV
mtd
procps
uClibc
udev
USB driver
util-linux
zlib

These source codes are available on the web site.
Access the following web site to download.
http://www.sony.net/Products/Linux/
Note that Sony accepts no inquiries concerning the contents 
of these source codes.

For details on GNU GENERAL PUBLIC LICENSE, refer to 
“GPL (English).rtf,” “GPL (French).rtf,” “LGPL (English).rtf” 
and “LGPL (French).rtf” on the CD-ROM.
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Specifications

Model name
PRS-700

Power source
Built-in rechargeable battery: DC 3.7 V
AC power adaptor: DC 5.2 V
USB

Battery life (continuous playback)
Maximum Battery: Approx. 7,500 continuous page turns when reading only *
* Measured using a fully charged battery and counting consecutive 

BBeB format page-turns at approx 1 page per sec. Actual battery life 
may vary based on usage patterns and specific device.

Battery life (built-in light)
Bright: Approx. 4 hours
Standard: Approx 8 hours  

(When the battery is fully charged and no operations are performed)

User available capacity
Approx. 420MB
Available memory capacity of the Reader may vary.

Operating temperature
41 to 95 °F (5 to 35 °C)

Dimensions (w/h/d)
Approx. 5 1/8 × 6 7/8 × 13/32 inches (127.6 × 174.3 × 9.7 mm)
(without soft cover)

Mass
Approx. 10 oz (280 g) (without soft cover)

Optional Accessories
AC Adaptor for Reader: AC-S5220E

Design and specifications are subject to change without 
notice.
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Book types .................................52

C
Charging ....................................21 

See also “Quick Start Guide”
Collection ...................................58
Comment ...................................85
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DC IN jack .................................10
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Help........................................�
Install...See “Quick Start Guide”
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H
Headphone jack .........................11
Highlight .....................................82
Hole for hand strap ....................10
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“Memory Stick Duo” slot .........9
SD Memory Card slot ............9

Memory Card .............................28
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N
Notes ...................................78, 88
Now Playing .....5�, 90, 97, 98, 104

O
On-screen keyboard ..................71
OPTION button ............................8
Option menu ..........5�, 90, 98, 104
Orientation .................................69

P
Page jump panel ........................60
Picture .....................................100
Power Management ...................24
POWER switch ......................9, 2�

R
Reading Books ..........................47
Reset .......................................114

RESET button ..............11, 114
RTF file ................................�6, 52
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S
SD Memory Card ...............28, 1�5
SEARCH button ...........................9
Search menu .............................71
Setting .....................................106

About..................................111
Date and Time....................109
Page Turn Gesture .............110
Power Management ...........109
Restore Defaults ................111
Slideshow ...........................110

Slideshow ................................105
Sort ..................5�, 90, 9�, 98, 104
Stylus .....................................9, 1�
Synchronizing ............................45

T
Table of Contents .......................56
Tool bar ..........................78, 80, 82
Touch Panel .................................9
Transfer ......................................�8
Troubleshooting .......................114

U
Updating ..................................126
USB ...........................................�9

USB connector ...............11, �9

V
Vertical .......................................69
View .............................5�, 98, 104
VOL –/+ button ....................11, 97

Z
Zoom in/out ........................64, 10�
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A propos des manuels
Le Guide de démarrage et le présent Guide de l’utilisateur 
sont livrés avec le Reader. Après avoir installé votre logiciel 
eBook Library à l’aide du CD-ROM fourni, vous pouvez 
également vous reporter à l’Aide eBook Library.

Navigation dans le Guide de l’utilisateur

Pour naviguer dans le présent Guide sur votre 
ordinateur
Cliquez sur le menu Démarrer en bas à gauche du Bureau, 
puis sélectionnez « Tous les programmes » – « Reader » – 
« PRS-700 User’s Guide » pour lancer Adobe Reader et 
ouvrir le Guide de l’utilisateur.
Pour plus d’informations sur l’utilisation du logiciel Adobe 
Reader, reportez-vous à l’Aide Adobe Reader.

Conseil
	Pour visualiser le Guide de l’utilisateur, Adobe Reader ou Acrobat 

doit être installé. Vous pouvez télécharger gratuitement Adobe 
Reader directement depuis le site Adobe (www.adobe.com).

FR

www.adobe.com
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Utilisation de l’Aide eBook Library

Pour plus d’informations sur l’utilisation du logiciel eBook 
Library, comme par exemple, l’importation de livres sur votre 
ordinateur ou bien le transfert de livres vers le Reader, 
reportez-vous à l’Aide eBook Library.
Suivez les étapes ci-dessous pour lancer eBook Library et 
parcourir l’Aide.

 Cliquez sur le menu Démarrer sur votre ordinateur, 
puis sélectionnez « Tous les programmes » – 
« Reader » – « eBook Library ».

 Cliquez sur « Help » – « eBook Library Help » dans 
la barre de menus.
L’Aide apparaît.
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Présentation

Utilisation du Reader
Lisez tout d’abord le Guide de démarrage avant d’utiliser 
votre Reader. Avant tout utilisation du Reader, vous devez 
charger la batterie et installer le logiciel dédié « eBook 
Library » sur votre ordinateur.
Une fois ces opérations effectuées, vous pouvez transférer 
le contenu de votre ordinateur vers le Reader afin de 
l’emporter partout où vous le souhaitez.

*1

*2

eBooks 
téléchargés

*1 Librairie en ligne eBook
*� Fichiers Livres/Fichiers audio/Images dont vous disposez déjà

Transfert

Chargez la batterie de votre Reader, puis installez les 
logiciels eBook Library et Adobe Digital Editions.

Téléchargement de eBooks 
depuis « The eBook Store 
from Sony ».

Transfert de contenu depuis 
votre ordinateur vers le 
Reader à l’aide de eBook 
Library.

Profitez de ce contenu sur 
votre Reader.

Lecture/Ecoute/
Visualisation

Importation

Mise en service
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Composants et commandes

Avant
 Touche OPTION

Affiche le menu d’options. (  pages 5�, 59, 90, 9�, 98 et 
104)  
Vous pouvez accéder à différentes fonctions, telles que 
la création de remarques ou le saut de page, à partir du 
menu d’options.

 Touche  (taille)
Affiche le menu Taille. (  pages 64 et 10�)
Vous pouvez régler la taille du texte et effectuer un zoom 
avant/arrière sur la page ou l’image à partir du menu Taille.
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 Touche SEARCH
Affiche le menu Recherche. (  page 71)  
Le menu Recherche s’affiche à l’aide du clavier à l’écran. 
Vous pouvez rechercher des livres ou des mots clés en 
saisissant un mot à l’aide du clavier à l’écran.

 Touche HOME
Affiche le menu d’accueil. (  page 16)

 Ecran tactile
L’écran tactile vous permet d’accéder facilement aux 
différentes fonctions à réaliser sur le Reader (  page 18).

 Stylet
Le stylet permet de réaliser des opérations délicates sur 
l’écran tactile, telles que le surlignage (  pages 1�, 18 et 
114).

 Fente pour carte mémoire SD
Sert à insérer une carte mémoire SD (en option).  
(  page �8)

 Fente pour « Memory Stick Duo »
Sert à insérer une carte mémoire « Memory Stick Duo » 
(en option). (  page �8)

 Commutateur POWER
Permet d’allumer et d’éteindre le Reader. (  page ��) 
Pour arrêter le Reader, faites glisser le commutateur et 
maintenez-le pendant plus de � secondes (  page �4).

 Témoin
Un témoin rouge s’allume pendant le chargement de la 
batterie et s’éteint une fois le chargement terminé.  
(  page �1)
Le témoin clignote en orange lorsque le Reader accède 
à votre ordinateur via un raccordement USB.
Il clignote également en orange lors de la mise sous 
tension ou hors tension du Reader.
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	Orifices	de	fixation	de	l’étui	souple
A l’achat, l’étui souple est fixé. (  page 12)

Se déplie lors de l’utilisation

Remarque

	N’exposez pas votre Reader à des températures élevées pour 
éviter tout risque de détérioration de l’étui souple.

	Touches	<	 	/	 	>	(utilisées	pour	tourner	les	pages)
Permettent de tourner les pages. Vous pouvez 
également tourner les pages à l’aide de l’écran tactile.

	Touche	 	(arrière)	
Permet de revenir au menu précédent.

	Orifice	de	fixation	de	la	dragonne
Sert à fixer la dragonne (en option).

	Commutateur	 	(éclairage)
Permet d’éteindre/d’allumer l’éclairage intégré.  
(  page 32)

	Prise	DC	IN
Sert au raccordement de l’adaptateur secteur pour le  
Reader (AC-S5220E) (en option).

	 Conseil
	Vous pouvez charger le Reader en le raccordant à un 

ordinateur à l’aide du câble USB fourni.
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 Connecteur USB
Sert à raccorder le câble USB (fourni). (  page �9)

 Prise  (écouteurs)
Sert à raccorder les écouteurs (en option). (  page 95)

 Touche VOL –/+
Permet de régler le volume. (  page 97)
Pour activer la fonction de sourdine, appuyez sur les 
deux côtés de la touche VOL –/+ et maintenez-la 
enfoncée. Pour désactiver la fonction de sourdine, 
appuyez de nouveau sur la touche VOL –/+.

Arrière

 Touche RESET
Permet de réinitialiser le Reader lorsqu’aucune opération 
n’est possible. (  page 114)
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A propos du numéro de série
Le numéro de série fourni avec le Reader est requis lors de 
l’enregistrement client. Ce numéro est inscrit sur l’étiquette 
collée au dos de votre Reader. Ne retirez jamais cette étiquette.

Pour retirer/fixer l’étui souple

Retrait de l’étui souple
 Tirez la languette de l’étui souple vers A.
 Retirez le Reader dans le sens de B.

Fixation de l’étui souple
 Insérez la languette C de l’étui souple dans l’orifice D 

du Reader.
 Tirez la languette de l’étui souple vers A.
 Insérez le Reader dans le sens de E pour le fixer sur 

l’étui souple.
 Vérifiez si les languettes de l’étui souple sont bien 

insérées dans les orifices du Reader.

Remarque

	Notez que la languette de l’étui souple peut se déformer si vous 
tirez trop fort dessus.
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Retrait du stylet fourni
Le stylet fourni est rangé sur le côté droit du Reader. Tirez-
le vers le haut lorsque vous souhaitez l’utiliser.

Remarque

	Lorsque que vous replacez le stylet à l’endroit prévu à cet effet, 
veillez à l’insérer complètement.
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Opérations de base

Fonctionnement des menus
Vous pouvez faire fonctionner le Reader à l’aide de l’écran 
tactile et des touches du Reader. 
A partir du menu d’accueil, vous pouvez lire et/ou visualiser 
le contenu et configurer les réglages.
Vous pouvez également sélectionner les options et/ou les 
contenus affichés à l’écran en tapant sur l’écran tactile. Pour 
plus d’informations sur l’utilisation de l’écran tactile, 
consultez le « Guide d’utilisation de l’écran tactile ».  
(  page 18)

Fonctionnement des menus  
Exemple : lecture d’un livre

 Dans le menu d’accueil, tapez sur 
 (Books).

La liste de livres apparaît. Par défaut, 
les livres sont triés par titre dans la 
liste.
Pour plus d’informations sur le menu 
d’accueil, consultez la section « A 
propos du menu d’accueil ».  
(  page 16)
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 Tapez sur le livre de votre choix 
dans la liste de livres.
La page du livre apparaît.
	Pour plus d’informations sur la 

liste de livres, consultez la 
section « Sélection d’un livre 
dans la liste de livres ».  
(  page 47)

 Lisez le livre.
	Pour plus d’informations sur la 

page du livre, consultez la 
section « Lecture de livres ».  
(  page 49)

Pour revenir au menu d’accueil
Appuyez sur la touche HOME.

Pour revenir à l’écran précédent
Appuyez sur la touche  (arrière).
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A propos du menu d’accueil

Le menu d’accueil est le point de départ pour lire et/ou 
visualiser le contenu, et configurer les réglages. Vous 
pouvez sélectionner les options de menu en tapant dessus. 
Il est toujours possible d’afficher le menu d’accueil en 
appuyant sur la touche HOME.

Option de menu Description

 (Continue Reading) Permet de poursuivre la lecture 
depuis la dernière page affichée.

 (Books) Affiche la liste de livres.  
(  page 47)

 (All Notes) Affiche la liste de tous les signets, 
les surlignages et les 
commentaires créés dans les 
livres dans le Reader. (  page 89) 
Pour plus d’informations sur les 
signets et le surlignage, consultez 
la section « Création de 
remarques sur une page de 
livre ». (  page 78)
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Option de menu Description

 (Collections) Affiche la liste des collections 
créées par eBook Library.  
(  page 58)

 (Audio) Affiche la liste des fichiers audio.  
(  page 95)

 (Pictures) Affiche la liste des images.  
(  page 100)

 (Settings) Permet d’afficher le menu 
Settings. (  page 106)

Autres fonctions disponibles dans le menu 
d’accueil
Les fonctions suivantes sont disponibles dans le menu 
d’accueil.
	Le menu d’options s’affiche en appuyant sur la touche 

OPTION. Vous pouvez afficher l’écran de lecture des 
fichiers audio (  page 97) ou modifier l’orientation de 
l’écran (  page 69) à partir du menu d’options.

	Le menu Recherche apparaît en appuyant sur la touche 
SEARCH. Vous pouvez rechercher un livre par titre ou 
nom d’auteur à partir du menu Recherche. (  page 71)
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Guide d’utilisation de l’écran 
tactile
Vous pouvez réaliser diverses opérations à l’aide du stylet 
fourni ou de votre doigt via l’écran tactile.

Remarque

	Lorsque vous utilisez le stylet fourni, veillez à utiliser la pointe de 
ce dernier afin de taper ou effectuer un glisser-déposer sur l’écran 
tactile. N’utilisez pas de stylo bille, de crayon ou tout autre objet 
pointu.

Taper
Vous pouvez sélectionner une option dans un menu ou une 
liste en tapant sur l’écran tactile.
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Taper deux fois
En tapant deux fois sur l’écran tactile, vous pouvez créer 
des signets (  page 79), sélectionner un mot dans une page 
de livre pour effectuer une recherche dans le menu 
Recherche (  page 71), etc.

Glisser-déposer
En effectuant un glisser-déposer sur l’écran tactile, vous 
pouvez tourner les pages (  page 50), glisser-déposer une 
page agrandie en mode Zoom (  page 68) ou sélectionner 
un mot à surligner (  page 8�).
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Glisser et maintenir
En maintenant le stylet ou le doigt sur l’écran tactile après 
un glisser-déposer, vous pouvez tourner les pages plusieurs 
fois. (  page 50)
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Chargement du Reader

A propos du chargement de la batterie

Vous devez charger le Reader avant sa première utilisation 
ou si l’autonomie de la batterie est faible. Mettez le Reader 
sous tension, puis chargez-le de l’une des deux façons 
suivantes.
	Raccordez l’appareil à un ordinateur via le câble USB (voir le 

Guide de démarrage et la  page 39). 
(Temps de charge : environ 4 heures*)

	Raccordez l’appareil à une prise secteur via l’adaptateur secteur 
pour le Reader (AC-S5220E) (en option). 
(Temps de charge : environ 2,5 heures*)
* Temps approximatif pour que la batterie soit complètement chargée.

Remarques

	Lorsque vous raccordez le Reader à votre ordinateur, l’indication 
 (connexion USB) s’affiche sur l’écran du Reader. Si la batterie 

est complètement épuisée, l’indication  peut mettre environ  
5 minutes à s’afficher. En attendant, vous ne pourrez pas mettre le 
Reader sous tension à l’aide du commutateur POWER. Dans ce 
cas, attendez que  s’affiche. 
Le témoin de charge s’allume en rouge si  ne s’affiche pas 
pendant la charge du Reader.

	Si le niveau d’autonomie de l’ordinateur portable auquel vous êtes 
raccordé est faible, le chargement via une connexion USB est 
impossible.

	Si vous raccordez le Reader à un ordinateur portable qui n’est pas 
branché à une prise secteur, vous risquez d’épuiser sa batterie. Ne 
laissez jamais votre Reader raccordé à un ordinateur portable qui n’est 
pas branché sur une prise secteur pendant une période prolongée.

	Le raccordement du Reader via un concentrateur ou une rallonge 
USB n’est pas pris en charge et risque de ne pas fonctionner. 
Raccordez le câble USB directement à l’ordinateur.
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Vous pouvez surveiller le niveau d’autonomie grâce au 
témoin situé dans le coin inférieur gauche de l’écran. 
Chargez de préférence la batterie lorsque le niveau 
d’autonomie est faible (le niveau d’autonomie est faible 
lorsqu’il ne reste plus qu’un seul segment noir affiché).

Remarque

	Si le niveau d’autonomie est faible, l’avertissement suivant 
apparaît. Mettez la batterie en charge.

 

 Si vous continuez à utiliser l’appareil sans recharger la batterie, 
l’avertissement suivant apparaît, puis le Reader s’éteint 
automatiquement.

 Chargez le Reader avant de l’allumer de nouveau.
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Mise sous tension du Reader
Faites glisser le commutateur POWER dans la direction de 
 pour mettre sous tension le Reader.

Faites glisser le 
commutateur 
POWER.

Le Reader s’allume. Le témoin s’allume en orange lorsque 
le Reader est sous tension.
	Lorsque vous mettez le Reader sous tension pour la 

première fois après son achat, l’écran de réglage 
apparaît. Le réglage est nécessaire pour sélectionner 
précisément les éléments sur l’écran tactile. Pour plus 
d’informations sur le réglage, consultez la section 
« Réglage de l’écran tactile » (  page �6).

	L’allumage du Reader et de l’écran de démarrage peut 
prendre un certain temps lorsque l’appareil est utilisé 
pour la première fois après réinitialisation (  page 114) ou 
arrêt (  page �5), ou lorsque la batterie est épuisée.
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Pour éteindre le Reader
Faites de nouveau glisser le commutateur POWER dans le 
sens de .
Le Reader s’éteint. Une fois hors tension, le Reader passe 
en mode de veille.
Si vous faites glisser le commutateur POWER et le maintenez 
enfoncé pendant plus de � secondes, le Reader est arrêté.

Conseil
	Lorsque le réglage « Power Management » est réglé sur « On »  

(  page 109), le Reader passe en mode de veille après 60 minutes 
d’inactivité, même si vous le mettez hors tension manuellement.

A propos de l’économie d’énergie du Reader

Le Reader dispose d’une fonction d’économie d’énergie 
pour éviter de décharger inutilement la batterie. Cette 
fonction est activée à l’achat. L’économie d’énergie 
fonctionne comme suit :
	Après 60 minutes d’inactivité, le Reader passe 

automatiquement en mode de veille et réduit ainsi la 
consommation d’énergie de la batterie.

	Le Reader se ferme automatiquement après 5 jours 
d’inactivité, ce qui interrompt la consommation d’énergie 
de la batterie.

 Si le niveau de la batterie est faible, le Reader se ferme après  
60 minutes d’inactivité.
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Conseil
	Vous pouvez activer/désactiver le mode économie d’énergie à 

partir de l’option « Power Management » dans le menu Settings.  
(  page 109)

Remarque

	Dans les cas suivants, le Reader ne se met pas en mode de veille 
après 60 minutes d’inactivité même si la fonction « Power 
Management » est réglée sur « On ».
– lorsque l’appareil est raccordé à l’ordinateur à l’aide du câble 

USB fourni
– lorsqu’il est raccordé à l’adaptateur secteur du Reader (AC-

S5220E) (en option) pour être rechargé
– lors de la lecture de fichiers audio

Pour arrêter le Reader manuellement
Vous pouvez arrêter le Reader manuellement de l’une des 
deux façons suivantes.
	Faites glisser le commutateur POWER et maintenez-le 

enfoncé pendant plus de 3 secondes.
	Sélectionnez « Device Shutdown » dans le menu 

Advanced Settings. (  page 113)
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Réglage de l’écran tactile

Lorsque vous mettez le Reader sous tension pour la 
première fois après son achat, l’écran de réglage apparaît. 
Le réglage est nécessaire pour sélectionner précisément les 
éléments sur l’écran tactile. 

Conseil
	Si vous ne parvenez pas à sélectionner un élément même en 

tapant dessus, réglez l’écran tactile à partir de l’option « Touch 
Panel » dans le menu Advanced Settings. (  page 11�)

Remarque

	Veillez à utiliser le stylet fourni pour effectuer le réglage.

 Mettez le Reader sous tension.
L’écran de réglage apparaît. Un × (cible) apparaît dans 
le coin supérieur gauche de l’écran.
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 Tapez sur la cible à l’aide du stylet fourni.
La cible se déplace vers le coin inférieur droit. Chaque 
fois que vous tapez sur la cible, sa position change. 
Continuez de taper sur la cible jusqu’à ce que le 
processus de réglage soit terminé.

Si vous manquez le centre de la cible en tapant
Si une erreur est détectée lors des étapes de réglage, 
un message s’affiche vous invitant à recommencer le 
processus de réglage.
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Insertion d’une carte mémoire
Vous pouvez insérer les cartes mémoire suivantes dans les 
fentes pour carte mémoire du Reader.

Remarque

	Le Reader dispose de fentes séparées pour la carte mémoire 
« Memory Stick Duo » et la carte mémoire SD. Assurez-vous 
d’insérer la carte mémoire dans la fente appropriée. L’insertion de 
la carte mémoire dans la mauvaise fente peut endommager la 
fente ainsi que la carte mémoire.

Carte mémoire  
« Memory Stick Duo »*1 

« Memory Stick Duo » 
« Memory Stick PRO Duo »

Carte mémoire SD*2 Carte mémoire SD
Carte mémoire SDHC
Carte miniSD*�

*1 Le Reader n’est pas compatible avec la norme MagicGate. De plus, 
les données qui requièrent la fonction de protection des droits 
d’auteur ne peuvent pas être copiées ou lues sur le Reader.

*� Le Reader n’est pas compatible avec la protection des droits d’auteur 
des cartes mémoire SD.

*� Un adaptateur pour carte miniSD (vendu séparément) est requis.

Remarques

	Avec la carte mémoire « Memory Stick Duo » de Sony d’une 
capacité maximale de 16 Go, un contrôle de compatibilité est 
effectué. Cependant, la compatibilité avec tous les « Memory Stick 
Duo » n’est en aucun cas garantie.

	Avec les cartes mémoire SD d’une capacité maximale de 16 Go, un 
contrôle de compatibilité est effectué. Cependant, la compatibilité 
avec toutes les cartes mémoire SD n’est en aucun cas garantie.

	Lorsque vous insérez la carte mémoire dans le Reader, la 
reconnaissance des fichiers de contenu peut prendre quelques 
instants, surtout si la taille des fichiers de contenu stockés sur 
cette carte mémoire est importante.
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Insertion d’une carte mémoire dans le Reader

 Retirez les protections de la fente pour « Memory 
Stick Duo » et carte mémoire SD.
Ces protections pour carte mémoire sont insérées dans 
la fente du « Memory Stick Duo » et celle de la carte 
mémoire SD à l’achat. Lorsque vous n’utilisez pas la 
carte mémoire, insérez la protection dans la fente.

Remarque

	Si la protection n’est pas insérée dans la fente, des corps 
étrangers risquent d’y pénétrer, ce qui peut entraîner des 
problèmes de fonctionnement ou des dommages.
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 Insérez une carte mémoire dans le sens de la 
marque  avec l’étiquette tournée vers le haut 
jusqu’au déclic de mise en place.
Remarque

	Le Reader dispose de fentes séparées pour la carte mémoire 
« Memory Stick Duo » et la carte mémoire SD. Assurez-vous 
d’insérer la carte mémoire dans la fente appropriée. L’insertion 
de la carte mémoire dans la mauvaise fente peut 
endommager la fente ainsi que la carte mémoire.

  
Marque

« Memory 
Stick Duo »

Carte 
mémoire SD

  
Marque

Remarques

	Assurez-vous d’insérer la carte mémoire dans le bon sens. Si vous 
forcez pour insérer la carte, cela peut endommager la fente.

	N’insérez jamais de carte mémoire incompatible dans l’appareil, 
vous risquez d’entraîner des problèmes de fonctionnement.

	N’utilisez jamais une carte mémoire ou un adaptateur déformé.
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Retrait d’une carte mémoire du Reader

 Appliquez une légère pression sur la carte mémoire.
Un déclic se fait entendre et la carte mémoire est 
éjectée de l’appareil.

« Memory 
Stick Duo »

Carte  
mémoire SD

 Retirez complètement la carte mémoire de la fente 
pour « Memory Stick Duo » ou pour carte mémoire SD.

Remarques

	Ne retirez jamais la carte mémoire ou n’éteignez jamais le Reader 
pendant la lecture ou l’écriture de données, car elles risqueraient 
d’être altérées.

	Pour plus d’informations sur l’utilisation des cartes mémoire, voir  
 page 1�5.
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Commandes d’éclairage intégrées
Vous pouvez éclairer l’écran en faisant glisser le 
commutateur  (éclairage). Utilisez l’éclairage intégré si 
vous lisez des livres sur le Reader dans l’obscurité.

Commutateur  (éclairage)

 Faites glisser le commutateur  (éclairage) vers 
 pour éclairer l’écran.
L’écran s’éclaire alors.
Il existe � niveaux de réglage de luminosité de 
l’éclairage intégré. Chaque fois que vous faites glisser le 
commutateur  (éclairage), le niveau de luminosité 
change selon la séquence suivante :
Eteint : l’éclairage intégré n’est pas activé. A 

chaque fois que le Reader est mis sous 
tension, l’éclairage intégré est toujours 
désactivé.

Standard : l’écran s’allume.
Lumineux : l’éclairage de l’écran est vif.

Suite �� FR



PRS-700.FR.4-1�4-649-11(1)

Remarques

	Veillez à bien éteindre l’éclairage intégré lorsque vous ne l’utilisez 
pas pour éviter de décharger la batterie.

	Lorsque vous raccordez le Reader à l’ordinateur via le câble USB, 
l’éclairage intégré s’éteint automatiquement. L’éclairage intégré 
n’est pas disponible lors de la connexion USB.
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Importation de contenu

Importation de eBooks depuis 
« The eBook Store from Sony »
Vous pouvez télécharger des eBooks depuis la librairie 
eBook en ligne sur votre ordinateur.
Utilisez le logiciel eBook Library dédié pour accéder à 
eBook Store.

Remarques

	Pour télécharger des eBooks, votre ordinateur doit être connecté à 
Internet.

	En outre, vous devez autorisez votre ordinateur à utiliser eBook 
Store pour télécharger des eBooks. 
Vous devez également autoriser le Reader à utiliser eBook Store 
pour transférer et lire les eBooks téléchargés sur le Reader. 
Pour plus d’informations, consultez l’Aide eBook Library.

 Double-cliquez sur l’icône eBook Library ( ) sur le 
bureau Windows.

 Conseil
	Vous pouvez également lancer le logiciel eBook Library en 

cliquant sur le menu Démarrer, puis en sélectionnant « Tous 
les programmes » – « Reader » – « eBook Library ».

 Cliquez sur « eBook Store » dans l’affichage par 
source.
La zone d’affichage passe à l’affichage Librairie et la 
page « The eBook Store from Sony » apparaît.
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 Suivez les instructions sur la page pour acheter des 
eBooks (téléchargement).
Les eBooks téléchargés sont automatiquement 
importés vers la zone « Library » dans l’affichage par 
source.

Library Contenu 
téléchargé

Affichage par source

 Conseil
	Les eBooks achetés sont regroupés sous « Purchased » dans 

la collection.

Conseils
	Vous pouvez lire les eBooks sur votre ordinateur à partir de eBook 

Library. Pour plus d’informations sur les opérations eBook Library, 
consultez l’Aide eBook Library.

	L’affichage par source diffère selon votre type d’ordinateur.
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Importation de contenu depuis 
votre ordinateur
Vous pouvez importer des fichiers de contenu stockés en 
local sur votre ordinateur dans eBook Library.

Vous pouvez importer les types de fichiers suivants.
	Livre 

Fichier PDF*1, fichier EPUB*1 fichier texte, fichier RTF, fichier Word 
(non protégé)*�, BBeB Book

	Audio 
Fichiers audio au format MP� et AAC (non protégés)

– Fichier MP� (extension de fichier .mp�) 
Les spécifications suivantes sont requises pour l’importation de 
fichiers MP�. 
Débit binaire : �� à ��0 kbit/s 
Fréquence d’échantillonnage : ��,05 à 44,1 kHz

– Fichier AAC (extension de fichier .mp4, .m4a, .mov ou .qt) 
Les spécifications suivantes sont requises pour l’importation de 
fichiers AAC. 
Débit binaire : 40 à ��0 kbit/s 
Fréquence d’échantillonnage : �4,0, 44,1, 48,0 kHz

Remarque

	Les fichiers film ne sont pas pris en charge.
	Image 

Fichier Bitmap, JPEG, GIF, PNG

*1 Les fichiers PDF et EPUB protégés par la technologie DRM d’Adobe sont 
uniquement pris en charge si Adobe Digital Editions, version 1.5 ou 
ultérieure, est installé et autorisé sur votre ordinateur. Pour savoir comment 
autoriser le Reader à utiliser des contenus protégés par la technologie 
DRM d’Adobe, reportez-vous à l’aide Adobe Digital Editions à l’adresse :  
http://www.adobe.com/go/digitaleditions_help_en

*� Les fichiers Word sont automatiquement convertis en fichiers RTF pendant 
le transfert, à condition que Microsoft Word soit installé sur votre ordinateur.

Pour plus d’informations sur les fichiers de contenu que 
vous pouvez importer, reportez-vous à l’Aide eBook Library.
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Importation de fichiers de contenu

Vous pouvez sélectionner des fichiers de contenu stockés 
en local sur votre ordinateur et les importer dans la Library.

 Cliquez sur le menu Démarrer, puis sélectionnez 
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.

 Cliquez sur « Import Files » dans le menu « File ».
La boîte de dialogue « Import Files » apparaît.

 Cliquez sur  dans la liste « Look in » pour 
sélectionner le dossier contenant le ou les fichier(s) 
que vous souhaitez importer.
Les fichiers de contenu du dossier sélectionné sont 
répertoriés.

Conseil
	Vous pouvez également double-cliquer sur le dossier (dans la 

liste de dossiers) pour afficher les fichiers de contenu.

 Sélectionnez le fichier de contenu que vous 
souhaitez importer.
Cliquez sur les fichiers en maintenant la touche Ctrl 
enfoncée pour sélectionner plusieurs fichiers à la fois.

 Cliquez sur « Open ».
Le ou les fichier(s) sont importés dans la Library.

Conseil
	Vous pouvez importer simultanément tous les fichiers d’un dossier 

sélectionné dans la Library en cliquant sur « Import Folder » dans 
le menu « File ».
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Transfert de contenu

Transfert de contenu vers le 
Reader raccordé à votre 
ordinateur
Vous pouvez transférer (copier) le contenu de la Library sur 
le Reader.

Remarque

	Si le Reader est verrouillé, il ne sera pas reconnu par votre 
ordinateur et le contenu ne peut pas être transféré. (  page 11�)  
Si le Reader est raccordé à votre ordinateur, débranchez-le et 
déverrouillez-le en saisissant le mot de passe.

Conseils
	Le contenu de livres peut être regroupé dans la Library sous forme 

de collection, qui peut ensuite être transférée sur le Reader. Pour 
plus d’informations sur la création et le transfert de collections, 
reportez-vous à l’Aide eBook Library.

	Vous pouvez synchroniser le contenu du dossier Library de votre 
eBook Library avec le Reader en sélectionnant un dossier (tel que 
« Library » ou des sous-dossiers de « Library »). (  page 45) Le 
Reader peut être mis à jour automatiquement pour correspondre 
au contenu de la Library lors du raccordement à votre ordinateur.

 Cliquez sur le menu Démarrer, puis sélectionnez 
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.
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 Raccordez le Reader à votre ordinateur à l’aide du 
câble USB fourni.

Câble USB  
(fourni)

Vers le connecteur USB

« Reader » apparaît dans l’affichage par source de 
eBook Library.
Un écran apparaît sur le Reader, indiquant que 
l’appareil est raccordé à l’ordinateur.
Remarques

	Si « Reader » n’apparaît pas dans l’affichage par source après 
le raccordement du Reader à l’ordinateur, débranchez le câble 
USB du Reader, puis reconnectez-le après quelques instants.

	Lorsque vous raccordez le Reader à votre ordinateur, l’indication, 
 (connexion USB) s’affiche sur l’écran du Reader. Si la 

batterie est complètement épuisée, l’indication  peut mettre 
environ 5 minutes à s’afficher. En attendant, vous ne pourrez pas 
mettre le Reader sous tension à l’aide du commutateur POWER. 
Dans ce cas, attendez que  s’affiche. 
Le témoin de charge s’allume en rouge si  ne s’affiche pas 
pendant la charge du Reader.

	Lorsque vous raccordez le Reader à votre ordinateur via la 
connexion USB, l’éclairage intégré s’éteint automatiquement. 
L’éclairage intégré n’est pas disponible lors de la connexion USB.
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 Cliquez sur « Library » dans l’affichage par source, 
puis sur  (affichage par liste).
La zone d’affichage passe à l’affichage par liste et tout 
le contenu de la Library est répertorié.

 Conseils
	Lorsque vous cliquez sur « Books », « Audio » ou « Pictures » 

dans l’affichage par source, seul le contenu correspondant 
s’affiche.

	Lorsque vous cliquez sur  (affichage par vignette), le 
contenu s’affiche sous forme de vignettes.

	Vous pouvez créer une collection dans la Library et celle-ci 
peut être transférée vers le Reader. Pour plus d’informations 
sur la création et le transfert de collections, reportez-vous à 
l’Aide eBook Library.

 Sélectionnez le contenu que vous souhaitez 
transférer depuis la liste.
Cliquez sur les fichiers en maintenant la touche Ctrl 
enfoncée pour sélectionner plusieurs fichiers à la fois.

 Faites glisser les fichiers depuis la liste vers 
« Reader » dans l’affichage par source.
Le contenu est transféré vers le Reader.

Reader
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Conseil
	Vous pouvez stocker des données informatiques dans la mémoire 

flash intégrée de votre Reader en les transférant depuis votre 
ordinateur à l’aide de l’Explorateur Windows.

Remarques

	Si la mémoire de votre Reader est insuffisante, le contenu risque 
de ne pas pouvoir être transféré. Vous pouvez augmenter la 
mémoire de votre Reader des deux façons suivantes.
	Retransférez tout contenu inutile vers eBook Library, puis supprimez-

le afin d’augmenter l’espace libre sur le Reader. (  page 4�)
	Supprimez tout livre inutile du Reader. (  page 94)

	Ne supprimez pas le contenu des sous-dossiers ou fichiers du 
dossier « database » à l’aide de l’Explorateur Windows. Procédez 
à la gestion des données à l’aide de eBook Library. Pour plus 
d’informations, reportez-vous à l’Aide eBook Library.

Transfert de contenu via une carte mémoire
Le contenu importé dans eBook Library peut être transféré 
vers une carte mémoire insérée dans le Reader.
Conseils
	Vous pouvez utiliser des « Memory Stick Duo » ou des cartes 

mémoire SD.
	Vous pouvez synchroniser le contenu du dossier Library de votre 

eBook Library avec une carte mémoire sur votre Reader en spécifiant 
un dossier (tel que « Library » ou ses sous-dossiers). (  page 45) 
Pour plus d’informations sur la synchronisation du contenu avec une 
carte mémoire, reportez-vous à l’Aide eBook Library.

 Cliquez sur le menu Démarrer, puis sélectionnez 
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.

 Raccordez le Reader à votre ordinateur à l’aide du 
câble USB fourni. (  page 39)
« Reader » apparaît dans l’affichage par source de eBook Library.
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 Insérez une carte mémoire dans la fente pour carte 
mémoire du Reader. (  page 30)
« Memory Stick/SD Card on Reader » apparaît dans 
l’affichage par source.

 Cliquez sur « Library » dans l’affichage par source, 
puis sur  (affichage par liste).
La zone d’affichage passe à l’affichage par liste et tout 
le contenu de la Library est répertorié.

 Conseils
	Lorsque vous cliquez sur « Books », « Audio » ou « Pictures » 

dans l’affichage par source, seul le contenu correspondant 
s’affiche.

	Lorsque vous cliquez sur  (affichage par vignette), le 
contenu s’affiche sous forme de vignettes.

	Vous pouvez créer une collection dans la Library et celle-ci 
peut être transférée vers une carte mémoire insérée dans le 
Reader. Pour plus d’informations sur la création et le transfert 
de collections, reportez-vous à l’Aide eBook Library.

 Sélectionnez le contenu que vous souhaitez 
transférer depuis la liste.
Cliquez sur les fichiers en maintenant la touche Ctrl 
enfoncée pour sélectionner plusieurs fichiers à la fois.

 Faites glisser le contenu de la liste vers « Memory 
Stick/SD Card on Reader » dans l’affichage par 
source.
Le contenu est transféré sur la carte mémoire insérée 
dans le Reader.
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Conseil
	Vous pouvez stocker des données informatiques dans la carte 

mémoire de votre Reader en les transférant depuis votre ordinateur 
à l’aide de l’Explorateur Windows.

Remarques

	Si la carte mémoire ne contient pas assez d’espace disponible, le 
contenu risque de ne pas pouvoir être transféré. Vous pouvez 
augmenter la mémoire de la carte mémoire des deux façons 
suivantes :
	Retransférez tout contenu inutile vers eBook Library, puis 

supprimez-le afin d’augmenter l’espace libre sur la carte 
mémoire.

	Supprimez tout livre inutile du Reader. (  page 94)
	Ne supprimez pas le contenu des sous-dossiers ou les fichiers du 

dossier « Sony Reader » à l’aide de l’Explorateur Windows. 
Procédez à la gestion des données à l’aide de eBook Library. Pour 
plus d’informations, reportez-vous à l’Aide eBook Library.

Pour transférer du contenu de l’appareil vers 
eBook Library

 Cliquez sur le menu Démarrer, puis sélectionnez 
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.

 Raccordez le Reader à votre ordinateur à l’aide du 
câble USB fourni. (  page 39)
« Reader » apparaît dans l’affichage par source.
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 Cliquez sur « Reader » dans l’affichage par source, 
puis sur  (affichage par liste).
La zone d’affichage passe à l’affichage par liste et tout 
le contenu de la Library est répertorié.

 Conseils
	Lorsque vous cliquez sur « Books », « Audio » ou « Pictures » 

dans l’affichage par source, seul le contenu correspondant 
s’affiche.

	Lorsque vous cliquez sur  (affichage par vignette), le 
contenu s’affiche sous forme de vignettes.

	Vous pouvez créer une collection dans le Reader et sur une 
carte mémoire insérée dans le Reader et cette collection peut 
être transférée vers eBook Library. Pour plus d’informations 
sur la création et le transfert de collections, reportez-vous à 
l’Aide eBook Library.

 Sélectionnez le contenu que vous souhaitez 
transférer depuis la liste.
Cliquez sur les fichiers en maintenant la touche Ctrl 
enfoncée pour sélectionner plusieurs fichiers à la fois.

 Faites glisser les fichiers depuis la liste vers 
« Library » dans l’affichage par source.
Le contenu est transféré vers eBook Library.
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Synchronisation du contenu de la Library 
avec le Reader

Vous pouvez synchroniser le contenu de la Library de 
eBook Library avec le Reader en sélectionnant un dossier 
(tel que « Library » ou les sous-dossiers de « Library »). Le 
Reader peut être mis à jour automatiquement pour 
correspondre au contenu de la Library lors du raccordement 
à votre ordinateur.

Remarque

	Pour synchroniser le contenu de la Library de eBook Library avec 
le Reader, vous devez spécifier un dossier (tel que « Library » ou 
les sous-dossiers de « Library »). Pour plus d’informations sur la 
sélection d’un dossier, reportez-vous à l’Aide eBook Library.

Conseil
	Si vous souhaitez synchroniser rapidement le contenu de la Library 

avec le Reader, vous pouvez également les synchroniser 
manuellement. Pour plus d’informations sur la synchronisation 
manuelle du contenu, reportez-vous à l’Aide eBook Library.

 Cliquez sur le menu Démarrer, puis sélectionnez 
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.

 Raccordez le Reader à votre ordinateur à l’aide du 
câble USB fourni. (  page 39)
eBook Library commence automatiquement la 
synchronisation du contenu de la Library avec le 
Reader.
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Conseils
	eBook Library lance également automatiquement la 

synchronisation du contenu de la Library avec le Reader dans les 
cas suivants :
	lorsque vous lancez eBook Library après avoir raccordé le 

Reader à votre ordinateur ;
	lorsqu’aucun changement n’a été effectué sur le dossier spécifié 

pendant un certain temps.
	Vous pouvez également synchroniser le contenu de la Library de 

eBook Library avec une carte mémoire dans le Reader. Pour plus 
d’informations sur la synchronisation de contenu avec une carte 
mémoire, reportez-vous à l’Aide eBook Library.

	Vous pouvez également synchroniser le contenu du disque de 
votre ordinateur avec le Reader en définissant un dossier comme 
dossier favori. Pour plus d’informations, reportez-vous à l’Aide 
eBook Library.
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Lecture de livres

Lecture de livres
Sélection d’un livre dans la liste de livres

Suivez les étapes ci-dessous pour trouver les livres 
transférés depuis votre ordinateur.

 Dans le menu d’accueil, tapez sur  (Books).
La liste de livres s’affiche.
Si plus de 10 livres sont stockés, la barre d’index 
apparaît sur le côté droit de la liste. Les livres sont 
stockés par ordre alphabétique. Si le livre de votre choix 
n’apparaît pas dans la liste, faites glisser la barre 
d’index jusqu’à ce que le livre apparaisse ou tapez la 
première lettre du titre du livre.



Indique le nombre de jours restants avant la date 
limite d’utilisation du livre. Si la date a déjà expiré, 
« Expired » s’affiche à la place du nombre de jours.

 Témoin

Barre d’index

Indique que le 
contenu est 
stocké sur une 
carte mémoire.

 : carte 
« Memory 
Stick Duo » 

 : carte 
mémoire 
SD
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	 Conseils
	Si vous souhaitez poursuivre la lecture à partir de la dernière 

page affichée, tapez sur  (Continue Reading) dans le menu 
d’accueil. La dernière page affichée apparaît.

	Le contenu de la carte mémoire apparaît également dans la 
liste de livres.

	Vous pouvez afficher la page suivante de la liste en appuyant 
sur les touches <  /  > (utilisées pour tourner les pages).

	Si une opération incorrecte est effectuée,  apparaît en bas 
de l’écran.

	Si le livre à une date limite d’utilisation, le nombre de jours 
restant avant cette date s’affiche dans la liste de livres.

	« Expired » s’affiche si la date du livre est expirée.

	 Tapez	sur	le	livre	de	votre	choix	dans	la	liste.
La page de couverture du livre apparaît.
Si vous avez déjà lu le livre auparavant, la dernière 
page affichée apparaît. 
Pour plus d’informations sur la page du livre, consultez 
la section « Lecture de livres ». (  page 49)

Conseil
	Le menu d’options de la liste de livres s’affiche en appuyant sur la 

touche OPTION. Pour plus d’informations sur le menu d’options de 
la liste de livres, consultez la section « Affichage du menu 
d’options d’un livre ». (  page 53)
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Lecture de livres

Vous pouvez lire des livres en choisissant le livre de votre 
choix dans la liste de livres.

 Tapez sur le livre de votre choix dans la liste de 
livres.
La page du livre apparaît.

Indicateur de taille Numéro de la page 
actuelle/Nombre 
total de pages



 Conseil
	Vous pouvez afficher l’écran de saut de page en tapant sur le 

numéro de la page en bas de l’écran. (  page 60)
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	 Une	fois	sur	la	page	du	livre,	faites	glisser	la	page	ou	appuyez	
sur	la	touche	<	 	/	 	>	(utilisée	pour	tourner	les	pages).
Pour revenir à la page précédente, faites glisser la page 
dans le sens opposé ou appuyez sur la touche <  
(utilisée pour tourner les pages).

    
	 Pour	tourner	les	pages	plusieurs	fois

Si vous maintenez le stylet ou le doigt sur l’écran tactile après un 
glisser-déposer, vous pouvez tourner les pages plusieurs fois.

	 Conseils
	Vous pouvez effectuer un saut de page à l’aide de l’écran de 

saut de page. (  page 60)
	Vous pouvez inverser le sens dans lequel la page est glissée 

depuis le menu Settings. (  page 110)
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Conseil
	Le menu d’options de la page du livre s’affiche en appuyant sur la 

touche OPTION. Pour plus d’informations sur le menu d’options de 
la page du livre, consultez la section « Affichage du menu 
d’options d’un livre ». (  page 5�)

Pour fermer un livre
Appuyez sur la touche  (arrière).

Pour utiliser l’outil de liens des fichiers eBooks 
sur le Reader
Lorsqu’un fichier eBook est affiché, vous pouvez utiliser 
l’outil de liens intégré.
Le lien est mis en surbrillance sur l’écran. Tapez pour ouvrir 
le contenu du lien ou passer à la page liée.

Lien

Conseil
	Si vous souhaitez revenir à la page précédente après être passé à 

la page liée, saisissez le numéro de page en bas de l’écran pour 
afficher l’écran de saut de page, puis tapez sur   (vue 
précédente).
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Types de livres pris en charge par le Reader

Les types de livres pris en charge par le Reader et leurs 
caractéristiques sont décrits ci-dessous.

Fichier BBeB
(extension de 
fichier .lrf et .lrx)

Fichier au format BBeB utilisé pour des 
livres et des publications numériques.
L’outil de liens intégré dans les eBooks 
(sauts de page, etc.) peut être utilisé.  
(  page 51)

Fichier PDF*1

(extension de 
fichier .pdf)

Fichier au format PDF (version 1.4 ou 
antérieure)
Les signets et l’outil de liens peuvent être 
utilisés sur les fichiers PDF.

Fichier EPUB*1

(extension de 
fichier .epub)

Un fichier au format EPUB utilisé par les 
publications et livres numériques dotés de 
la fonction de repagination.

Fichier Texte 
(extension de 
fichier .txt)

Fichier RTF 
(extension de 
fichier .rtf)

Fichier RTF (non sécurisé) 
automatiquement converti depuis un 
fichier Microsoft Word.*�

*1 Les fichiers PDF et EPUB protégés par la technologie DRM d’Adobe 
sont uniquement pris en charge si Adobe Digital Editions, version 1.5 
ou ultérieure, est installé et autorisé sur votre ordinateur. 

*� Uniquement si Microsoft Word est installé sur votre ordinateur.
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Affichage du menu d’options d’un livre

Le menu d’options s’affiche en appuyant sur la touche 
OPTION. Vous pouvez accéder à différentes fonctions à 
partir du menu d’options.

Menu d’options de la liste de livres

Option Description/Page de référence

Sort Permet de trier la liste de livres par titre, auteur ou 
date.

View Permet de modifier le format d’affichage de la 
liste. (  page 55)

Now 
Playing*1

Permet d’atteindre l’écran de lecture des fichiers 
audio. (  page 97)

Orientation Permet de modifier l’orientation de l’écran 
(verticale/horizontale). (  page 69)

*1 « Now Playing » s’affiche uniquement lors de la lecture de pistes.

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche OPTION.
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Tri d’une liste
Vous pouvez trier une liste.
Dans le menu d’options, tapez sur « by Title », « by Author » 
ou « by Date » pour trier la liste.

Tri « by Date »

Date de 
transfert

Tri « by Author »

Nom de 
l’auteur

Conseils
	La fonction de tri de liste est également disponible dans la liste de 

collections, la liste de toutes les remarques, la liste des remarques, 
la liste des fichiers audio et la liste des images. Les options de tri 
varient selon le type de liste. Les rubriques de tri par défaut sont 
les suivantes : 
La liste de livres : « by Title » 
La liste de collections : « by Order » 
La liste de toutes les remarques : « by Date » 
La liste des remarques : « by Page » 
La liste des fichiers audio : « by Title » 
La liste des images : « by Title »

	Dans la barre d’index, les lettres qui se rapportent à des titres de 
livre ou à des noms d’auteur s’affichent en gras.

	Dans la barre d’index, les titres de livre ou les noms d’auteur qui 
commencent par un numéro sont triés sous « # ». Ceux qui 
commencent par un symbole sont triés sous «  ».
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Remarque

	L’apparence de la barre d’index varie selon le type de tri. Ainsi, si la 
liste est triée par date, les lettres n’apparaissent pas dans la barre.

Modification du format d’affichage de la liste
Vous pouvez choisir entre deux formats d’affichage de liste : 
la visualisation sous forme de « List » ou de « Thumbnail ».
Dans le menu d’options, tapez sur « Thumbnail » dans 
« View » pour modifier le format d’affichage de la liste.

« List » (par défaut) « Thumbnail »

Si vous modifiez le format d’affichage de liste, la liste des 
fichiers audio et la liste des images voient leur format 
modifié également.

Remarques

	Dans la liste de livres et de fichiers audio, la vignette peut s’afficher 
uniquement si le livre ou la piste contient des informations relatives 
à la pochette.

	Il est impossible d’afficher certaines de ces informations selon le 
format du fichier.

	Si les livres ou les pistes ne contiennent pas d’informations 
relatives à la pochette, l’image par défaut s’affiche alors dans la 
liste « Thumbnail ».
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Menu d’options d’une page de livre

Option Description/Page de référence

Go to Page Affiche l’écran de saut de page. (  page 60)
Create/Edit 
Notes

Affiche la barre d’outils pour créer/supprimer un 
signet et/ou mettre en surbrillance/créer un 
commentaire. (  page 78)

Hide Notes/
Show Notes

Masque/Affiche le signet/surlignage. (  page 84)

Table of 
Contents*1

Affiche la table des matières.

Book Info Affiche les informations relatives au livre.  
(  page 57)

Delete Book Supprime un livre. (  page 94)
Now 
Playing*2

Permet d’atteindre l’écran de lecture des fichiers 
audio. (  page 97)

Orientation Permet de modifier l’orientation de l’écran 
(verticale/horizontale). (  page 69)

*1 Les éléments affichés varient selon le contenu.
*2 « Now Playing » s’affiche uniquement lors de la lecture de pistes.

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche OPTION.
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Informations relatives au livre
Vous pouvez vérifier les informations sur le livre en question 
(titre, auteur, vignette de couverture, etc.).
Dans le menu d’options de la page du livre, tapez sur 
« Book Info » pour afficher les informations sur le livre.

Options Description

Book cover 
thumbnail*1

Affiche la vignette de la couverture.

Title Affiche le titre.
Author Affiche l’auteur.
Publisher*1 Affiche l’éditeur.
Category*1 Affiche la catégorie.
eBook ID*1 Affiche l’identifiant du livre.
Kind Affiche le type de fichier.
Date Affiche la dernière mise à jour et la date de 

création.
Size Affiche la taille du fichier.
Location Affiche l’emplacement de la mémoire où le livre est 

enregistré.
Internal memory : le livre est enregistré sur le Reader.
Memory Stick/ SD Memory Card : le livre est 
enregistré sur la carte mémoire.

Path Affiche l’emplacement du chemin de fichier.
Digital 
Rights*1,*�

Affiche les informations suivantes uniquement si 
la technologie DRM est sélectionnée.
Full viewable : le livre peut être lu en totalité. 
Restricted : seule une partie du livre peut être lue.

Expiration 
date*�

Affiche la date d’expiration du livre si ce livre doté 
de la technologie DRM en comporte une.

*1 Cette option apparaît uniquement si un livre BBeB est sélectionné.
*� Cette option apparaît uniquement si des fichiers PDF et EPUB sont 

sélectionnés.
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Sélection d’un livre dans la liste 
de collections
Vous pouvez sélectionner et lire un livre à partir de la liste 
de collections créée dans eBook Library.

Conseils
	Pour plus d’informations sur la création et le transfert de 

collections, reportez-vous à l’Aide eBook Library.
	Vous pouvez rechercher une collection dans la liste de collections 

à l’aide du menu Recherche. 
Pour plus d’informations sur le menu Recherche, consultez la 
section « Recherche de livres ». (  page 74)

	Le menu d’options de la liste de collections s’affiche en appuyant 
sur la touche OPTION. Vous pouvez modifier l’orientation de 
l’écran à partir du menu d’options. (  page 69)

	Vous pouvez également afficher le menu d’options d’une collection 
en appuyant sur la touche OPTION alors que la liste de livres de la 
collection est affichée. Pour plus d’informations sur les menus 
disponibles, consultez la section « Affichage du menu d’options 
d’une collection ». (  page 59)

 Dans le menu d’accueil, tapez sur  (Collections).
La liste de collections apparaît.

 Tapez sur la collection de votre choix dans la liste.
La liste de livres apparaît.

 Tapez sur le livre de votre choix.
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Affichage du menu d’options d’une collection

Le menu d’options s’affiche en appuyant sur la touche OPTION.
Vous pouvez accéder à différentes fonctions à partir du 
menu d’options.

Menu d’options d’une collection

Option Description

Sort Permet de trier la liste par ordre 
alphabétique, titre, auteur ou par date.

View Permet de modifier le format 
d’affichage de la liste. (  page 55)

Now Playing*1 Permet d’atteindre l’écran de lecture 
des fichiers audio. (  page 97)

Orientation Permet de modifier l’orientation de l’écran 
(verticale/horizontale). (  page 69)

*1 « Now Playing » s’affiche uniquement lors de la lecture de pistes.

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur
la touche OPTION.
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Saut de page
L’écran de saut de page apparaît en tapant sur « Go to 
Page » dans le menu d’options de la page du livre. Vous 
pouvez sauter des pages et atteindre une page directement 
à l’aide de l’écran de saut de page.

Conseil
	Vous pouvez afficher l’écran de saut de page en tapant sur le 

numéro de la page en bas de l’écran.

 Sur la page du livre, appuyez sur la touche OPTION.
Le menu d’options apparaît.

 Tapez sur « Go to Page ».
L’écran de saut de page apparaît.

Enter Page #
(  page 6�)

Barre de saut de page (  page 61)

 (vue précédente)/ 
  (vue suivante)
(  page 6�)

Pour fermer l’écran de saut de page
Tapez sur  ou sur le numéro de page en bas de l’écran. 
Sinon, appuyez sur la touche  (arrière) ou sur la touche 
OPTION.
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Utilisation de la barre de saut de page

Vous pouvez sauter des pages à l’aide de la barre de saut 
de pages sur l’écran de saut de page.

 Faites glisser la case de défilement ou appuyez 
brièvement sur la barre de saut de page.
La page est affichée selon la position de la case de 
défilement dans la barre de saut de page.

Case de défilement
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Accès direct à la page indiquée

Vous pouvez accéder directement à une page en saisissant 
son numéro à l’aide des touches numériques à l’écran.

 Tapez « Enter Page # » sur l’écran de saut de page.
Le clavier numérique s’affiche.

Zone de saisie

Touches numériques

Touche  (retour arrière)

 Saisissez le numéro de la page à l’aide des touches 
numériques.
Le numéro que vous avez saisi s’affiche dans la zone 
de saisie. Pour supprimer le numéro, appuyez sur la 
touche  (retour arrière).

Conseil
	10 chiffres au maximum peuvent être saisis.

 Tapez sur « Go ».
La page de saisie apparaît.
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Lecture des pages précédemment affichées

Le Reader stocke dans la mémoire les pages affichées 
précédemment afin de pouvoir les rappeler facilement.

 Tapez sur   (vue précédente) sur l’écran de saut 
de page.
La page affichée précédemment s’affiche. Pour revenir 
à la page affichée avant le saut de page, tapez sur  
  (vue suivante).
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Modification de la taille et zoom
Le menu Taille s’affiche en appuyant sur la touche  (taille). 
Dans le menu Taille, vous pouvez régler la taille du texte et 
effectuer un zoom avant/arrière sur la page.

 Sur la page du livre, appuyez sur la touche  (taille).
Le menu Taille apparaît.

 Zoom In
(  page 67)

Icônes de taille (  page 65)

Pour fermer le menu Taille
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche  (taille).

64 FR



PRS-700.FR.4-1�4-649-11(1)

Réglage de la taille du texte

Vous pouvez choisir parmi 5 tailles de texte différentes (S, 
M, L, XL ou XXL) dans le menu Taille. « S » est la taille par 
défaut.

 Tapez sur « M », « L », « XL » ou « XXL ».
La taille du texte est agrandie jusqu’à atteindre la taille 
sélectionnée et le texte est repositionné sur la page du 
livre. La taille sélectionnée est indiquée en bas de 
l’écran et la page d’origine est divisée en plusieurs 
sections.

Indicateur de taille

 Tapez sur , puis appuyez sur la touche  (arrière) 
ou sur la touche  (taille) pour fermer le menu Taille.
Une fois le menu Taille fermé, le texte s’affiche selon la 
taille sélectionnée. Pour revenir à la taille de texte par 
défaut, tapez sur « S » dans le menu Taille.
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Conseils
	Lors de la visualisation d’un document PDF à la taille S, vous 

pouvez agrandir la taille de la police en modifiant l’orientation de 
l’écran en « Horizontal ». Cela s’applique uniquement si vous 
devez conserver la mise en page originale du document PDF.

	La taille de police pour les fichiers BBeB, PDF ou EPUB est 
augmentée aux valeurs suivantes : 
Fichier BBeB : S(100 %), M(1�0 %), L(150 %), XL(�00 %), 
XXL(�60 %) 
Fichier PDF : S(100 %), M(�00 %), L(�00 %), XL(450 %),  
XXL(600 %) 
Fichier EPUB : S(100 %), M(140 %), L(180 %), XL(��0 %),  
XXL( - )*
*	 La	taille	XXL	n’est	pas	disponible	pour	les	fichiers	EPUB.

Remarques

	Si la taille de police est augmentée, le nombre total de pages 
affichées sur le Reader augmente proportionnellement au nombre 
de pages divisées. Toutefois, si la taille de police provenant de 
fichiers PDF/EPUB est agrandie, le nombre total de pages 
n’augmente pas et la pagination actuelle correspond à celle 
d’origine.

	Les fichiers PDF visualisés selon un facteur de zoom M, L, XL et 
XXL sont affichés en mode de reformatage dynamique. Dans 
certaines situations, seul le texte apparaît à ces échelles, les 
tableaux et les graphiques pouvant être reformatés et altérés.  
Si tel est le cas, il est conseillé d’appliquer un zoom réduit afin de 
conserver le formatage d’origine.

	Certaines pages basées sur une image, telle que la couverture 
d’un livre ou un fichier PDF créés sous forme d’un fichier d’images, 
ne peuvent pas être agrandies aux tailles M, L, XL ou XXL. Dans 
ce cas, nous vous recommandons d’utiliser le mode Zoom.
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Zoom avant/arrière

La page du livre passe en mode Zoom en tapant sur  
«  Zoom In » sur l’écran du menu Taille.

 Tapez sur «  Zoom In ».
La barre de zoom apparaît.

Case de défilement

Barre de zoom

 Déplacez la case de défilement ou tapez plusieurs 
fois sur + ou – sur la barre de zoom jusqu’à ce que 
la page soit agrandie à la taille souhaitée.
Un zoom avant/arrière est effectué sur la page.

Conseils
	Vous pouvez également effectuer un zoom avant/arrière sur la 

page du livre en tapant sur un point sur la barre de zoom.
	En tapant deux fois sur la page du livre en mode Zoom, un 

zoom avant est effectué et le point sur lequel vous avez tapé 
deux fois est centré.
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Pour faire défiler une image agrandie
Lorsqu’un zoom avant est effectué sur la page du livre,  
/ / /  apparaît aux bords de l’écran. Vous pouvez afficher 

le bord de la page en tapant sur / / / .

Vous pouvez également faire défiler la page en effectuant 
un glisser-déposer.

Pour sortir du mode Zoom
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche  (taille). La barre de zoom disparaît et l’écran de 
la page du livre revient à sa taille de police d’origine.
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Modification de l’orientation de 
l’écran (verticale/horizontale)
Dans le menu d’options, vous pouvez modifier l’orientation 
de l’écran (verticale/horizontale ou vice versa). Une fois 
l’orientation de l’écran modifiée, tous les menus et les 
contenus s’affichent selon l’orientation sélectionnée.

Conseil
	Vous pouvez modifier l’orientation de l’écran à partir de tous les 

menus d’options.

 Appuyez sur la touche OPTION.
Le menu d’options apparaît.

 Tapez sur « Orientation ».
L’orientation passe de la verticale à l’horizontale.
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A propos de la division de l’écran lorsque 
l’orientation de l’écran est horizontale
Lorsque l’orientation est horizontale, une page de livre est 
divisée en 2 parties (inférieure et supérieure). Pour afficher 
la partie inférieure, faites glisser la page ou appuyez sur la 
touche  > (utilisée pour tourner les pages).

>

<

Affichage de la
moitié supérieure

Affichage de la
moitié inférieure

Indicateur
de position



« Vertical » « Horizontal »
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Recherche de livres ou de mots 
clés
Le menu Recherche ainsi que le clavier à l’écran s’affiche 
en appuyant sur la touche SEARCH. Vous pouvez 
rechercher des livres ou des mots clés en saisissant un mot 
à l’aide du clavier à l’écran.

 Appuyez sur la touche SEARCH.
Le menu Recherche apparaît.

Search

Zone de saisie

Clavier à l’écran
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 Tapez sur le clavier à l’écran pour saisir le mot.
Le mot s’affiche à l’écran de la zone de saisie.

Zone de saisieCurseur

Historique du 
clavier

Touches 
alphabétiques

 (retour arrière)
/@#$

Symbols/Abc

Pour modifier un mot saisi
Tapez directement sur le mot saisi pour déplacer le 
curseur.

Pour effacer un caractère
Sélectionnez le caractère inutile à l’aide d’un glisser-
déposer ou tapez sur le caractère inutile pour déplacer 
le curseur vers la droite du mot, puis tapez sur  
 (retour arrière).

Pour modifier le caractère affiché sur le clavier
Tapez sur « Symbols ». Le clavier affiche alors les 
symboles. Pour revenir au clavier alphabétique, tapez 
sur « Abc ».
Pour passer des minuscules aux majuscules et 
inversement, tapez sur «  ».
Il existe � types de claviers de symboles (priorité 
élevée/priorité faible). Pour passer à l’autre clavier, 
tapez sur « @#$ ».
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Conseils
	48 caractères au maximum peuvent être saisis.
	Les mots saisis précédemment s’affichent dans la zone de 

l’historique du clavier. Seuls les mots qui sont concernés 
restent affichés alors que vous saisissez les caractères. Le 
mot que vous avez saisi s’affiche dans la zone de saisie.

Remarques

	Les mots de moins de � lettres ou de plus de 16 lettres ne 
peuvent pas être enregistrés dans l’historique du clavier.

	L’historique du clavier enregistre les lettres et les tirets. Les 
chiffres et autres symboles ne sont pas enregistrés.

 Tapez sur « Search ».
Pour plus d’informations sur la recherche de livres ou de 
mots clés, reportez-vous aux sections suivantes :
	Recherche de livres (  page 74)
	Recherche de mots clés dans un livre (  page 76)

Pour fermer le menu Recherche
Tapez sur  ou appuyez sur la touche SEARCH ou la 
touche  (arrière).
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Recherche de livres

Vous pouvez rechercher des livres par titre ou par auteur 
dans le menu d’accueil, dans la liste de livres ou de 
collections.
Conseils
	Vous pouvez rechercher une collection par nom dans la liste de 

collections.
	Vous pouvez également rechercher une remarque dans la liste des 

remarques ou la liste de toutes les remarques en saisissant un 
mot. (  page 88)

 Dans le menu d’accueil ou la liste de livres, appuyez 
sur la touche SEARCH.
Le menu Recherche s’affiche à l’aide du clavier à 
l’écran.

 Saisissez le mot en utilisant le clavier à l’écran.  
(  page 7�)
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 Tapez sur « Search ».
La liste des résultats de recherche apparaît. 
Tout livre comportant le mot saisi dans son titre ou dans 
le nom de l’auteur s’affiche dans la liste des résultats de 
recherche.

 Tapez sur le livre de votre choix.
La page du livre apparaît.

Pour fermer la liste des résultats de recherche
Tapez sur  ou appuyez sur la touche  (arrière).
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Recherche de mots clés dans un livre

Vous pouvez effectuer une recherche par mot-clé à l’aide du 
clavier à l’écran. Les mots clés s’affichent dans la zone de 
saisie des deux façons suivantes :
	Tapez deux fois sur un mot dans une page de livre, puis 

appuyez sur la touche SEARCH. Le mot sur lequel vous 
avez tapé deux fois s’affiche dans la zone de saisie.

	Appuyez sur la touche SEARCH dans une page de livre. 
Saisissez le mot-clé à l’aide du clavier à l’écran.

 Sur la page du livre, appuyez sur la touche SEARCH.
Le menu Recherche s’affiche à l’aide du clavier à l’écran.

 Saisissez le mot en utilisant le clavier à l’écran.  
(  page 72)

Pour saisir un mot sur une page
Tapez deux fois sur le mot de la page du livre pour le mettre 
en surbrillance temporairement. Pour sélectionner des mots 
qui se suivent, y compris la ponctuation, etc., faites glisser 
le curseur le long de la phrase après avoir tapé deux fois ; 
puis appuyez sur la touche SEARCH. Le mot ou la phrase 
sélectionné est placé dans la zone de saisie.

Mot saisi

Zone de saisie
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Remarque

	Les surlignages créés en tapant deux fois sur un mot peuvent 
être effacés des deux façons suivantes : 
–  Tapez sur n’importe quelle partie de la page autre que celle 

qui a été mise en surbrillance
– Tapez deux fois sur un autre mot
– Ouvrez un autre livre

 Tapez sur « Search ».
La page des résultats de recherche pour le mot saisi 
s’affiche. Les mots apparaissent en surbrillance sur la 
page.

 Tapez sur   (recherche suivante) pour passer à 
la page suivante où se trouve le mot recherché.
Cette page apparaît alors. Pour revenir à la page 
précédente où se trouve le mot saisi, tapez sur  

 	(recherche précédente).

Pour sortir de la page des résultats de recherche
Tapez sur  ou appuyez sur la touche  (arrière).
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Création de remarques sur une 
page de livre
En tapant sur « Create/Edit Notes » dans le menu d’options 
de la page du livre, une barre d’outils apparaît. Vous pouvez 
créer les remarques suivantes à l’aide de la barre d’outils.
	Création d’un signet (  page 79)
	Surlignage de mots (  page 8�)
	Ajout d’un commentaire (  page 85)

 Une fois sur la page du livre, appuyez sur la touche 
OPTION.
Le menu d’options apparaît.

 Tapez sur « Create/Edit Notes ».
La barre d’outils apparaît.

 Remarques  
(  page 91)

 (surlignage) 
(  page 82)

 (gomme)  
(  page 83)

 (signet)  
(  page 79)
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Pour fermer la barre d’outils
Tapez sur  ou appuyez sur la touche  (arrière).

Création d’un signet sur une page

Vous pouvez créer un signet sur une page afin de l’atteindre 
facilement plus tard. 
Il est possible de créer un signet des deux façons suivantes.
	Sur la page du livre, créez un signet en tapant deux fois 

sur la page.
	Sur la page du livre, créez un signet en utilisant la barre 

d’outil.

Pour créer un signet en tapant deux fois sur 
une page

 Une fois sur la page du livre, tapez deux fois sur le 
coin supérieur droit de l’écran.
Le signet apparaît dans le coin supérieur droit de la 
page actuelle. 

Signet
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Pour créer un signet à l’aide de la barre d’outils 

 Une fois sur la page du livre, appuyez sur la touche 
OPTION.
Le menu d’options apparaît.

 Tapez sur « Create/Edit Notes ».
La barre d’outils apparaît.

 Tapez sur  (signet).
Le signet apparaît dans l’angle supérieur droit de la 
page actuelle et la couleur de  dans la barre d’outils 
est inversée.

 (signet)

Signet

Conseil
	Vous pouvez ajouter un commentaire à un signet. Pour plus 

d’informations, consultez la section « Ajout d’un commentaire à 
une remarque ». (  page 85)
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Pour supprimer un signet
Pour supprimer un signet, tapez deux fois sur le signet. 
Vous pouvez également supprimer un signet en tapant sur 

 dans la barre d’outils.

Conseils
	Lors de la visualisation d’un commentaire d’un signet, vous pouvez 

supprimer le signet et le commentaire en tapant sur « Delete ».  
(  page 87)

	Vous pouvez supprimer toutes les remarques d’un livre à partir du 
menu d’options de la liste de remarques. (  page 9�)

Remarque

	Si vous supprimez un signet accompagné d’un commentaire, ce 
dernier est également supprimé. Tapez sur « Yes » dans le 
message de confirmation pour supprimer le signet et le 
commentaire.

Pour afficher une page incluant un signet
Vous pouvez afficher une page incluant un signet à partir de 
la liste de toutes les remarques ou la liste des remarques.  
(  pages 89 et 91)
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Surlignage des mots

Vous pouvez surligner les mots d’une page de livre. 

 Tapez sur  (surlignage).
La couleur du symbole  est inversée dans la barre 
d’outils et la fonction de surlignage devient alors disponible.

 Faites glisser votre stylet sur le mot indiqué sur la 
page du livre.
ll est alors surligné.

 (surlignage)

Mot surligné

 Conseil
	Vous pouvez ajouter un commentaire à un surlignage. Pour 

plus d’informations, consultez la section « Ajout d’un 
commentaire à une remarque ». (  page 85)

Conseils
	Vous pouvez également mettre en surbrillance un mot à l’aide d’un 

lien hypertexte et y ajouter un commentaire (  page 85).
	Pour mettre en surbrillance plusieurs lignes d’un texte en une 

seule fois, effectuez un glisser-déposer en partant du premier 
caractère et ce, jusqu’au dernier.
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Remarques

	Si vous saisissez un mot surligné avec un lien hypertexte, l’éditeur 
de commentaire (  page 85) ou l’écran de visualisation des 
commentaires (  page 87) s’affiche au lieu d’effectuer un saut de 
page. Pour activer le lien hypertexte, masquez les surlignages en 
utilisant « Hide Notes » dans le menu d’options ou supprimez le 
surlignage. 

	Vous ne pouvez pas mettre en surbrillance la page de garde ni les 
images, de même pour les titres de livre ou de chapitre qui 
s’affichent en haut à droite de la page du livre.

Pour supprimer un surlignage
 Tapez sur  (gomme).

La couleur du symbole  est inversée dans la barre 
d’outils et la fonction de suppression du surlignage 
devient alors disponible.

 Tapez sur le mot surligné ou effectuez un glisser-
déposer sur la page du livre.
Le surlignage est alors effacé.

Conseils
	Lors de la visualisation d’un commentaire d’un signet, vous pouvez 

supprimer le signet et le commentaire en tapant sur « Delete ».  
(  page 87)

	Vous pouvez supprimer toutes les remarques d’un livre à partir du 
menu d’options de la liste de remarques. (  page 9�)

Remarque

	Si vous supprimez un surlignage accompagné d’un commentaire, 
ce dernier est également supprimé. Tapez sur « Yes » dans le 
message de confirmation pour supprimer le surlignage et le 
commentaire.
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Masquage des remarques (signet/surlignage)
Permet de masquer/démasquer les signets/surlignages 
dans un livre à partir du menu d’options d’une page. 

 Tapez sur « Hide Notes ».
Tous les signets et les surlignages du livre sont 
masqués temporairement. Pour les afficher de nouveau, 
tapez sur « Show Notes ».

84 FR



PRS-700.FR.4-1�4-649-11(1)

Ajout d’un commentaire à une 
remarque
Vous pouvez ajouter un commentaire à un signet ou à un 
mot surligné à l’aide du clavier à l’écran dans éditeur de 
commentaires.

 Tapez sur le signet ou le mot surligné.
L’éditeur de commentaire apparaît.

Clavier à l’écran

Ecran de saisie

Suite 85 FR



PRS-700.FR.4-1�4-649-11(1)

 Saisissez votre commentaire en utilisant le clavier à 
l’écran.
Pour plus d’informations sur l’utilisation du clavier à 
l’écran, voir  page 7�.
Le clavier à l’écran de l’éditeur de commentaires 
dispose d’une touche « Return ». Vous pouvez passer à 
la ligne suivante à l’aide de cette touche.

Conseil
	Un commentaire peut comporter � 048 caractères maximum.

 Tapez sur « Done ».
L’éditeur de commentaires est fermé et le symbole  est 
joint au signet et au surlignage.

Remarque

	Veillez à taper sur « Done » une fois le commentaire saisi. Si 
vous tapez sur , le commentaire n’est pas ajouté.
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Pour visualiser un commentaire
Tapez sur  (signet et commentaire) ou sur  (surlignage 
et commentaire) sur la page du livre. L’écran de visualisation 
des commentaires apparaît.

Numéro de page du 
commentaire

/ : 
Les flèches sont disponibles lorsqu’un 
commentaire comporte plusieurs pages.
Pour afficher la page suivante/précédente 
du commentaire, tapez sur /.

Remarque

	Si vous saisissez un mot surligné avec un lien hypertexte, l’éditeur 
de commentaire (  page 85) ou l’écran de visualisation des 
commentaires s’affiche au lieu d’effectuer un saut de page. Pour 
activer le lien hypertexte, masquez les surlignages en utilisant 
« Hide Notes » dans le menu d’options ou supprimez le surlignage. 
(  pages 8� et 84)

Pour modifier le commentaire
Tapez sur « Edit » dans l’écran de visualisation des 
commentaires pour afficher l’éditeur de commentaires. 
Modifiez votre commentaire en utilisant le clavier à l’écran.  
(  page 7�)

Pour supprimer un commentaire
Tapez sur « Delete » dans l’écran de visualisation des 
commentaires. Le commentaire et le signet/surlignage sont 
ajoutés.
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Ouverture d’une page à partir de 
la liste de remarques
Vous pouvez ouvrir directement une page contenant un 
signet ou des mots surlignés à partir de l’écran de listes.

Conseils
	Il est également possible de créer des remarques dans eBook 

Library.  
Vous pouvez régler la fusion des remarques du Reader et de 
eBook Library tout en effectuant la synchronisation. En cas 
d’incohérence sur un même mot lors de la fusion des remarques, 
les anciennes remarques sont remplacées par les plus récentes.

	Lors de la copie d’un livre vers le Reader depuis eBook Library, les 
remarques existant dans le Reader sont remplacées par celles de 
eBook Library (et inversement).

	Les annotations d’un livre transféré depuis le logiciel Adobe Digital 
Editions, version 1.5 ou ultérieure, sont converties en signets sur le 
Reader.
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Recherche de remarques sur le Reader

En tapant sur  (All Notes) dans le menu d’accueil, la liste de 
toutes les remarques apparaît. La liste de toutes les remarques 
comporte toutes les remarques de tous les livres stockés sur le 
Reader et sur les cartes mémoire. Vous pouvez passer à une 
page donnée en tapant sur une option dans la liste.

Conseil
	Vous pouvez rechercher une remarque dans la liste de toutes les 

remarques à l’aide du menu Recherche.

 Dans le menu d’accueil, tapez sur  (All Notes).
La liste de tous les signets et surlignages du Reader apparaît.

Indique le type de remarque
 (signet) : la première phrase de la page s’affiche.
 (surlignage) : le mot surligné s’affiche.
 (surlignage avec commentaire) : le commentaire s’affiche.
 (signet avec commentaire) : le commentaire s’affiche.

Date annotée/Titre de livre/Numéro 
de page

 Tapez sur une remarque.
La page qui inclut la remarque s’affiche.
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Affichage du menu d’options de la liste de 
toutes les remarques

Le menu d’options s’affiche en appuyant sur la touche OPTION. 
Vous pouvez accéder à différentes fonctions à partir du 
menu d’options.

Menu d’options de la liste de toutes les remarques

Option Description

Sort Permet de trier la liste par date, 
type ou commentaire.

Now Playing*1 Permet d’atteindre l’écran de 
lecture des fichiers audio.  
(  page 97)

Orientation Permet de modifier l’orientation 
de l’écran (verticale/horizontale).  
(  page 69)

*1 « Now Playing » s’affiche uniquement lors de la lecture de pistes.

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche OPTION.
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Recherche de remarques dans un livre

En appuyant sur «  Notes » dans la barre d’outils, la liste 
des remarques s’affiche. Cette liste comprend toutes les 
remarques du livre que vous êtes en train de visualiser. 
Vous pouvez sauter à une page donnée en tapant sur une 
option dans la liste.

Conseil
	Vous pouvez rechercher une remarque dans la liste de remarques 

à l’aide du menu Recherche.

 Sur la page du livre, appuyez sur la touche OPTION.
Le menu d’options apparaît.

 Tapez sur « Create/Edit Notes ».
La barre d’outils apparaît.
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 Tapez sur «  Notes ».
La liste de tous les signets et surlignages du livre actuel 
apparaît. 


Numéro de 
page

 (signet) : 
la première phrase de la page 
s’affiche.

 (surlignage) : 
le mot surligné s’affiche.
Indique le type de remarque.

 (surlignage avec commentaire) : 
le commentaire s’affiche.

 (signet avec commentaire) : 
le commentaire s’affiche.

 Tapez sur une remarque.
La page qui inclut la remarque s’affiche.

Pour supprimer toutes les remarques dans un livre
Dans le menu d’options de la liste de remarques, tapez sur 
« Delete Notes ».
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Affichage du menu d’options de la liste de 
remarques

Le menu d’options s’affiche en appuyant sur la touche OPTION. 
Vous pouvez accéder à différentes fonctions à partir du 
menu d’options.

Menu d’options de la liste de remarques

Option Description

Sort Permet de trier la liste par page, 
type ou commentaire.

Delete Notes Supprime tous les signets, les 
surlignages et les commentaires du livre.

Now Playing*1 Permet d’atteindre l’écran de lecture 
des fichiers audio. (  page 97)

Orientation Permet de modifier l’orientation de 
l’écran (verticale/horizontale).  
(  page 69)

*1 « Now Playing » s’affiche uniquement lors de la lecture de pistes.

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche OPTION.
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Suppression d’un livre 
Vous pouvez supprimer un livre du Reader ou des cartes 
mémoire insérées dans le Reader.

 Sur la page du livre, appuyez sur la touche OPTION.
Le menu d’options apparaît.

 Tapez sur « Delete Book ».
Le message de confirmation apparaît.

 Tapez sur « Yes ».
Le livre est supprimé et l’écran revient à la liste de 
livres.
Remarque

	Vérifiez bien avant de supprimer le livre.
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Lecture de fichiers audio

Lecture de fichiers audio
Lecture de fichiers audio transférés depuis 
votre ordinateur

Les fichiers MP3 et AAC (non protégés) peuvent être lus sur le 
Reader. Vous pouvez également lire des livres tout en écoutant 
un fichier audio. (  page 96) Lors de l’écoute de fichiers audio, 
raccordez les écouteurs en option à la prise écouteurs.

 Dans le menu d’accueil, tapez sur  (Audio).
La liste des fichiers audio apparaît.

Indique que le 
contenu est stocké 
sur une carte 
mémoire.

 : carte 
« Memory 
Stick Duo » 

 : carte 
mémoire SD

Vignettes des 
images (le cas 
échéant)

 Témoin



 Conseils
	Le contenu de la carte mémoire apparaît également dans la liste 

de fichiers audio.
	Si plus de 10 plages sont stockées, la barre d’index apparaît 

sur le côté droit de la liste. Vous pouvez afficher la page 
suivante de la liste en faisant défiler la barre ou en appuyant 
sur la touche  > (utilisée pour tourner les pages).

	Si une opération incorrecte est effectuée,  apparaît en bas de l’écran.
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 Tapez sur la piste de votre choix.
La lecture commence.
Puis, les pistes suivantes sont lues dans l’ordre de la 
liste.

Pour arrêter la lecture, tapez sur  à l’écran.

Pour fermer la liste de fichiers audio ou l’écran 
de lecture
Appuyez sur la touche  (arrière).

Conseils
	Vous pouvez lire un livre lors de la lecture de pistes. Pour ce faire, 

démarrez la lecture de la piste avant de commencer la lecture du 
livre.

	Le menu d’options pour les fichiers audio s’affiche en appuyant sur 
la touche OPTION. (  page 98)

	Lors de la lecture d’une piste, l’indicateur de volume s’affiche en 
bas à droite de l’écran.
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Opérations disponibles sur l’écran de lecture
Vous pouvez exécuter les opérations suivantes à partir de 
l’écran de lecture.

Icône du mode de lecture*1

 : Lecture aléatoire
 : Repeat (1 Song)

 : Repeat (All Songs)
Nom de la piste
Nom de l’artiste

Nom de l’album

Case de 
défilement

Indicateur de volume

Temps de 
lecture écoulé/
Durée totale de 
la piste actuelle

Numéro de la piste actuelle/
Nombre total de pistes

Barre de progression  
de lecture

(arrêt)/(lecture)

Zone d’image

*1 Les icônes du mode de lecture apparaissent alors que les plages sont 
en cours de lecture aléatoire ou de lecture répétée. (  page 99)

Touche/Mouvement Opération

  Glisser-déposer (  page 19)
  Touches   /   (utilisées 

pour tourner les pages)

Permet de passer à la piste 
précédente/suivante.

Barre de progression de 
lecture

Permet d’effectuer une avance et/
ou un retour rapide de la piste en 
faisant glisser la case de défilement 
ou en tapant sur un point de la 
barre de progression de lecture.

/ Arrête/Redémarre la lecture.

Touche VOL –/+ 	Règle le volume.
	Permet d’activer et/ou de 

désactiver la fonction de sourdine 
en appuyant sur cette touche et 
en la maintenant enfoncée.
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Affichage du menu d’options des fichiers audio

Le menu d’options apparaît en appuyant sur la touche OPTION.
Vous pouvez accéder à différentes fonctions à partir du 
menu d’options.

Menu d’options de la liste de fichiers audio

Option Description/Page de référence

Sort Permet de trier la liste des fichiers 
audio par titre ou par artiste.

View Permet de modifier le format 
d’affichage de la liste. (  page 55)

Now Playing*1 Permet d’atteindre l’écran de lecture 
des fichiers audio. (  page 97)

Orientation Permet de modifier l’orientation 
de l’écran (verticale/horizontale).  
(  page 69)

*1 « Now Playing » s’affiche uniquement lors de la lecture de pistes.

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche OPTION.
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Menu d’options de l’écran de lecture

Option Description/Page de référence

Repeat Off (réglage par défaut) : arrête la 
lecture une fois que toutes les 
pistes ont été lues.
1 Song : lit la piste actuelle de 
façon répétée.
All Songs : lit toutes les pistes de 
façon répétée.

Shuffle Off/On Lit toutes les pistes dans un ordre 
aléatoire.

Continue Reading Permet d’atteindre l’écran de la 
page du livre. La page affichée 
précédemment s’affiche.

Orientation Permet de modifier l’orientation 
de l’écran (verticale/horizontale).  
(  page 69)

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche OPTION.
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Visualisation d’images

Visualisation d’images
Visualisation d’images transférées depuis votre 
ordinateur

Les fichiers BMP/JPEG/GIF/PNG peuvent être visualisés 
sur le Reader.

 Dans le menu d’accueil, tapez sur  (Pictures).
La liste des images apparaît.

Indique que le 
contenu est 
stocké sur une 
carte mémoire.

 : carte 
« Memory 
Stick Duo »

 : carte 
mémoire SD

Vignettes

 Témoin



 Conseils
	Le contenu de la carte mémoire apparaît également dans la liste 

d’images.
	Si plus de 10 images sont stockées, la barre d’index apparaît 

à droite de la liste. Vous pouvez afficher la page suivante de la 
liste en faisant défiler la barre ou en appuyant sur la touche  

 > (utilisée pour tourner les pages).
	Si une opération incorrecte est effectuée,  apparaît en bas 

de l’écran.
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 Tapez sur l’image de votre choix.
L’image apparaît.

Pour fermer la liste d’images ou l’écran de 
visualisation d’images
Appuyez sur la touche  (arrière). 

Conseils
	Le menu Taille de l’écran de visualisation d’images peut s’afficher 

en appuyant sur la touche  (taille). Dans le menu Taille, vous 
pouvez effectuer un zoom avant/arrière de l’image. (  page 67)

	Le menu d’options de l’image apparaît en appuyant sur la touche 
OPTION. (  page 104)

	Pour augmenter la résolution des images en mode paysage, 
visualisez-les en mode horizontal. (  page 69)
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Opérations disponibles sur l’écran de 
visualisation d’images
Vous pouvez exécuter les opérations suivantes à partir de 
l’écran de visualisation d’images.

Numéro de l’image actuelle/
Nombre total d’images

Touche/Mouvement Opération

  Glisser-déposer  
(  page 19)

  Touches   /   
(utilisées pour tourner 
les pages)

Permet d’afficher l’image 
précédente/suivante.
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Pour effectuer un zoom avant/arrière sur une 
image
Vous pouvez effectuer un zoom avant/arrière sur une image. 
Dans l’écran de visualisation d’images, appuyez sur la 
touche  (taille) pour afficher un menu d’images, puis tapez 
sur « Zoom In » pour afficher la barre de zoom. 
Pour plus d’informations sur l’utilisation de la barre de zoom 
et le défilement de l’image agrandie, reportez-vous à la 
section « Zoom avant/arrière » (  page 67). 



Barre de zoom

Case de défilement

10� FR



PRS-700.FR.4-1�4-649-11(1)

Affichage du menu d’options des images

Le menu d’options apparaît en appuyant sur la touche OPTION.
Vous pouvez accéder à différentes fonctions à partir du 
menu d’options.

Menu d’options de la liste d’images

Option Description/Page de référence

Sort Permet de trier la liste des images 
par titre ou par date.

View Permet de modifier le format 
d’affichage de la liste. (  page 55)

Now Playing*1 Permet d’atteindre l’écran de lecture 
des fichiers audio. (  page 97)

Orientation Permet de modifier l’orientation 
de l’écran (verticale/horizontale).  
(  page 69)

*1 « Now Playing » s’affiche uniquement lors de la lecture de pistes.

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche OPTION.
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Menu d’options de l’écran de visualisation d’images

Option Description/Page de référence

Slideshow On/Off Démarre/Arrête le diaporama 
d’images.
Le diaporama peut être configuré 
à partir du menu Settings.  
(  page 110)

Now Playing*1 Permet d’atteindre l’écran de lecture 
des fichiers audio. (  page 97)

Orientation Permet de modifier l’orientation 
de l’écran (verticale/horizontale).  
(  page 69)

*1 « Now Playing » s’affiche uniquement lors de la lecture de pistes.

Remarque

	Lorsque le réglage « Slideshow » du menu Settings est réglé sur 
« Off », le diaporama ne démarre pas même si vous sélectionnez 
« Slideshow On » dans le menu d’options.

Pour fermer le menu d’options
Tapez sur , puis appuyez sur la touche  (arrière) ou sur 
la touche OPTION.
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Réglages

Modification des réglages
Vous pouvez configurer les différents réglages dans le 
menu Settings.

 Dans le menu d’accueil, tapez sur  (Settings).
Le menu Settings apparaît. 
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 Tapez sur l’option de réglage que vous souhaitez 
sélectionner.
Le menu Settings de l’option sélectionnée apparaît. 
Lorsque vous sélectionnez « Advanced Settings », le 
menu de réglages avancés apparaît. Tapez sur l’option 
de réglage que vous souhaitez de nouveau sélectionner.
	Options du menu Settings (  page 109)
	Options du menu Advanced Settings (  page 11�)

Menu Advanced Settings

 Tapez pour sélectionner un réglage. Pour saisir un 
numéro, tapez la touche numérique.
Exemple : Device Lock

Touches numériques
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 Tapez sur « OK » ou sur « Yes » pour confirmer le 
réglage.

Pour fermer le menu Settings
Pour fermer le menu Settings et le menu Advanced Settings, 
appuyez sur la touche  (arrière).
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Options du menu Settings

Dans le menu Settings, vous pouvez configurer les réglages 
suivants.

Option Description

Date and Time Permet de régler la date et l’heure 
affichées sur le Reader. Pour saisir une 
valeur, tapez sur la touche numérique. 

Conseil
	Lorsque vous raccordez le Reader à votre 

ordinateur et que eBook Library est ouvert, 
la date et l’heure du Reader sont 
automatiquement synchronisées avec 
l’horloge de votre ordinateur.

Power 
Management

Permet d’activer ou de désactiver le mode 
Economie d’énergie.
On (réglage par défaut) :
	Après 60 minutes d’inactivité, le Reader 

passe automatiquement en mode de veille 
et réduit ainsi la consommation d’énergie de 
la batterie.

	Le Reader se ferme automatiquement après 
5 jours d’inactivité, ce qui interrompt la 
consommation d’énergie de la batterie.

	Si le niveau de la batterie est faible, le Reader se 
ferme après 60 minutes d’inactivité.

Off : le Reader ne passe pas en mode 
Economie d’énergie.
Pour plus d’informations, consultez la 
section « A propos de l’économie 
d’énergie du Reader ». (  page �4)
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Option Description

Power 
Management  
(suite)

Remarque

	Dans les cas suivants, le Reader ne se met 
pas en mode de veille après 60 minutes 
d’inactivité même si la fonction « Power 
Management » est réglée sur « On ».
– lorsque l’appareil est raccordé à l’ordinateur 

à l’aide du câble USB fourni
– lorsqu’il est raccordé à l’adaptateur secteur 

pour le Reader (AC-S5220E) (en option) 
pour être rechargé

– lors de la lecture de pistes

Page Turn 
Gesture

Permet de changer la direction dans 
laquelle la page est tournée.
 : vous passez d’une page à l’autre en 
glissant de gauche à droite sur l’écran 
tactile.
 : vous passez d’une page à l’autre en 
glissant de droite à gauche sur l’écran 
tactile.

Slideshow Permet de configurer les réglages du 
diaporama.
On : active le diaporama.
Off (réglage par défaut) : désactive le 
diaporama.
Slide Duration : pour saisir une durée, 
tapez sur la touche numérique. La durée 
peut atteindre 60 secondes, par 
incréments de 1 seconde.

Remarque

	L’affichage d’une image volumineuse peut 
prendre plus de temps que la durée réglée 
dans « Slide Duration ».
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Option Description

Advanced 
Settings

Voir « Options du menu Advanced 
Settings ». (  page 11�)

About Affiche la version du micrologiciel du 
Reader, le nom du produit et les 
informations sur la licence, etc.

Restore Defaults Voir « Restauration des réglages par 
défaut ». (  page 1�4)
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Options du menu Advanced Settings

Dans le menu Advanced Settings, vous pouvez configurer 
les réglages suivants.

Option Description

Device Lock Permet de verrouiller le Reader à l’aide 
d’un mot de passe.
On :  le Reader est verrouillé à l’aide d’un 

mot de passe.
Off (réglage par défaut) :  le Reader n’est 

pas verrouillé.
Code :  pour saisir un mot de passe, tapez 

les quatre chiffres à l’aide des 
touches numériques. 

Une fois le mot de passe configuré, un 
écran de saisie du mot de passe apparaît 
à la mise sous tension du Reader. Pour le 
déverrouiller, entrez le mot de passe à 
l’aide des touches numériques, puis tapez 
sur « OK ».

Remarque

	Veillez à ne pas oublier ce mot de passe. 
Veuillez contacter l’assistance Sony si vous 
avez perdu votre mot de passe. 
Pour les clients aux Etats-Unis : 
Numéro de téléphone : 1-866-96�-7669 
Pour les clients au Canada : 
Numéro de téléphone : 1-877-899-7669

Touch Panel Permet de régler l’écran tactile pour une 
sélection précise. Pour plus d’informations 
sur le réglage, voir « Réglage de l’écran 
tactile ». (  page �6)
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Option Description

Clear Keyboard 
History

Permet de supprimer tous les mots 
enregistrés à l’aide du clavier à l’écran. 
Une fois supprimé, le mot n’apparaît plus 
dans l’historique du clavier sur le clavier à 
l’écran.

Format Internal 
Memory

Permet de formater la mémoire flash 
intégrée du Reader. En formatant la 
mémoire, tous les contenus du Reader 
sont effacés.

Remarque

	Avant de formater, veillez à transférer les 
données que vous ne voulez pas perdre sur 
votre ordinateur ou sur un autre 
périphérique.

Device Shutdown Permet d’arrêter le Reader afin d’éviter 
que la batterie ne se décharge. 

Conseil
	Vous pouvez également arrêter le Reader 

en faisant glisser le commutateur POWER et 
en le maintenant pendant plus de 
� secondes.

Remarques

	Une fois arrêté, la mise sous tension du 
Reader peut demander quelques instants.

	Si vous souhaitez connecter le Reader à 
votre ordinateur après son arrêt, vous devez 
le remettre sous tension.
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Dépannage

Dépannage
Si votre Reader ne fonctionne pas correctement, essayez 
d’effectuer les étapes suivantes pour résoudre le problème.

 Réinitialisez le Reader en appuyant sur la touche 
RESET à l’aide de la pointe du stylet fourni, d’une 
petite aiguille ou du bout d’un trombone.

Retrait de la pointe du stylet fourni
Tournez la pointe jusqu’à ce qu’elle soit complètement 
détachée du stylet fourni. Pour appuyer sur la touche 
RESET, utilisez l’autre extrémité de la pointe stockée 
dans le corps du stylet. Veuillez le remettre à sa place 
après l’avoir utilisé.

Sert à appuyer sur la touche RESET

La réinitialisation du Reader n’affecte pas son contenu 
et ses réglages : aucune information ne sera effacée.
Après avoir appuyé sur la touche RESET, mettez le Reader 
sous tension en faisant glisser le commutateur POWER.
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Remarques

	L’écran ne change pas après avoir appuyé sur la touche RESET. 
Faites glisser le commutateur POWER pour réactiver le Reader.

	Si vous raccordez le Reader à votre ordinateur après une 
réinitialisation, il est nécessaire de remettre le Reader sous 
tension. Sinon, il faut environ 5 minutes avant que  ne 
s’affiche. Pendant cette période, vous ne pourrez pas mettre le 
Reader sous tension à l’aide du commutateur POWER. Dans 
ce cas, débranchez le câble USB du Reader, puis allumez le 
Reader et reconnectez-le.

 Vérifiez les symptômes à la section « Dépannage ». 
(  page 116)

 Consultez les informations relatives à ce problème 
dans l’Aide eBook Library.

 Consultez les informations relatives à ce problème 
sur l’un des sites Web de support à la clientèle.
Pour les clients aux Etats-Unis :
http://www.sony.com/readersupport
Pour les clients au Canada :
http://www.sony.ca/ElectronicsSupport/

 Si les conseils donnés ci-dessus ne permettent pas 
de résoudre le problème, contactez l’assistance Sony.
Pour les clients aux Etats-Unis :
Numéro de téléphone : 1-866-96�-7669
Pour les clients au Canada :
Numéro de téléphone : 1-877-899-7669
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Alimentation
Symptôme Cause ou action corrective

Impossible de 
charger la batterie 
(Le témoin ne 
s’allume pas).

 Permet de charger la batterie à une 
température comprise entre 10 °C et 
�0 °C. 
Sinon, la charge peut s’avérer 
insuffisante ou impossible à 
effectuer. 

L’autonomie de la 
batterie est faible.

 La température de fonctionnement 
est inférieure à 5 °C. Ceci est dû à 
des caractéristiques propres à la 
batterie. Il ne s’agit pas d’un 
problème de fonctionnement.

 Vous n’avez pas utilisé le Reader 
pendant une période prolongée. 
L’efficacité de la batterie augmente 
au fil des charges et des décharges.

 La batterie doit être remplacée. 
Consultez votre centre de réparation 
Sony le plus proche.

 La batterie n’a pas eu le temps de se 
recharger complètement.

	 Chargez la batterie jusqu’à ce que le 
témoin s’éteigne. (L’icône de la 
batterie n’indique pas l’autonomie 
restante en cours de charge.)

 La durée de vie de la batterie est 
plus courte si l’éclairage intégré est 
activé tout le temps. (  page ��)
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Symptôme Cause ou action corrective

Impossible de mettre 
le Reader sous 
tension.

 De la condensation s’est peut être 
formée. Attendez quelques heures, 
puis mettez de nouveau le Reader 
sous tension.

 Si la batterie est épuisée, raccordez 
le lecteur à votre ordinateur à l’aide 
d’un câble USB et chargez la 
batterie. (  page �9)

 Si la batterie est complètement 
épuisée, l’indication  peut mettre 
environ 5 minutes à s’afficher. En 
attendant, vous ne pourrez pas 
mettre le Reader sous tension à 
l’aide du commutateur POWER. 
Dans ce cas, attendez que  
s’affiche. 
Le témoin de charge s’allume en 
rouge si  ne s’affiche pas 
pendant la charge du Reader.

Alimentation (suite)
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Ecran
Symptôme Cause ou action corrective

L’affichage met 
quelque temps à 
apparaître.

 Dans un endroit froid, à l’extérieur 
par exemple, l’affichage peut mettre 
quelques instants à apparaître.

	 Ceci est dû à des caractéristiques 
propres à l’affichage. Il ne s’agit pas 
d’un problème de fonctionnement.

Impossible 
d’autoriser ou 
d’annuler 
l’autorisation du 
Reader à l’aide de 
eBook Store de 
Sony.

  Il n’est pas possible d’autoriser ou 
d’annuler l’autorisation du Reader à 
l’aide de eBook Store de Sony si 
l’option « Device Lock » du Reader 
est réglée sur « On ». Réglez-la sur 
« Off », puis autorisez ou annulez 
l’autorisation du Reader.

Impossible de 
sélectionner des 
éléments même si 
vous tapez bien 
dessus.

  Réglez l’écran tactile à partir de 
l’option « Touch Panel » du menu 
« Advanced Settings ». (  page 11�)

L’écran est fixe.   Réinitialisez le Reader en appuyant 
sur la touche RESET. Ensuite, faites 
de nouveau glisser le commutateur 
POWER pour réactiver le Reader.  
(  page 114)
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Lecture/Ecoute/Visualisation d’un contenu
Symptôme Cause ou action corrective

Impossible de lire un 
livre.

 Impossible de lire un livre protégé 
par des droits d’auteur sur un 
appareil autre que celui autorisé.

 Si le livre comporte une date limite 
d’utilisation, vérifiez si la date a été 
dépassée ou non  page 47.

Impossible de lire un 
fichier audio.

 Les fichiers audio non pris en charge 
par le Reader ne peuvent pas être lus. 
Pour plus d’informations sur les fichiers 
audio pris en charge, voir  page 95.

Aucun son n’est 
émis.

 Permet d’augmenter le volume s’il est bas.
 Si aucun son n’est émis via les écouteurs, 

vérifiez si la fiche des écouteurs est 
correctement insérée dans la prise écouteurs.

Impossible d’afficher 
une image.

 Les fichiers image non pris en charge par 
le Reader ne peuvent pas être visualisés. 
Pour plus d’informations sur les fichiers 
image pris en charge, voir  page 100.

 Si l’image est volumineuse, il est 
possible qu’elle ne puisse pas être 
affichée et que son fichier n’apparaisse 
pas dans la liste. Supprimez le fichier 
image à l’aide de eBook Library.

Les données de 
lecture continue ou 
des remarques de 
certains fichiers 
manquent.

 Si l’état du fichier a changé (comme 
dans les cas suivants), les données 
de lecture continue ou des remarques 
peuvent avoir été supprimées.
	Un fichier Texte/RTF/PDF est modifié.
	Un eBook acheté avec un Reader autorisé 

est lu sur un autre Reader désautorisé 
après un transfert de carte mémoire.
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Raccordement à l’ordinateur
Symptôme Cause ou action corrective

Impossible de faire 
fonctionner le 
Reader lors d’une 
connexion USB.

 Débranchez le Reader de la 
connexion USB.

Le Reader n’est pas 
reconnu.

 Le Reader est-il sous tension ? Le 
câble USB est-il raccordé 
correctement ?

	 Vérifiez les éléments ci-dessus et 
essayez de nouveau.

 Utilisez-vous un concentrateur USB 
ou une rallonge USB ?

	 Le raccordement du Reader via un 
concentrateur ou une rallonge USB 
n’est pas pris en charge et risque de 
ne pas fonctionner. Raccordez le 
câble USB directement à l’ordinateur.

 Vérifiez si l’indication  (connexion 
USB) est affichée en haut de l’écran 
du Reader. Si le Reader n’est 
toujours pas reconnu, débranchez le 
câble USB du Reader, puis 
reconnectez-le après quelques 
instants.

 Si l’option « Device Lock » du 
Reader est réglée sur « On », 
réglez-la sur « Off ». Si le Reader est 
verrouillé, il ne sera pas reconnu par 
votre ordinateur.
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Symptôme Cause ou action corrective

Impossible de 
transférer le contenu 
de l’ordinateur vers 
le Reader.

 Le câble USB n’est pas raccordé 
correctement. Débranchez le câble 
USB, puis reconnectez-le.

 Il n’y a pas assez d’espace libre 
dans la mémoire du Reader. 
Transférez l’ensemble du contenu 
inutile vers eBook Library ou vers un 
« Memory Stick Duo », puis 
supprimez-le pour augmenter 
l’espace disponible du Reader.

Aucune réponse de 
eBook Library lors 
d’une communication 
avec le Reader.

 Débranchez le câble USB du 
Reader, puis reconnectez-le.

Le Reader devient 
instable lorsqu’il est 
raccordé à un 
ordinateur.

 Utilisez-vous un concentrateur USB 
ou une rallonge USB ?

	 Le raccordement du Reader via un 
concentrateur ou une rallonge USB 
n’est pas pris en charge et risque de 
ne pas fonctionner. Raccordez le 
câble USB directement à l’ordinateur.

La batterie du 
Reader ne se charge 
pas (Le témoin ne 
s’allume pas).

 Le câble USB est-il raccordé 
correctement ? Vérifiez et essayez 
de nouveau.

 Utilisez-vous un concentrateur USB 
ou une rallonge USB ? Le 
raccordement du Reader via un 
concentrateur ou une rallonge USB 
n’est pas pris en charge et risque de 
ne pas fonctionner. Raccordez le 
câble USB directement à l’ordinateur.

Raccordement à l’ordinateur (suite)
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eBook
Symptôme Cause ou action corrective

Impossible de lire un 
eBook.

 Vous n’êtes pas identifié ou 
autorisé sur le service, ce qui est 
essentiel pour lire des eBooks. 
Autorisez votre ordinateur et le 
Reader.

 Vous avez essayé de lire du 
contenu appartenant à un autre 
utilisateur. Il est impossible de lire 
le contenu appartenant à un autre 
utilisateur.

 Les données d’autorisation ont 
peut être été altérées en raison 
d’un arrêt lors de la lecture d’un 
eBook. Annulez l’autorisation de 
votre ordinateur et du Reader, puis 
réactivez l’autorisation.

 Il est nécessaire d’installer et 
d’autoriser le logiciel Adobe Digital 
Editions, version 1.5 ou ultérieure, 
sur votre ordinateur pour lire un 
contenu protégé par la technologie 
DRM d’Adobe. Pour plus 
d’informations relatives à 
l’utilisation et au support du logiciel 
Adobe Digital Editions, reportez-
vous à la page d’informations 
Adobe disponible à l’adresse 
Internet suivante :  
http://www.adobe.com/go/
digitaleditions_us
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Carte mémoire
Symptôme Cause ou action corrective

Impossible de lire/
écouter/visualiser le 
contenu d’une carte 
mémoire.

 Vérifiez si la carte mémoire est 
insérée dans le bon sens dans la 
fente pour carte mémoire.

 Vérifiez que vous utilisez bien une 
carte mémoire prise en charge par le 
Reader.

 Nettoyez la zone de contact de la 
carte mémoire avec un chiffon doux, 
si nécessaire.

 Vérifiez si les livres/images/pistes 
sont transférés à l’aide de eBook 
Library ou du logiciel Adobe Digital 
Editions.

Impossible de 
transférer le contenu 
vers une carte 
mémoire.

 Débloquez l’onglet de protection en 
écriture s’il est verrouillé.

 La carte mémoire ne contient pas 
assez d’espace disponible. 
Supprimez les données inutiles.

Une carte mémoire 
n’est pas reconnue.

 Il est possible qu’une carte mémoire 
non formatée en FAT 16 ou FAT �� 
ne soit pas reconnue dans eBook 
Library.

	 Formatez une carte mémoire à l’aide 
de l’utilitaire de formatage fourni 
avec la carte mémoire ou à l’aide de 
l’Explorateur Windows en vous 
référant aux réglages par défaut du 
fabricant de la carte mémoire.

Impossible de 
supprimer le contenu 
de la carte mémoire.

 Débloquez l’onglet de protection en 
écriture s’il est verrouillé.

 Décochez l’attribut « lecture seule ».
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Restauration des réglages par défaut

Tous les réglages par défaut du Reader sont restaurés.

Remarques

Les changements suivants se produisent lors de la restauration des 
paramètres par défaut.
	L’orientation de l’écran devient verticale.
	Le verrouillage de l’appareil est réglé sur « Off » et le mot de passe 

est réglé sur « 0000 ».
	Le mode « Slideshow » est réglé sur « Off » et sa durée définie à  

5 secondes.
	La sourdine est désactivée et le volume est réglé sur la valeur par 

défaut (niveau �).
	La direction dans laquelle les pages tournent est réglées de la 

gauche vers la droite (pour afficher la page suivante, faites glisser 
la page de gauche à droite).

	Le réglage « Power Management » est réglé sur « On ».

 Dans le menu d’accueil, tapez sur  (Settings).
Le menu Settings apparaît.

 Tapez sur « Restore Defaults ».
L’écran de restauration des réglages par défaut apparaît. 
Si « Device Lock » (  page 11�) est réglé sur « On », 
l’écran de saisie du mot de passe apparaît. Saisissez le 
mot de passe, puis tapez sur « OK ».

 Tapez sur « Yes » pour restaurer les réglages par 
défaut.
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Désinstallation de eBook Library
Pour désinstaller le logiciel fourni de votre ordinateur, suivez 
la procédure ci-dessous.

Remarque

	Avant la désinstallation, annulez l’autorisation de votre ordinateur, 
le cas échéant. 
Pour plus d’informations sur l’annulation de l’autorisation, reportez-
vous à l’Aide eBook Library.

 Cliquez sur « Démarrer » – « Panneau de configuration ».

 Double-cliquez sur « Ajout/Suppression de 
programmes ». *1

 Cliquez sur « eBook Library by Sony » dans la liste 
« Programmes actuellement installés », puis cliquez 
sur « Supprimer ». *2

Suivez les instructions affichées à l’écran, puis 
redémarrez votre ordinateur. La désinstallation est 
terminée une fois l’ordinateur redémarré.

Désinstallation du Guide de l’utilisateur PRS-700
1 Cliquez sur « Démarrer » – « Panneau de configuration ».
2 Double-cliquez sur « Ajout/Suppression de programmes ». *1

3 Cliquez sur « PRS-700 User’s Guide » dans la liste « Programmes 
actuellement installés », puis cliquez sur « Supprimer ». *2

Suivez les instructions affichées à l’écran, redémarrez votre ordinateur. 
La désinstallation est terminée une fois l’ordinateur redémarré.

*1 « Désinstaller un programme » ou « Programmes et Fonctions » 
sous Windows Vista.

*� « Désinstaller » sous Windows Vista.
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Informations complémentaires

Mise à jour du micrologiciel du 
Reader
Vous pouvez disposer des nouvelles fonctions disponibles 
en installant la dernière version du micrologiciel du Reader. 
Les mises à jour du micrologiciel peuvent être effectuées à 
partir du menu de mise à jour eBook Library, accessible en 
cliquant sur « Help » – « Check for Updates ».
Pour plus d’informations sur les mises à jour, reportez-vous 
à l’Aide eBook Library ou visitez le site Web suivant.
Pour les clients aux Etats-Unis :
http://www.sony.com/readersupport
Pour les clients au Canada :
http://www.sony.ca/ElectronicsSupport/
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A propos des livres pré-installés 
sur le Reader
Lorsque vous achetez le Reader, il dispose déjà de certains 
échantillons de données qui vous permettent de l’essayer 
immédiatement. Les échantillons de données pré-installés 
permettent de tester la lecture, la visualisation et l’écoute.

A propos des échantillons de données
Le Reader dispose déjà de certains échantillons de 
données lorsqu’il est pré-installé.
Il est impossible de restaurer les échantillons de données 
qui ont été supprimés et aucune donnée de remplacement 
ne vous sera fournie par Sony.
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Remarques sur la mise au rebut 
du Reader
La batterie rechargeable intégrée du Reader est recyclable. 
Ne retirez pas la batterie vous-même, consultez « Sony 
Support ». (  page 115)
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Précautions

Fiche d’identification
Les numéros de modèle et de série sont indiqués à l’arrière 
de l’appareil. Inscrivez ces numéros dans l’espace ci-
dessous. Faites-y référence chaque fois que vous appelez 
votre détaillant Sony au sujet de ce produit.
N° de modèle __________________________
N° de série __________________________

Suite 1�9 FR



PRS-700.FR.4-1�4-649-11(1)

Le règlement FCC suivant s’applique uniquement à la 
version du modèle fabriqué et vendu aux Etats-Unis.
Les autres versions peuvent ne pas être conformes aux 
réglementations techniques FCC.

INFORMATIONS :
Remarque : Cet appareil a été testé et s’est avéré respecter 
les limites définies pour les appareils numériques de Classe 
B, conformément à la section 15 des règlements FCC. Ces 
limites sont définies pour garantir un niveau de protection 
acceptable contre les interférences nuisibles dans des 
zones résidentielles. Cet appareil crée, utilise et peut 
émettre des fréquences radio. Si l’appareil n’est pas installé 
et utilisé conformément aux instructions, il peut créer des 
interférences nuisibles aux communications radio.
Toutefois, il n’existe aucune garantie de non interférence dans 
une installation donnée. Si cet appareil crée des interférences 
nuisibles à la réception des radiocommunications ou de la 
télévision (ceci peut être déterminé en mettant l’appareil hors 
et sous tension). Nous recommandons à l’utilisateur de 
corriger l’interférence en exécutant une ou plusieurs des 
mesures suivantes :
– Réorienter ou repositionner l’antenne de réception.
– Augmenter la distance entre l’appareil et le récepteur.
– Brancher l’appareil à une prise sur un circuit autre que 

celui auquel est branché le récepteur.
– Contacter le revendeur ou un technicien radio/TV 

expérimenté pour obtenir davantage d’aide.
Toute modification ou tout changement que vous effectuez 
et qui n’est pas expressément approuvé(e) dans ce manuel 
peut annuler votre droit à utiliser cet appareil.
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Si vous avez des questions relatives à ce produit, contactez-
nous :
Par Internet :
www.sony.com/readersupport
Par téléphone :
Sony Portable Reader System Support Center au 1-(866)-
96�-7669
Par courrier :
Sony Customer Information Services Center
1�451 Gateway Blvd., Fort Myers, FL ��91�

Déclaration de conformité

Appellation commerciale : SONY 
N° de modèle : PRS-700
Partie responsable : Sony Electronics Inc.
Adresse :  165�0 Via Esprillo,  

San Diego,  
CA 9�1�7 U.S.A.

 Numéro de téléphone : 858-94�-���0

Cet appareil est conforme à la section 15 des 
règlements de la FCC. Son fonctionnement est 
soumis aux deux conditions suivantes : (1) cet 
appareil ne doit pas provoquer d’interférences 
gênantes, et (�) cet appareil doit pouvoir 
accepter les interférences reçues, y compris les 
interférences risquant de déclencher des 
opérations non désirées.
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À l’attention des clients résidant aux États- 
Unis et au Canada
RECYCLAGE DES ACCUMULATEURS AUX IONS 
DE LITHIUM
Les accumulateurs aux ions de lithium sont 
recyclables.
Vous pouvez contribuer à préserver 
l’environnement en rapportant les piles usées dans 
un point de collection et recyclage le plus proche.

Pour plus d’informations sur le recyclage des accumulateurs, 
téléphonez le numéro gratuit 1-800-8��-88�7 (Etats-Unis et 
Canada uniquement), ou visitez http://www.rbrc.org/.

Avertissement : Ne pas utiliser des accumulateurs aux 
ions de lithium qui sont endommagées ou qui fuient.

Sécurité

	N’insérez aucun corps étranger dans la prise DC IN du 
Reader.

	Veillez à ne pas court-circuiter les bornes du Reader avec 
des objets métalliques.

Installation

	N’exposez jamais le Reader à une lumière, à des 
températures, à de l’humidité ou des vibrations excessives.

	Ne recouvrez jamais le Reader en cours d’utilisation avec 
l’adaptateur secteur. Une surchauffe interne du Reader 
risque de provoquer un problème de fonctionnement ou 
des dommages.
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Surchauffe interne

Une surchauffe interne risque de se produire lors du 
chargement du Reader ou s’il est utilisé pendant une 
période prolongée.

Ecouteurs

Sécurité routière
N’utilisez pas les écouteurs lorsque vous conduisez une 
voiture, un vélo ou tout autre véhicule motorisé. Ceci est 
dangereux et illégal dans de nombreux pays. La lecture à un 
volume élevé peut également être dangereuse lors de 
déplacements à pieds, notamment au niveau des passages 
piéton. Utilisez l’appareil avec précaution ou interrompez son 
utilisation dans des situations potentiellement dangereuses.

Prévention des troubles auditifs
Evitez d’utiliser les écouteurs à un volume sonore élevé. Les 
médecins déconseillent l’écoute prolongée à un volume 
élevé. Si vous percevez un sifflement dans les oreilles, 
réduisez le volume ou interrompez l’écoute.

Respect d’autrui
Maintenez le volume à un niveau modéré. Ceci vous 
permettra d’entendre les sons extérieurs et d’être attentif à 
votre entourage.

Avertissement
Si un orage survient lorsque vous utilisez le Reader, retirez 
immédiatement les écouteurs.
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Utilisation

	La garantie ne couvre pas le remplacement ou la 
réparation d’un écran tactile cassé ou rayé. 

	Ne soumettez pas le Reader à un choc excessif.
	Ne donnez pas un coup à quelqu’un avec la pointe du 

stylet fourni.
	N’essayez pas de tordre le stylet fourni et ne vous en 

servez pas pour rayer l’écran tactile.
	Utilisez uniquement le stylet fourni pour les opérations 

prévues sur l’écran tactile.
	N’utilisez pas un stylet endommagé ou déformé.
	Selon les types de texte et de caractères, le texte affiché 

sur le Reader peut ne pas s’afficher correctement sur 
l’appareil. Ceci peut être dû à :
– la capacité du Reader ;
– un dysfonctionnement du Reader ;
– des données de contenu écrites dans une langue ou avec des 

caractères non pris en charge par le Reader.
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Remarques sur les cartes mémoire

A propos des « Memory Stick Duo »
Une carte mémoire « Memory Stick Duo » est un support 
d’enregistrement à circuit imprimé compact de grande 
capacité. Vous pouvez échanger des données entre des 
appareils compatibles « Memory Stick Duo », mais vous 
pouvez également l’utiliser comme support de stockage 
amovible.

A propos des cartes mémoire SD
Les cartes mémoire SD sont conformes à la norme relative 
aux cartes mémoire compactes et sont utilisées comme 
support de stockage pour les appareils photo numériques.

Pour plus d’informations sur les cartes mémoires prise en 
charge par le Reader, reportez-vous à la section « Insertion 
d’une carte mémoire » à la  page �8.

Remarques sur l’utilisation des cartes mémoire
	Lors de l’utilisation d’une carte miniSD dans le Reader, 

un adaptateur (vendu séparément) est requis.
	Le Reader n’est pas conforme avec :

− la norme MagicGate ;
− la protection des droits d’auteur des cartes mémoire SD.
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	Vous ne pouvez pas enregistrer ou supprimer de données 
stockées sur une carte mémoire lorsque l’onglet de 
protection en écriture est verrouillé.

 

	Conservez les cartes mémoire dans leur étui pour les 
transporter ou les stocker.

	Ne touchez pas le connecteur d’une carte mémoire avec 
les doigts ou des objets métalliques.

	Ne pliez pas, ne laissez pas tomber la carte mémoire ou 
ne l’exposez pas à des chocs excessifs.

	Ne démontez pas ou ne modifiez pas la carte mémoire.
	Ne mouillez pas la carte mémoire.
	Evitez d’effectuer les actions suivantes pour ne pas 

endommager les données. Sony n’offre aucune garantie 
pour les données endommagées.
− Retrait d’une carte mémoire ou mise hors tension du Reader 

pendant l’écriture ou la lecture de données.
− Utilisation du Reader dans des endroits où il peut être soumis à 

de l’électricité statique ou à des interférences électriques.

	N’utilisez pas d’autre étiquette que l’étiquette appropriée 
dans la zone mémo.

	N’utilisez pas ou ne conservez pas le Reader dans un 
endroit soumis :
− à des températures extrêmes, comme dans une voiture en plein 

soleil ;
− à la lumière directe du soleil ;
− à un fort taux d’humidité ou à des substances corrosives.
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Logiciel

	La législation sur les droits d’auteur interdit la 
reproduction partielle ou totale du logiciel ou du manuel 
qui l’accompagne, de même que le prêt du logiciel sans 
l’autorisation du détenteur des droits d’auteur.

	En aucun cas SONY ne pourra être tenu responsable de 
dommages financiers ou de pertes de profit, y compris 
les plaintes de tiers, résultant de l’utilisation du logiciel 
fourni avec le Reader.

	En cas de problème avec ce logiciel résultant d’une 
fabrication défectueuse, SONY le remplacera. SONY 
n’assume toutefois aucune autre responsabilité.

	Le logiciel fourni avec le Reader ne peut être utilisé avec 
aucun autre équipement que celui prévu à cet effet.

	Notez que, en raison d’efforts permanents visant à 
améliorer la qualité, les spécifications du logiciel peuvent 
être modifiées sans préavis.

	L’utilisation du Reader avec un autre logiciel que celui 
fourni n’est pas couverte pas la garantie.

	La possibilité d’afficher les langues dans eBook Library 
dépend du système d’exploitation installé sur votre 
ordinateur. Pour de meilleurs résultats, veuillez vous 
assurer que le système d’exploitation installé est 
compatible avec la langue que vous souhaitez afficher.
− Nous ne garantissons pas que toutes les langues seront 

affichées correctement dans votre eBook Library.
− Les caractères créés par l’utilisateur et certains caractères 

spéciaux risquent de ne pas s’afficher.
	Pour tirer le meilleur parti des explications données dans ce 

manuel, vous devez être familiarisé avec les fonctions de 
base de Windows. Pour plus d’informations sur l’utilisation 
de votre ordinateur et de son système d’exploitation, 
veuillez vous reporter aux manuels correspondants.
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Entretien
	Nettoyez le boîtier du Reader avec un chiffon doux, 

comme des lingettes nettoyantes pour lunettes.
	Si le boîtier du Reader est vraiment sale, nettoyez-le avec 

un chiffon doux légèrement imprégné d’eau ou d’une 
solution détergente neutre.

	N’utilisez pas de tampon abrasif, de poudre à récurer ni 
de solvant, tel que de l’alcool ou du benzène, qui risquent 
de ternir la surface du boîtier.

	Veillez à ne pas laisser d’eau pénétrer dans le Reader 
par l’orifice situé près du connecteur.

	Nettoyez régulièrement la fiche des écouteurs.
	L’utilisation d’un stylet encrassé peut endommager la 

surface de l’écran tactile. Lorsque le stylet est sale, 
nettoyez-le avec un chiffon sec.

Pour toute question ou tout problème concernant le Reader, 
consultez votre revendeur Sony le plus proche.

Remarques

	Le contenu enregistré est limité à un usage privé exclusivement. 
L’utilisation du contenu au-delà de cette limite nécessite 
l’autorisation des détenteurs des droits d’auteur.

	Sony ne peut être tenu responsable de tout enregistrement ou 
téléchargement incorrect ou de dommages causés aux données 
suite à des problèmes rencontrés par le Reader ou l’ordinateur.
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À propos des droits d’auteur

Le contenu de chaque livre préinstallé sur ce produit est 
protégé par des droits d’auteur, et est édité avec la 
coopération de l’éditeur et du rédacteur mentionnés. 
La législation sur les droits d’auteur interdit la reproduction, 
partielle ou totale, des données concernant ce produit ou 
du contenu de ce manuel (illustrations, documents liés, 
etc.) sans la permission du détenteur des droits d’auteur. 
En outre, l’utilisation des données concernant ce produit 
ou du contenu du présent manuel est interdite sans la 
permission de Sony, excepté pour un usage personnel.

	SONY et le logo SONY sont des marques déposées de Sony 
Corporation.

	BBeB, BBeB Book et leurs logos sont des marques de 
commerce de Sony Corporation.

	« Memory Stick », « Memory Stick Duo », « Memory Stick 
PRO Duo », et leurs logos sont des marques de commerce de 
Sony Corporation.

	Bitstream est une marque déposée et Dutch, Font Fusion et   
Swiss sont des marques de commerce de Bitstream Inc.

	Microsoft, Windows, Windows Vista et Windows Media sont 
des marques de commerce ou des marques déposées de 
Microsoft Corporation aux États-Unis et/ou dans d’autres pays.

	Adobe, le logo Adobe, Adobe Reader et Adobe PDF sont des 
marques de commerce ou des marques déposées de Adobe 
Systems Incorporated aux Etat-Unis et /ou dans d’autres pays.

	Licence de la technologie de codage audio MPEG Layer-� et 
des brevets obtenue de Fraunhofer IIS et Thomson.
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	Ce produit inclut un logiciel développé par OpenSSL Project 
destiné à l’utilisation dans OpenSSL Toolkit. 
(<http://www.openssl.org/>)  Copyright © 1998-�006 The 
OpenSSL Project. Tous droits réservés. Ce produit comprend 
un logiciel cryptographique développé par Eric Young (eay@ 
cryptsoft.com). Ce produit contient un logiciel développé par 
Tim Hudson (tjh@cryptsoft.com). Pour obtenir plus de détails 
sur la licence OpenSSL, reportez-vous au document « openssl. 
txt » sur le CD-ROM.

Tous les autres noms de système et de produit cités dans ce 
document sont en général des marques de commerce ou des 
marques déposées de leur détenteur respectif. Les symboles TM 
et ® n’apparaissent pas dans ce manuel.

Programme ©�008 Sony Corporation
Documentation ©�008 Sony Corporation

À propos de la LICENCE PUBLIQUE GÉNÉRALE GNU

Chers clients
Nous vous remercions d’avoir fait l’acquisition de ce produit. 
Ce produit contient le logiciel suivant, qui est applicable à la 
GPL/LGPL. Vous pouvez obtenir, modifier et redistribuer les 
codes source du logiciel.

busybox
dosfstools
FreeType
gcc
glibc
intiscripts
Kernel
kernel header
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libgcc
libstdc++
make
MAKEDEV
mtd
procps
uClibc
udev
USB driver
util-linux
zlib

Ces codes source sont disponibles depuis le site Web.
Visitez le site Web suivant pour procéder au téléchargement. 
http://www.sony.net/Products/Linux/
Veuillez noter que Sony ne répond à aucune demande 
concernant le contenu de ces codes source.

Pour obtenir davantage d’informations sur la LICENCE 
PUBLIQUE GÉNÉRALE GNU, reportez-vous aux fichiers 
« GPL (English).rtf », « GPL (French).rtf » « LGPL  
(English).rtf » et « LGPL (French).rtf » sur le CD-ROM.
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Spécifications
Nom de modèle
PRS-700

Source d’alimentation
Batterie rechargeable intégrée : �,7 V CC
Adaptateur secteur : 5,� V CC
USB

Autonomie de la batterie (lecture en continu)
Autonomie maximale de la batterie : environ 7 500 pages tournées en 
continu et en lecture seule *
* Mesure réalisée avec une batterie entièrement chargée et un nombre 

de pages au format BBeB tournées en continu à une vitesse 
d’environ 1 page par seconde. L’autonomie de la batterie peut varier 
selon le type d’utilisation et le périphérique concerné.

Durée de vie de la batterie (éclairage intégré)
Lumineux : environ 4 heures
Standard : environ 8 heures  

(lorsque la batterie est entièrement chargée et qu’aucune opération 
n’est effectuée)

Capacité utilisateur disponible
Environ 4�0 Mo
La capacité de la mémoire disponible du Reader peut varier.

Température de fonctionnement
5 à �5 °C

Dimensions (l/h/p)
Environ 1�7,6 × 174,� × 9,7 mm
(sans l’étui souple)

Poids
Environ �80 g (sans l’étui souple)

Accessoires en option
Adaptateur secteur pour Reader : AC-S5��0E

La conception et les spécifications sont sujettes à 
modification sans préavis.
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Index
Symboles

 (Continue Reading) ..............48
 (Books)  ................................47
 (All Notes) ............................89
 (Collections)  .........................58
 (Audio)  ..................................95
 (Pictures)  ...........................100
 (Settings)  ...........................106

Touche  (taille) ....................8, 64
Touches < / > (utilisées pour 

tourner les pages) ......10, 48, 50
Commutateur   

(éclairage) ........................10, 32
Touche   

(arrière) ......10, 51, 96, 101, 108

A
Adobe Digital Editions ...36, 52, 88
Advanced Settings ...................112

Clear Keyboard History ......113
Device Lock........................112
Device Shutdown ...............113
Format Internal Memory ....113
Ecran tactile .................18, 112

B
Barre d’outils ..................78, 80, 82
Batterie ......................................22

C
Carte mémoire ...........................28
Carte Mémoire SD .............28, 135
Charge .......................................21

Voir également le « Guide de 
démarrage »

Clavier à l’écran .........................71
Collection ...................................58
Commentaire .............................85
Commutateur POWER ..........9, 23

D
Dépannage ..............................114
Diaporama ...............................105

E
eBook Library ................36, 38, 41

Aide ........................................3
Installation ... Voir le « Guide de 

démarrage »
Désinstallation ....................125

eBooks .......................................52
Economie d’énergie ...................24
Ecran de saut de page ..............60
Ecran tactile .................................9
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F
Fente pour carte mémoire .....9, �8

Carte mémoire SD .................9
« Memory Stick Duo »............9

Fichier RTF ..........................�6, 5�
Fichiers audio ............................95

G
Gomme (suppression d’un 

surlignage) .............................8�

H
Horizontal ..................................69

I
Images .....................................100
Importer

Contenu ...............................�6
eBooks .................................�4

Informations ...............................57

L
Lecture de livres ........................47
Lien ............................................51
Liste de livres .............................47

M
Manuel .........................................�
« Memory Stick » ...............�8, 1�5
Menu d’accueil ...........................16
Menu d’options ......5�, 90, 98, 104
Menu Recherche .......................71
Mise à jour ...............................1�6

N
Now Playing .....5�, 90, 97, 98, 104

O
Orientation .................................69
Orifice pour la dragonne ............10
Orifices pour la fixation de l’étui 

souple ....................................10

P
Prise DC IN ...............................10
Prise écouteurs .........................11
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R
Réglage ...................................106

About..................................111
Date and Time....................109
Page Turn Gesture .............110
Power Management ...........109
Restore Defaults ................111
Slideshow ...........................110

Réglages par défaut ................1�4
Réinitialisation .........................114

Touche RESET ............11, 114
Remarques ..........................78, 88

S
Signets .......................................79
Sort ..................5�, 90, 9�, 98, 104
Stylet ......................................9, 1�
Surlignage .................................8�
Synchronisation .........................45

T
Table des matières ....................56
Témoin .........................................9
Touche HOME .............................9
Touche OPTION ..........................8
Touche SEARCH .........................9
Touche VOL –/+ ...................11, 97
Transfert .....................................�8
Types de livres ...........................5�

U
USB ...........................................�9

Connecteur USB ............11, �9

V
Vertical .......................................69
View .............................5�, 98, 104

Z
Zoom avant/arrière ............64, 10�
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